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Conventions used in this guide

TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging
the product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal
injury, catastrophic loss of data, or extensive damage to the product.
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Product comparison

  HP LaserJet Pro 300
color MFP M375nw

CE903A

HP LaserJet Pro 400
color MFP M475dn

CE863A

HP LaserJet Pro 400
color MFP M475dw

CE864A

Paper handling Tray 1 (50-sheet
capacity)

Tray 2 (250-sheet
capacity

Optional Tray 3 (250-
sheet capacity)

Standard output bin (150-
sheet capacity)

Automatic duplex printing  

Supported operating
systems

Windows XP, 32-bit

 Windows Vista, 32-bit
and 64-bit

 Windows 7, 32-bit and
64-bit

 Windows 2003 Server
(32-bit, Service Pack 3),
printer and scan drivers
only

 Windows 2008 Server,
printer and scan drivers
only

Windows 2008 Server
R2, printer and scan
drivers only

 Mac OS X v10.5 and
later

Connectivity Hi-Speed USB 2.0

10/100 Ethernet LAN
connection

Wireless network
connection

 

HP Smart Install for easy
software installation
(Windows only)

Memory 192 MB RAM,
expandable to 448 MB
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  HP LaserJet Pro 300
color MFP M375nw

CE903A

HP LaserJet Pro 400
color MFP M475dn

CE863A

HP LaserJet Pro 400
color MFP M475dw

CE864A

Control-panel display Color graphical touch
screen

Print Prints 18 pages per
minute (ppm) on A4-size
paper and 19 ppm on
Letter-size paper

  

Prints 20 pages per
minute (ppm) on A4-size
paper and 21 ppm on
Letter-size paper

 

Automatic duplex printing  

Walk-up USB printing (no
computer required

Copy Copies at up to 18 ppm   

Copies at up to 20 ppm  

Copy resolution is 300
dots per inch (dpi)

50-page document
feeder that supports
page sizes from 127 to
356 mm (5 to 14 in) in
length and from 127 to
216 mm (5 to 8.5 in) in
width

Flatbed scanner supports
page sizes up to 297 mm
(11.7 in) in length and up
to 215 mm (8.5 in) in
width

Automatic duplex
copying
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  HP LaserJet Pro 300
color MFP M375nw

CE903A

HP LaserJet Pro 400
color MFP M475dn

CE863A

HP LaserJet Pro 400
color MFP M475dw

CE864A

Scan Scans in black and white
with resolution up to
1200 dpi

Scans in color with
resolution up to 600 dpi

Automatic duplex
scanning

 

Walk-up USB scanning
(no computer required)

Fax V.34 with two RJ-11 fax
ports
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Environmental features

Duplex printing Save paper by using the manual duplex printing option. Automatic duplex printing is available
with the HP LaserJet Pro 400 color MFP M475dn and HP LaserJet Pro 400 color MFP
M475dw models.

Print multiple pages per
sheet

Save paper by printing two or more pages of a document side-by-side on one sheet of paper.
Access this feature through the printer driver.

Copies multiple pages per
sheet

Save paper by copying two or four pages of an original document side-by-side on one sheet
of paper.

Recycling Reduce waste by using recycled paper.

Recycle print cartridges by using the HP Planet Partners return process.

Energy savings Instant on Fusing technology and sleep mode enable this product to quickly go into reduced
power states when not printing, thus saving energy.

Accessibility features

The product includes several features that aid users with accessibility issues.

● Online user guide that is compatible with text screen-readers.

● Print cartridges can be installed and removed by using one hand.

● All doors and covers can be opened by using one hand.
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Product views

Front view

1 Document feeder cover

2 Document feeder input tray

3 Document feeder input tray extension

4 Document feeder output bin

5 Color touch screen control panel

6 Control-panel-adjustment lever

7 DIMM access door

8 Walk-up USB printing port

9 On/Off button

10 Optional Tray 3

11 Tray 2 (access for clearing jams)

12 Tray 1

13 Print-cartridge-door handle

14 Output bin stop

15 Output bin
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Back view

1 Fax ports

2 Network port

3 Hi-Speed USB 2.0 port

4 Power connection

5 Rear door (access for clearing jams)
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Interface ports

1 Telephone “line out” port for attaching an extension phone, answering machine, or other device

2 Fax “line in” port for attaching fax line to product

3 Network port

4 Hi-Speed USB 2.0 port
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Serial number and model number location

The serial number and product model number label is at the back of the product.

NOTE: Another label is inside the front door.
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Control panel layout

1  Touch screen display

2  Wireless light: indicates the wireless network is enabled. The light blinks while the product is establishing a
connection to the wireless network. When connected, the light stops blinking and stays lit.

NOTE: Wireless models only

3  Ready light: indicates the product is ready

4  Attention light: indicates a problem with the product

5 Help button and light: provides access to the control panel help system

6 Right arrow button and light: moves the cursor to the right or moves the display image to the next screen

NOTE: This button illuminates only when the current screen can use this feature.

7 Cancel button and light: clears settings, cancels the current job or exits the current screen.

NOTE: This button illuminates only when the current screen can use this feature.

8 Back button and light: returns to the previous screen

NOTE: This button illuminates only when the current screen can use this feature.

9 Left arrow button and light: moves the cursor to the left

NOTE: This button illuminates only when the current screen can use this feature.

10 Home button and light: provides access to the Home screen
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Buttons on the Home screen

The Home screen provides access to the product features, and it indicates the product status.

NOTE: Depending on the product configuration, the features on the Home screen can vary. The
layout might also be reversed for some languages.

1 Web Services button: provides quick access to HP Web Services features, including HP ePrint.

HP ePrint is a tool that prints documents by using any e-mail enabled device to send them to the product’s e-mail
address.

2 Setup  button: provides access to the main menus

3
Network  button: provides access to network settings and information. From the network settings screen,

you can print the Network Summary page.

4 Wireless  button: provides access to the Wireless menu and wireless status information.

NOTE: Wireless models only

NOTE: When you are connected to a wireless network, this icon changes to a set of signal strength bars.

5 Information  button: provides product status information. From the status summary screen, you can print the

Configuration Report page.

6 Supplies  button: provides information about supplies status. From the supplies summary screen, you can print

the Supplies Status page.

7 Fax button: provides access to the fax feature

8 Apps button: provides access to the Apps menu to print directly from select Web applications

9 Product status

10 Scan button: provides access to the scan feature

11 Copy button: provides access to the copy feature

12 USB button: provides access to the walk-up USB printing and scanning feature (no computer is required)
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Control panel help system

The product has a built-in Help system that explains how to use each screen. To open the Help
system, touch the Help  button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You
can browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the
options for that screen.

If the product alerts you of an error or warning, touch the Help  button to open a message that
describes the problem. The message also contains instructions to help solve the problem.
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2 Control panel menus

● Setup Menu

● Function specific menus
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Setup Menu

To open this menu, touch the Setup  button. The following sub menus are available:

● HP Web Services

● Reports

● Quick Forms

● Fax Setup

● System Setup

● Service

● Network Setup
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HP Web Services menu

Menu item Description

Enable Web Services Enables HP Web Services so you can use HP ePrint and the Apps menu.

HP ePrint is a tool that prints documents by using any e-mail enabled device to send them
to the product’s e-mail address.

Use the Apps menu to print directly from select Web applications.

Display E-Mail Address Select whether to display the product's IP address on the control panel.

Print Information Sheet Print a page that contains the e-mail address for the product as well as other information
for HP Web Services.

Turn ePrint On/Off Turn HP ePrint on or off.

Turn Apps On/Off Turn the Apps feature on or off.

Remove Web Services Remove HP Web Services from this product.
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Reports menu

Use the Reports menu to print reports that provide information about the product.

Menu item Description

Demo Page Prints a page that demonstrates print quality

Menu Structure Prints a map of the control panel-menu layout. The active settings for each menu
are listed.

Configuration Report Prints a list of all the product settings. Includes basic network information when
the product is connected to a network.

Supplies Status Prints the status for each print cartridge, including the following information: 

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP print cartridges

● Number of pages printed

● Information about ordering new HP print cartridges and recycling used HP
print cartridges

Network Summary Prints a list of all product network settings

Usage Page Prints a page that lists pages that were jammed or mispicked in the product,
monochrome (black and white) or color pages, and reports the count for pages
scanned, faxed, and copied.

PCL Font List Prints a list of all the PCL fonts that are installed.

PS Font List Prints a list of all the PostScript (PS) fonts that are installed

PCL6 Font List Prints a list of all the PCL6 fonts that are installed

Color Usage Log Prints a report that shows the user name, application name, and color usage
information on a job-by-job basis

Service Page Prints the service report

Diagnostics Page Prints the calibration and color diagnostics pages

Print Quality Page Prints a page that helps solve problems with print quality
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Quick Forms menu

Menu item Sub-menu item Description

Notebook Paper Narrow Rule

Wide Rule

Child Rule

Prints pages that have preprinted lines

Graph Paper 1/8 inch

5 mm

Prints pages that have preprinted graph lines

Checklist 1-Column

2-Column

Prints pages that have preprinted lines with check boxes

Music Paper Portrait

Landscape

Prints pages that have preprinted lines for writing music
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Fax Setup menu

In the following table, items that have an asterisk (*) indicate the factory default setting.

Menu item Sub-menu item Sub-menu item Description

Fax Set-Up Utility   This is a tool for configuring the fax settings. Follow the on-
screen prompts and select the appropriate response for each
question.

Basic Setup Time/Date (Settings for time
format, current time,
date format, and
current date.)

Sets the time and date setting for the product.

 Fax Header Enter your fax
number.

Enter company
name.

Sets the identifying information that is sent to the receiving
product.

 Answer Mode Automatic*

Manual

TAM

Fax/Tel

Sets the type of answer mode. The following options are
available:

● Automatic: The product automatically answers an incoming
call on the configured number of rings.

● Manual: The user must press the Start Fax button or use an
extension phone (press buttons 1-2-3 on the extension
phone) to make the product answer the incoming call.

● TAM: A telephone answering machine (TAM) is attached to
the Aux phone port of the product. The product will listen for
fax tones after the answering machine has picked up the
call-and pick up a call if fax tones are detected.

● Fax/Tel: The product will automatically pick up all calls and
determine if the call is a voice or fax call. If the call is a fax
call, the product handles the call as an incoming fax. If the
incoming call is detected as a voice call, the product will
generate an audible synthesized ring to alert the user of an
incoming voice call.

 Rings to Answer  Sets the number of rings that must occur before the fax modem
answers. The default setting is 5.
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Menu item Sub-menu item Sub-menu item Description

 Distinctive Ring All Rings*

Single

Double

Triple

Double and Triple

If you have distinctive ring phone service, use this item to
configure how the product responds to incoming calls.

● All Rings: The product answers all ring patterns or calls that
come through the telephone line.

● Single: The product answers any calls that produce a
single-ring pattern.

● Double: The product answers any calls that produce a
double-ring pattern.

● Triple: The product answers any calls that produce a triple-
ring pattern.

● Double and Triple: The product answers any calls that
produce a double-ring or triple-ring pattern.

 Dial Prefix On

Off*

Specifies a prefix number that must be dialed when sending
faxes from the product. If you turn this feature on, the product
prompts you to enter the number and then it automatically
includes that number every time you send a fax.

Advanced Setup Fax Resolution Standard

Fine*

Superfine

Photo

Sets the resolution for sent documents. Higher resolution images
have more dots per inch (dpi), so they show more detail. Lower
resolution images have fewer dots per inch and show less detail,
but the file size is smaller and the fax takes less time to transmit.

 Lighter/Darker  Sets the darkness of outgoing faxes.

 Fit to Page On*

Off

Shrinks incoming faxes that are larger than the paper size set for
the tray.

 Glass Size Letter

A4

Sets the default paper size for documents being scanned from
the flatbed scanner.

 Dialing Mode Tone*

Pulse

Sets whether the product should use tone or pulse dialing.

 Redial if Busy On*

Off

Sets whether the product should attempt to redial if the line is
busy.

 Redial if No Answer On

Off*

Sets whether the product should attempt to redial if the recipient
fax number does not answer.

 Redial if Comm. Error On*

Off

Sets whether the product should attempt to redial the recipient
fax number if a communication error occurs.

 Detect Dial Tone On

Off*

Sets whether the product should check for a dial tone before
sending a fax.
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Menu item Sub-menu item Sub-menu item Description

 Billing Codes On

Off*

Enables the use of billing codes when set to On. A prompt
appears where you can enter the billing code for an outgoing fax.

 Extension Phone On*

Off

When this feature is enabled, you can press the 1-2-3 buttons on
the extension phone to cause the product to answer an incoming
fax call.

 Stamp Faxes On

Off*

Sets the product to print the date, time, sender's phone number,
and page number on each page of incoming faxes.

 Private Receive On

Off*

Setting the Private Receive feature to On requires you to set a
product password. After setting the password, the following
options are set:

● The Private Receive feature is turned on.

● All old faxes are deleted from memory.

● Fax forwarding is set to Off and is not allowed to be
changed.

● All incoming faxes are stored in memory.

 Confirm Fax Number On

Off*

Confirm a fax number by entering it a second time.

 Allow Fax Reprint On*

Off

Sets whether incoming faxes are stored in memory for reprinting
later.

 Fax/Tel Ring Time 20*

30

40

70

Sets the time, in seconds, after which the product should stop
sounding the Fax/Tel audible ring to notify the user of an
incoming voice call.

 Print Duplex On

Off*

Sets duplex printing as the default for faxes.

NOTE: This item is available only for duplex models.

 Fax Speed Fast (V.34)*

Medium (V.17)

Slow (V.29)

Sets the allowed fax communication speed.
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System Setup menu

In the following table, items that have an asterisk (*) indicate the factory default setting.

Menu item Sub-menu item Sub-menu item Sub-menu item Description

Language (List of available
control-panel
display
languages.)

  Sets the language in which the control panel displays
messages and product reports.

Paper Setup Default Paper Size Letter

A4

Legal

 Sets the size for printing internal reports, faxes, or any
print job that does not specify a size.

 Default Paper
Type

Lists available
paper types.

 Sets the type for printing internal reports, faxes, or any
print job that does not specify a type.

 Tray 1 Paper Type

Paper Size

 Select the default size and type for Tray 1 from the list
of available sizes and types.

 Tray 2 Paper Type

Paper Size

 Select the default size and type for Tray 2 from the list
of available sizes and types.

 Paper Out Action Wait forever*

Cancel

Override

 Determines how the product reacts when a print job
requires a paper size or type that is unavailable or
when the tray is empty.

● Wait forever: The product waits until you load the
correct paper.

● Override: Print on a different size paper after a
specified delay.

● Cancel: Automatically cancel the print job after a
specified delay.

● If you select either the Override or Cancel item,
the control panel prompts you for the number of
seconds to delay.

Print Quality Color Calibration Calibrate Now

Power-On
Calibration

 Performs a full calibration.

● Calibrate Now: Performs an immediate
calibration.

● Power-On Calibration: Specify the length of time
the product should wait after you turn it on before
it calibrates.

 Adjust Alignment Print Test Page  Use this menu to shift the margin alignment to center
the image on the page from top to bottom and from left
to right. Before adjusting these values, print a test
page. It provides alignment guides in the X and Y
directions so you can determine which adjustments are
necessary.
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Menu item Sub-menu item Sub-menu item Sub-menu item Description

  Adjust Tray <X> X1 Shift

X2 Shift

Y Shift

Use the X1 Shift setting to center the image from side
to side on a single-sided page or for the second side of
a two-sided page.

Use the X2 Shift setting to center the image from side
to side on the first side of a two-sided page.

Use the Y Shift setting to center the image from top to
bottom on the page.

Energy Settings Sleep Delay 15 Minutes*

30 Minutes

1 Hour

2 Hours

Off

1 Minute

 Sets how long the product remains idle before it enters
Sleep mode. The product automatically exits Sleep
mode when you send a print job or press a control
panel button.

NOTE: The default Sleep Delay time is 15 minutes.

 Auto Power Down Power Down
Delay

30 Minutes*

1 Hour

2 Hours

4 Hours

8 Hours

24 Hours

Never

Select the length of time after which the product
automatically turns off.

NOTE: The default Power Down Delay time is 30
minutes.

  Wake Events USB Job

LAN Job

Wireless Job

Button Press

Select whether the product wakes when it receives
each of these types of jobs or actions.

The default for each option is Yes.

Volume Settings Alarm Volume

Ring Volume

Key-Press Volume

Phone Line
Volume

  Set the volume levels for the product. The following
options are available for each volume setting:

● Off

● Soft

● Medium*

● Loud

Time/Date (Settings for time
format, current
time, date format,
and current date.)

  Sets the time and date setting for the product.
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Menu item Sub-menu item Sub-menu item Sub-menu item Description

Product Security On

Off

  Sets the product-security feature. If you select the On
setting, you must set a password.

USB Flash Drive On

Off

  Enable or disable printing directly from the USB port on
the front of the product.

Disable Fax On

Off

  Enable or disable the Fax feature.

Supply Settings Black Cartridge Very Low Setting Prompt

Continue*

Stop

Set how the product behaves when the black print
cartridge reaches the very low threshold.

● Prompt: The product stops printing and prompts
you to replace the print cartridge. You can
acknowledge the prompt and continue printing. A
customer configurable option on this product is
"Prompt to Remind Me in 100 pages, 200 pages,
300 pages, or never." This option is provided as a
customer convenience and is not an indication
these pages will have acceptable print quality.

● Continue: The product alerts you that the print
cartridge is very low, but it continues printing.

● Stop: The product stops printing until you replace
the print cartridge.

  Low Threshold Enter percentage Use the arrow buttons to increase or decrease the
percentage of estimated life remaining at which the
product alerts you that the print cartridge is low.

For the black cartridge that ships with the product, the
default is 27%. For the standard replacement black
print cartridge, the default is 15%. For the high-
capacity replacement black print cartridge, the default
is 8%.

The default values are intended to provide
approximately two weeks of use before the cartridge
reaches the very low state.
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Menu item Sub-menu item Sub-menu item Sub-menu item Description

 Color Cartridges Very Low Setting Stop

Prompt

Continue

Print Black*

Set how the product behaves when the one of the
color print cartridges reaches the very low threshold.

● Prompt: The product stops printing and prompts
you to replace the print cartridge. You can
acknowledge the prompt and continue printing. A
customer configurable option on this product is
"Prompt to Remind Me in 100 pages, 200 pages,
300 pages, or never." This option is provided as a
customer convenience and is not an indication
these pages will have acceptable print quality.

● Continue: The product alerts you that the print
cartridge is very low, but it continues printing.

● Print Black: The product has been customer
configured to print using only the black print
cartridge when the level of a color supply is very
low. The color supply might still be able to
produce acceptable print quality. To print in color,
either replace the color supply or reconfigure the
product.

When you choose to replace the very low print
cartridge, color printing resumes automatically.

● Stop: The product stops printing until you replace
the print cartridge.

  Low Threshold Cyan

Magenta

Yellow

Enter percentage

Use the arrow buttons to increase or decrease the
percentage of estimated life remaining at which the
product alerts you that the print cartridge is low.

For the color print cartridges that ship with the product,
the default is 20%. For the replacement color print
cartridges, the default is 10%.

The default values are intended to provide
approximately two weeks of use before the cartridge
reaches the very low state.
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Menu item Sub-menu item Sub-menu item Sub-menu item Description

 Store Usage Data On Supply*

Not on Supply

 The product automatically stores print cartridge usage
data in its internal memory. It can also store this data
on memory chips in the print cartridges. Select the Not
on Supply option to store the data only in the product
memory.

The information stored on the print cartridge memory
chip helps HP design future products to meet our
customers' printing needs. HP collects a sampling of
memory chips from print cartridges returned to HP's
free return and recycling program. The memory chips
from this sampling are read and studied in order to
improve future HP products.

The data collected from the print cartridge memory
chip does not contain information that can be used to
identify a customer or user of the print cartridge or their
product.

Courier Font Regular

Dark

  Sets Courier font values.

Color Copy On

Off

  Enables or disables color copying.
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Service menu

In the following table, items that have an asterisk (*) indicate the factory default setting.

Menu item Sub-menu item Sub-menu item Description

Fax Service Clear Saved Faxes  Clears all faxes in memory.

 Run Fax Test  Performs a fax test to verify that the phone cord is plugged
in the correct outlet and that there is a signal on the phone
line. A fax test report is printed indicating the results.

 Print T.30 Trace Now

Never*

If Error

At End of Call

Prints or schedules a report that is used to troubleshoot fax
transmission issues.

 Error Correction On*

Off

The error correction mode allows the sending device to re-
transmit data if it detects an error signal.

 Fax Service Log  The fax service log prints out the last 40 entries in the fax
log.

Cleaning Page   Cleans the product when specks or other marks appear on
printed output. The cleaning process removes dust and
excess toner from the paper path.

When selected, the product prompts you to load plain
Letter or A4 paper in Tray 1. Touch the OK button to begin
the cleaning process. Wait until the process completes.
Discard the page that prints.

NOTE: For models that do not have an automatic
duplexer, the product prints the first side and then prompts
you to remove the page from the output bin and reload it in
Tray 1, keeping the same orientation.

USB Speed High*

Full

 Sets the USB speed for the USB connection to the
computer. For the product to actually operate at high
speed, it must have high speed enabled and be connected
to an EHCI host controller that is also operating at high
speed. This menu item also does not reflect the current
operating speed of the product.

Less Paper
Curl

On

Off*

 When printed pages are consistently curled, this option
sets the product to a mode that reduces curl.

Archive Print On

Off*

 When printing pages that will be stored for a long time, this
option sets the product to a mode that reduces toner
smearing and dusting.

Firmware
Datecode

  Displays the current firmware datecode
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Menu item Sub-menu item Sub-menu item Description

Restore
Defaults

  Sets all settings to the factory default values

HP Smart
Install

On*

Off

 Enable or disable the HP Smart Install tool.

Disable the tool if you want to connect to a network by
using an Ethernet cable.

If you disable HP Smart Install, you must use the product
software CD to install the product software.
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Network Setup menu

In the following table, items that have an asterisk (*) indicate the factory default setting.

Menu item Sub-menu item Sub-menu item Description

Wireless Menu

NOTE: You can also
access this menu by
touching the Wireless

 button on the control

panel.

Wireless Direct Settings Wireless Direct On/Off Enables or disables the Direct Wi-Fi wireless access
feature.

Wireless Direct Name Set the product's Direct Wifi name, so you can access it
from other wireless devices that support the Wi-Fi Direct
protocol.

Wireless Direct Mode Set the product's Direct Wifi mode.

● Select the Print Only option (the default setting) to
allow wireless access to only the product print
functions from a mobile device.

● Select the Open Network option to allow wireless
access to all product functions and settings from a
mobile device.

Wireless Setup Wizard  Guides you through the steps to set up the product on a
wireless network

Wi-Fi Protected Setup  If your wireless router supports this feature, use this
method to set up the product on a wireless network. This
is the simplest method.

Run Network Test  Tests the wireless network and prints a report with the
results.

Turn Wireless On/Off  Enables or disables the wireless network feature.

TCP/IP Config Automatic*

Manual

 Automatic: The product automatically configures all the
TCP/IP settings via DHCP, BootP or AutoIP.

Manual: You can manually configure the IP address,
subnet mask, and default gateway. The control panel
prompts you to specify values for each address section.
As each address is completed, the product prompts for
address confirmation before moving to the next one. After
all three addresses are set, the network reinitializes.

Auto Crossover On*

Off

 Enables or disables the use of a standard 10/100 network
cable when the product is directly connected to a
computer.

Network Services IPv4

IPv6

 Enable or disable the IPv4 and IPv6 protocols. By default,
each protocol is enabled.

Link Speed Automatic*

10T Full

10T Half

100TX Full

100TX Half

 Sets the link speed manually if needed.

After setting the link speed, the product automatically
restarts.
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Menu item Sub-menu item Sub-menu item Description

HTTPS Enforcement Yes

No*

 Sets the product so that it communicates only with Web
sites that use hypertext transfer protocol secure (HTTPS).

Restore Defaults   Resets all network configurations to their factory defaults.
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Function specific menus

The product features function-specific menus for copying, faxing, and scanning. To open these
menus, touch the button for that function on the control panel.

Copy menu

To open this menu, touch the Copy button, and then touch the Settings... button.

NOTE: Settings that you change with this menu expire 2 minutes after the last copy completes.

Menu item Sub-menu item Sub-menu item Description

ID Copy

NOTE: This item is available
from the main Copy screen. You
do not need to touch the
Settings... button to access it.

  Copies both sides of
identification cards, or other
small-size documents, onto the
same side of one sheet of
paper.

Number of Copies (1–99)  Specifies the number of copies

Reduce/Enlarge Original=100%*

Legal to Letter=78%

Legal to A4=83%

A4 to Letter=94%

Letter to A4=97%

Full Page=91%

Fit to Page

2 Pages per Sheet

4 Pages per Sheet

Custom: 25 to 400%

 Specifies the size of the copy.

Lighter/Darker   Specifies the contrast of the
copy.

Optimize Describe Original Auto Select*

Mixed

Text

Picture

Specifies the type of content in
the original document, so the
copy is the best match for the
original.

Paper Paper Size

Paper Type

 Specifies the paper size and
type for copies.
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Menu item Sub-menu item Sub-menu item Description

Multi-Page Copy Off*

On

 When this feature is on, the
product prompts you to load
another page onto the scanner
glass or to indicate that the job
is complete.

Collation On*

Off

 Specifies whether to collate
copy jobs

Tray Select Auto Select*

Tray 1

Tray 2

 Specifies which tray to use for
copies.

Two Sided 1-Sided to 1-Sided*

1-Sided to 2-Sided

2-Sided to 1-Sided

2-Sided to 2-Sided

 Specifies the duplex setting for
copies.

NOTE: This item is available
for duplex models only.

Draft Mode Off*

On

 Specifies whether to use draft-
quality printing for copies

Image Adjustment Lightness

Contrast

Sharpen

Background Removal

Color Balance

Grayness

 Adjusts the image quality
settings for copies

Set as New Defaults   Saves any changes you have
made to this menu as the new
defaults

Restore Defaults   Restores the factory defaults for
this menu
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Fax menu

To open this menu, touch the Fax button, and then touch the Fax Menu button.

Menu item Sub-menu item Sub-menu item Description

Fax Reports Fax Confirmation On Every Fax

On Send Fax Only

On Receive Fax Only

Never*

Sets whether the product prints
a confirmation report after a fax
job.

 Include First Page On*

Off

Sets whether the product
includes a thumbnail image of
the first page of the fax on the
report.

 Fax Error Report On Every Error*

On Send Error

On Receive Error

Never

Sets whether the product prints
a report after a failed fax job.

 Print Last Call Report  Prints a detailed report of the
last fax operation, either sent or
received.

 Fax Activity Log Print Log Now

Auto Log Print

Print Log Now: Prints a list of
the faxes that have been sent
from or received by this product.

Auto Log Print: Automatically
prints a report after every fax
job.

 Print Phone Book  Prints a list of the speed dials
that have been set up for this
product.

 Print Junk Fax list  Prints a list of phone numbers
that are blocked from sending
faxes to this product.

 Print Billing Report  Prints a list of billing codes that
have been used for outgoing
faxes. This report shows how
many sent faxes were billed to
each code. This menu item
appears only when the billing
codes feature is turned on.

 Print All Fax Reports  Prints all fax-related reports.

Send Options Send Fax Later  Allows a fax to be sent at a later
time and date.

 Broadcast Fax  Sends a fax to multiple
recipients.
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Menu item Sub-menu item Sub-menu item Description

 Fax Job Status  Displays pending fax jobs, and
allows you to cancel pending fax
jobs.

 Fax Resolution Standard

Fine

Superfine

Photo

Sets the resolution for sent
documents. Higher resolution
images have more dots per inch
(dpi), so they show more detail.
Lower resolution images have
fewer dots per inch and show
less detail, but the file size is
smaller.

Receive Options Print Private Faxes  Prints stored faxes when the
private-receive feature is on.
This menu item appears only
when the private-receive feature
is turned on. The product
prompts you for the system
password.

 Block Junk Faxes Add Number

Delete Number

Delete All Numbers

Print Junk Fax list

Modifies the junk fax list. The
junk fax list can contain up to 30
numbers. When the product
receives a call from one of the
junk fax numbers, it deletes the
incoming fax. It also logs the
junk fax in the activity log along
with job-accounting information.

 Reprint Faxes  Prints the received faxes stored
in available memory. This item
is available only if you have
turned on the Allow Fax Reprint
feature in the Fax Setup menu.

 Forward Fax On

Off*

Sets product to send all
received faxes to another fax
machine.

 Polling Receive  Allows the product to call
another fax machine that has
polling send enabled.

Phone Book Setup Individual Setup  Edits the fax phone book speed
dials and group-dial entries. The
product supports up to 120
phone book entries, which can
be either individual or group
entries.

 Group Setup

 Delete Entry Deletes a specific phone book
entry.

 Delete All Entries Deletes all entries in the phone
book.
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Menu item Sub-menu item Sub-menu item Description

 Print Report Now Prints a list of all the individual
and group dial entries in the
phone book.

Change Defaults   Opens the Fax Setup menu.

Scan menu

Menu item Sub-menu item Sub-menu item Description

Scan to USB Drive

NOTE: Touch the Settings...
button to access the sub menus.

Scan File Type JPEG

PDF

Scans a document and stores it
as a .PDF file or .JPEG image
on the USB flash drive.

 Scan Resolution 75 dpi

150 dpi

300 dpi

Specifies the resolution to use
for the scanned image.

Scan quality increases with
higher resolution, but the file
size also increases.

 Scan Paper Size Letter

Legal

A4

Specifies the size of the page to
use for the scanned file.

 Scan Source Document Feeder

Flatbed Scanner

Specifies whether the scanned
page is in the document feeder
or on the scanner glass.

 File Name Prefix  Provides a way to set a
standard name prefix for scan
job files.

 Output Color Color

Black & White

Specifies whether the scan
output file will be a color image
or a monochrome image.

 Set as New Defaults  Saves any changes you have
made to this menu as the new
defaults.
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USB Flash Drive

Menu item Description

Print Documents Prints documents stored on the USB drive. Use the arrow
buttons to scroll through the documents. Touch the names of
documents that you want to print.

Touch the summary screen to change settings such as the
number of copies, the paper size, or the paper type.

Touch the Print button when you are ready to print the
documents.

View and Print Photos Previews photos on the USB drive. Use the arrow buttons to
scroll through the photos. Touch the preview image for each
photo that you want to print. You can adjust the settings, and
you can save the changes as the new default settings. When
you are ready to print the photos, touch the Print button.

Scan to USB Drive Scans a document and stores it as a .PDF file or .JPEG
image on the USB flash drive.
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3 Software for Windows

● Supported operating systems and printer drivers for Windows

● Select the correct printer driver for Windows

● Change print job settings for Windows

● Remove the printer driver from Windows

● Supported utilities for Windows

● Software for other operating systems
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Supported operating systems and printer drivers for
Windows

The product supports the following Windows operating systems:

Recommended software installation

● Windows XP (32-bit, Service Pack 2)

● Windows Vista (32-bit and 64-bit)

● Windows 7 (32-bit and 64-bit)

Print and scan drivers only

● Windows 2003 Server (32-bit, Service Pack 3)

● Windows 2008 Server

● Windows 2008 Server R2

The product supports the following Windows printer drivers:

● HP PCL 6 (this is the default printer driver included on the product CD and in the HP Smart
Install program)

● HP Universal Print Driver for Windows Postscript

● HP Universal Print Driver for PCL 5

The printer drivers include online Help that has instructions for common printing tasks and also
describes the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: For more information about the UPD, see www.hp.com/go/upd.

Select the correct printer driver for Windows

Printer drivers provide access to the product features and allow the computer to communicate with
the product (using a printer language). The following printer drivers are available at www.hp.com/go/
LJColorMFPM375_software or www.hp.com/go/LJColorMFPM475_software.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless
you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for
postscript flash font support
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HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● May not be fully compatible with third-party and custom solutions based on
PCL5
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HP Universal Print Driver (UPD)

The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built
on proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and
then customizes the user interface to show the product’s unique, available features. It automatically
enables features that are available for the product, such as two-sided printing and stapling, so you do
not need to enable them manually.

For more information, go to www.hp.com/go/upd.

UPD installation modes

Traditional mode ● Use this mode if you are installing the driver from a CD for a single computer.

● When installed from the CD that comes with the product, UPD operates like
traditional printer drivers. It operates with a specific product.

● If you use this mode, you must install UPD separately for each computer and
for each product.

Dynamic mode ● To use this mode, download UPD from the Internet. See www.hp.com/go/
upd.

● Dynamic mode allows you to use a single driver installation, so you can
discover and print to HP products in any location.

● Use this mode if you are installing UPD for a workgroup.
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Change print job settings for Windows

Priority for print settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software
program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here override settings
changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and usually do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box usually do not override
settings anywhere else in the printing software. You can change most of the print settings here.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is closed

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start
menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start
menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.
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Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start
menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start
menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
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Remove the printer driver from Windows

Windows XP

1. Click the Start button, , and then click the Printers and Faxes item.

2. Find and right-click the product from the list, and then click the Delete item.

3. From the File menu, click the Server Properties item. The Print Server Properties dialog box
opens.

4. Click the Drivers tab, and in the list, select the driver to be removed.

5. Click the Remove button, and then click the Yes button to confirm the removal.

Windows Vista

1. Click the Start button , and then click the Control Panel item.

2. In the Hardware and Sound group, click the Printer item.

3. Find and right-click the product, click the Delete item, and then click the Yes button to confirm
the removal.

4. From the File menu, click the Server Properties item. The Print Server Properties dialog box
opens.

5. Click the Drivers tab, and in the list, select the driver to be removed.

6. Click the Remove button, and then click the Yes button to confirm the removal.

Windows 7

1. Click the Start button, and then click the Devices and Printers item.

2. Find and select the product from the list.

3. Click the Remove device button at the top of the dialog box, and then click the Yes button to
confirm the removal.

4. Click the Print server properties button at the top of the dialog box, and then click the Drivers
tab.

5. Select the product in the list, and then click the Remove button.

6. Select to delete only the driver and or the driver software package, and then click the OK button
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Supported utilities for Windows

● HP Web Jetadmin

● HP Embedded Web Server

● HP ePrint

Other Windows components and utilities

● HP Smart Install — automates the printing system installation

● Online Web registration

● HP LaserJet Scan

● PC Fax Send

● HP Device Toolbox

● HP Uninstall

● HP Help & Learn Center

● Reconfigure your HP device

● HP Fax Setup Wizard

● HP LaserJet Customer Participation Program

Software for other operating systems

OS Software

UNIX For HP-UX and Solaris networks, go to www.hp.com/support/net_printing to download
the HP Jetdirect printer installer for UNIX.

For Unix print drivers, go to www.hp.com/pond/modelscripts/index2.

Linux For information, go to www.hp.com/go/linuxprinting.
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4 Use the product with Mac

● Software for Mac

● Basic print tasks with Mac

● Use AirPrint

● Fax with Mac

● Scan with Mac

● Solve problems with Mac
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Software for Mac

Supported operating systems and printer drivers for Mac

The product supports the following Mac operating systems:

● Mac OS X 10.5 and 10.6

NOTE: For Mac OS X 10.5 and later, PPC and Intel® Core™ Processor Macs are supported. For
Mac OS X 10.6, Intel Core Processor Macs are supported.

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, Printer Dialog
Extensions (PDEs), and the HP Utility for use with Mac OS X computers. The HP printer PPD and
PDE files, in combination with the built-in Apple PostScript printer drivers, provide full printing
functionality and access to specific HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using
a cable that is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Install the software from the CD.

3. Click HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.
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Install software for Mac computers on a wired network

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

Install the software

1. Install the software from the CD. Click the product icon, and follow the onscreen instructions.

2. Print a page from any program to make sure that the software is correctly installed.
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Install software for Mac computers on a wireless network

Before installing the product software, make sure the product is not connected to the network using a
network cable. Make sure your Mac computer is connected to the same wireless network to which
you plan to connect the product.

Use one of the following procedures to connect the product to the wireless network.

● Connect the product to a wireless network using WPS by using the control panel menus

● Connect the product to a wireless network using a USB cable

If your router supports Wi-Fi Protected Setup (WPS), use that method to add the product to your
network. This is the simplest way to set up the product on a wireless network.

NOTE: Apple AirPort wireless routers do not support WPS button setup.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router
network settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.

Connect the product to a wireless network using WPS by using the control panel menus

1. On the front of the product, press the Wireless button. Look at the control panel display to see if
the Wireless Menu item has opened. If it has not opened, complete these steps:

a. At the control panel, press the OK button to open the menus.

b. Open the following menus:

● Network Setup

● Wireless Menu

2. Select the Wi-Fi Protected Setup item.

3. Use one of these methods to complete the setup:

● Pushbutton: Select the Pushbutton option and follow the instructions on the control panel.
Establishing the wireless connection can take a few minutes.

● PIN: Select the Generate PIN option. The product generates a unique PIN, which you must
type into the wireless router's setup screen. Establishing the wireless connection can take a
few minutes.

4. At the computer, open the Apple menu , click the System Preferences menu, and then click
the Print & Fax icon.
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5. Click the plus (+) symbol in the lower left corner of the Printer Names column.

By default, Mac OS X uses the Bonjour method to find the product over the local network and
add it to the printer pop-up menu. This method is best in most situations. If Mac OS X cannot
find the HP printer driver, an error message displays. Reinstall the software.

6. Print a page from any program to make sure that the software is correctly installed.

NOTE: If this method is not successful, try using the wireless network using a USB cable method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the
product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
connection easier. After the setup is complete, you can disconnect the USB cable and use the
wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Configure your device for a
wireless network option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a
SSID name.

4. Print a page from any program to make sure that the software is correctly installed.

Remove the printer driver from Mac operating systems

You must have administrator rights to remove the software.

1. Open System Preferences.

2. Select Print & Fax.

3. Highlight the product.

4. Click the minus (-) symbol.

5. Click the Delete Printer button to remove the print queue.

NOTE: If you want to remove all the software associated with the project, use the HP Uninstaller
utility in the Hewlett-Packard program group.

Priority for print settings for Mac

Changes to print settings are prioritized depending on where the changes are made:
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NOTE: The names of commands and dialog boxes might vary depending on your software
program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change printer-driver settings for Mac

Change the settings for all print jobs until the software program is closed

1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.

3. On the Presets menu, click the Save As... option and type a name for the preset.

These settings are saved in the Presets menu. To use the new settings, you must select the saved
preset option every time you open a program and print.

Change the product configuration settings

1. From the Apple menu , click the System Preferences menu and then click the Print & Fax
icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.
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Software for Mac computers

HP Utility for Mac

Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected
to a TCP/IP-based network.

Open the HP Utility

▲ From the dock, click HP Utility.

-or-

From Applications, open the Hewlett-Packard folder, and then click HP Utility.

HP Utility features

Use the HP Utility software to perform the following tasks:

● Obtain information about supplies status.

● Obtain information about the product, such as the firmware version and the serial number.

● Print a configuration page.

● For products connected to an IP-based network, obtain network information and open the
HP Embedded Web Server.

● Configure the paper type and size for the tray.

● Transfer files and fonts from the computer to the product.

● Update the product firmware.

● Display the color usage page.

● Configure basic fax settings.

Supported utilities for Mac

HP Embedded Web Server

The product is equipped with the HP Embedded Web server, which provides access to information
about product and network activities. Access the HP Embedded Web Server from the HP Utility.
Open the Printer Settings menu, and then select the Additional Settings option.
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You can also access the HP Embedded Web Server from the Safari Web browser:

1. Select the page icon in the left side of the Safari toolbar.

2. Click the Bonjour logo.

3. In the list of printers, double-click this product. The HP Embedded Web Server opens.

HP ePrint

With HP ePrint , you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile
device. HP ePrint works with any email-capable device. If you can e-mail, you can print to an
HP ePrint-enabled product. For more details, go to www.hpeprintcenter.com.

NOTE: The product must be connected to a network and have Internet access to use HP ePrint.

HP ePrint is disabled as a default setting in the product. Use this procedure to enable it.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded
Web Server.

2. Click the HP Web Services tab.

3. Select the option to enable Web Services.

AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to
the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in
the following applications:

● Mail

● Photos

● Safari

● Select third-party applications

To use AirPrint, the product must be connected to a wireless network. For more information about
using AirPrint and about which HP products are compatible with AirPrint, go to www.hp.com/go/
airprint.

NOTE: You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/go/
LJColorMFPM375 or www.hp.com/go/LJColorMFPM475.
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Basic print tasks with Mac

Cancel a print job with Mac

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that
currently appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.

Change the paper size and type with Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Resize documents or print on a custom paper size with Mac

Mac OS X 10.5 and 10.6

Use one of these methods.

1. On the File menu, click the Print option.

2. Click the Page Setup button.

3. Select the product, and then select the correct settings for the Paper Size
and Orientation options.

1. On the File menu, click the Print option.

2. Open the Paper Handling menu.

3. In the Destination Paper Size area, click the Scale to fit paper size box,
and then select the size from the drop-down list.

Create and use printing presets with Mac

Use printing presets to save the current printer driver settings for reuse.
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Create a printing preset

1. On the File menu, click the Print option.

2. Select the driver.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.

2. Select the driver.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Print a cover page with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the
Before Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

Use watermarks with Mac

1. On the File menu, click the Print option.

2. Open the Watermarks menu.

3. From the Mode menu, select the type of watermark to use. Select the Watermark option to print
a semi-transparent message. Select the Overlay option to print a message that is not
transparent.

4. From the Pages menu, select whether to print the watermark on all pages or on the first page
only.

5. From the Text menu, select one of the standard messages, or select the Custom option and
type a new message in the box.

6. Select options for the remaining settings.

54 Chapter 4   Use the product with Mac ENWW



Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Layout menu.

4. From the Pages per Sheet menu, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing) with Mac

Use automatic duplex printing

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Layout menu.

4. From the Two-Sided menu, select a binding option.

Print on both sides manually

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Finishing menu, and click the Manual Duplex tab or open the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button. Follow the instructions in the pop-up window that appears on the
computer screen before replacing the output stack in Tray 1 for printing the second half.
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6. Go to the product, and remove any blank paper that is in Tray 1.

7. Insert the printed stack face-up with the bottom edge feeding into the printer first in Tray 1. You
must print the second side from Tray 1.

8. If prompted, press the appropriate control-panel button to continue.

Set the color options with Mac

If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all
documents and automatically adjusts all photographic images with the same improved photographic
results.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in the HP Mac Postscript printer driver, so you do not
need to make manual color adjustments. To disable the option so you can manually adjust the color
settings, use the following procedure.

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Color/Quality Options menu, and then click the HP EasyColor check box to clear it.

4. Open the Advanced menu, or select the appropriate tab.

5. Adjust the individual settings for text, graphics, and photographs.
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Use AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to
the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in
the following applications:

● Mail

● Photos

● Safari

● Select third-party applications

To use AirPrint, the product must be connected to a network. For more information about using
AirPrint and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

NOTE: You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/go/
LJColorMFPM375 or www.hp.com/go/LJColorMFPM475.
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Fax with Mac

To send a fax by printing to a fax driver, complete the following steps:

1. Open the document that you want to fax.

2. Click File and then click Print.

3. In the Printer pop-up menu, select the fax print queue that you want to use.

4. In the Copies field, adjust the number of copies if necessary.

5. In the Paper Size pop-up menu, adjust the paper size if necessary.

6. In the Fax Information area, enter the fax number of one or more recipients.

NOTE: If you need to include a dialing prefix, enter it in the Dialing Prefix field.

7. Click Fax.
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Scan with Mac

Use the HP Scan software to scan images to a Mac computer.

1. Load the document onto the scanner glass or into the document feeder.

2. Open the Applications folder, and then click Hewlett-Packard. Double-click HP Scan.

3. Open the HP Scan menu and click Preferences. From the Scanner pop-up menu, select this
product from the list, and click Continue.

4. To use the standard preset settings, which produce acceptable results for images and text, click
the Scan button.

To use presets optimized for pictures or text documents, select a preset from the Scanning
Presets pop-up menu. To adjust the settings, click the Edit button. When you are ready to scan,
click the Scan button.

5. To scan more pages, load the next page and click Scan. Click Append to List to add the new
pages to the current list. Repeat until you have scanned all the pages.

6. Click the Save button, and then browse to the folder on your computer where you want to save
the file.

NOTE: To print the scanned images now, click the Print button.
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Solve problems with Mac

For information about solving problems with a Mac, see Solve product software problems with Mac
on page 283.
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5 Connect the product with Windows

● Printer sharing disclaimer

● Use HP Smart Install to connect to a computer, a wired network, or a wireless network

● Connect with USB

● Connect to a network with Windows
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Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating
systems and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Use HP Smart Install to connect to a computer, a wired
network, or a wireless network

The software installation files are in the product memory. The HP Smart Install program uses a USB
cable to transfer the installation files from the product to your computer. This installer supports USB
connections, wired networks, and wireless networks. It installs all files you need to print, copy, scan,
and fax. To use the HP Smart Install program, follow one of these procedures, depending on your
connection type.

NOTE: If you prefer not to use the HP Smart Install program, you can insert the product CD to
install the software.

HP Smart Install for Windows direct connections (USB)

1. Turn the product on.

2. Connect an A-to-B type USB cable to the computer and the product. The HP Smart Install
program might take a few minutes to start.

3. The HP Smart Install program should start automatically. Follow the onscreen instructions to
install the software.

NOTE: The HP Smart Install program might take a few minutes to start. If the HP Smart Install
program does not start automatically, AutoPlay might be disabled on the computer. Browse the
computer and double-click the HP Smart Install drive to run the program.

NOTE: If the HP Smart Install program fails, disconnect the USB cable, turn the product off
and then on again, and then insert the product CD into your computer. Follow the onscreen
instructions. Connect the cable only when the software prompts you.

HP Smart Install for Windows wired networks

1. Connect a network cable to the product and a network port. Allow a few minutes for an IP
address to be assigned.

2. On the product control panel, touch the network  button to display the product IP address.

3. At the computer, open a Web browser and type the IP address in the URL address bar to open
the HP Embedded Web Server. Click the HP Smart Install tab and follow the onscreen
instructions.

NOTE: If the HP Smart Install program fails, insert the product CD into your computer. Follow the
onscreen instructions.
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HP Smart Install for Windows wireless networks, method 1: Use the
product control panel

NOTE: Use this method only if you know your wireless network SSID and password.

1. On the product control panel, touch the Wireless  button. Touch the Wireless Menu button,
and then touch the Wireless Setup Wizard item. Follow the instructions to complete the wireless
setup.

2. On the product control panel, touch the wireless status  button to display the product IP
address.

3. At the computer, open a Web browser and type the IP address in the URL address bar to open
the HP Embedded Web Server. Click the HP Smart Install tab and follow the onscreen
instructions.

HP Smart Install for Windows wireless networks, method 2: Temporarily
connect a USB cable

1. Connect an A-to-B type USB cable to the computer and the product. The HP Smart Install
program might take a few minutes to start.

2. Follow the onscreen instructions. Choose the Wireless Network option for the installation type.
Remove the USB cable when instructed.

HP Smart Install for Windows wireless networks, method 3: Use WPS

1. On the product control panel, touch the Wireless  button. Touch the Wireless Menu button,
and then touch the Wi-Fi Protected Setup item. Follow the instructions to complete the wireless
setup.

2. On the product control panel, touch the wireless status  button to display the product IP
address.

3. At the computer, open a Web browser and type the IP address in the URL address bar to open
the HP Embedded Web Server. Click the HP Smart Install tab and follow the onscreen
instructions.
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Connect with USB

NOTE: Use this procedure if you are not using the HP Smart Install.

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using
a cable that is no longer than 2 m (6.5 ft).

CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

CD installation

1. Quit all open programs on the computer.

2. Install the software from the CD, and follow the onscreen instructions.

3. When prompted, select the Directly connect to this computer using a USB cable option, and
then click the Next button.

4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the Finish button.

6. On the More Options screen, you can install more software, or click the Finish button.

7. Print a page from any program to make sure that the printing software is correctly installed.
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Connect to a network with Windows

Supported network protocols

To connect a networking-equipped product to a network, you need a network that uses one or more
of the following protocols.

● TCP/IP (IPv4 or IPv6)

● LPD Printing

● SLP

● WS-Discovery

Install the product on a wired network with Windows

NOTE: Use this procedure if you are not using the HP Smart Install.

Obtain the IP address

1. Connect the network cable to the product and to the network. Turn the product on.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. At the product control panel, press the Setup  button.

4. Touch the Reports menu, and then touch the Configuration Report button to print the
configuration report.
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5. Find the IP address on the configuration report.

Jetdirect Page HP Color LaserJet
Page 1

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.

4. When prompted, select the Connect through a wired network option, and then click the Next
button.

5. From the list of available printers, select the printer that has the correct IP address.

6. Click the Finish button.

7. On the More Options screen, you can install more software, or click the Finish button.

8. Print a page from any program to make sure that the printing software is correctly installed.

Install the product on a wireless network with Windows (wireless models
only)

NOTE: Use this procedure if you are not using the HP Smart Install.

Before installing the product software, make sure the product is not connected to the network using a
network cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router
network settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.
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Connect the product to a wireless network using WPS

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the
product on a wireless network.

1. From the Home screen on the product control panel, touch the Wireless  button.

2. Touch the Wireless Menu button, and then touch the Wi-Fi Protected Setup button.

3. Use one of these methods to complete the setup:

● Pushbutton: Select the Pushbutton option and follow the instructions on the control panel.
Establishing the wireless connection can take a few minutes.

● PIN: Select the Generate PIN option and follow the instructions on the control panel. The
product generates a unique PIN, which you must type into the wireless router's setup
screen. Establishing the wireless connection can take a few minutes.

NOTE: If this method is not successful, try using the Wireless Setup Wizard on the product control
panel or try using the USB cable connection method.

Connect the product to a wireless network using the Wireless Setup Wizard

If your wireless router does not support WiFi-Protected Setup (WPS), you can use this method to
install the product on a wireless network.

1. From the Home screen on the product control panel, touch the Wireless  button.

2. Touch the Wireless Menu button, and then touch the Wireless Setup Wizard button.

3. The product scans for available wireless networks and returns a list of network names (SSIDs).
Select the SSID for your wireless router from the list if it is available. If the SSID for your wireless
router is not in the list, touch the Enter SSID button. When prompted for the type of network
security, select the option that your wireless router uses. A keypad opens on the control panel
display.

4. If your wireless router uses WPA security, type the passphrase on the keypad.

If your wireless router uses WEP security, type the key on the keypad.

5. Touch the OK button, and wait while the product establishes a connection with the wireless
router. Establishing the wireless connection can take a few minutes.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the
product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
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connection easier. After the setup is complete, you can disconnect the USB cable and use the
wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Connect through a wireless
network option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a
SSID name.

4. When installation is complete, disconnect the USB cable.

Install the software for a wireless product currently on the network

If the product already has an IP address on a wireless network and you want to install product
software on a computer, complete the following steps.

1. From the product control panel, print a configuration page to obtain the product IP address.

2. Install the software from the CD.

3. Follow the on-screen instructions.

4. When prompted, select the Connect through a wireless network option, and then click the
Next button.

5. From the list of available printers, select the printer that has the correct IP address.

Configure IP network settings with Windows

View or change network settings

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits.
It has a format similar to this:

xxxx::xxxx:xxxx:xxxx:xxxx

2. To open the HP Embedded Web Server, type the IP address (IPv4) into the address line of a
Web browser. For IPv6, use the protocol established by the Web browser for entering IPv6
addresses.

3. Click the Networking tab to obtain network information. You can change settings as needed.
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Set or change the product password

Use the HP Embedded Web Server to set a password or change an existing password for a product
on a network.

1. Type the product IP address into the address line of a Web browser. Click the Networking tab,
and click the Security link.

NOTE: If a password has previously been set, you are prompted to type the password. Type
the password, and then click the Apply button.

2. Type the new password in the New Password box and in the Verify password box.

3. At the bottom of the window, click the Apply button to save the password.

Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.

1. Touch the Setup  button.

2. Scroll to and touch the Network Setup menu.

3. Touch the TCP/IP Config menu, and then touch the Manual button.

4. Use the numeric keypad to enter the IP address, and touch the OK button. Touch the Yes button
to confirm.

5. Use the numeric keypad to enter the subnet mask, and touch the OK button. Touch the Yes
button to confirm.

6. Use the numeric keypad to enter the default gateway, and touch the OK button. Touch the Yes
button to confirm.
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Link speed and duplex settings

NOTE: This information applies only to Ethernet networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most
situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex
settings might prevent the product from communicating with other network devices. If you need to
make changes, use the product control panel.

NOTE: The setting must match with the network product to which you are connecting (a network
hub, switch, gateway, router, or computer).

NOTE: Making changes to these settings causes the product to turn off and then on. Make changes
only when the product is idle.

1. Touch the Setup  button.

2. Scroll to and touch the Network Setup menu.

3. Touch the Link Speed menu.

4. Select one of the following options.

Setting Description

Automatic The print server automatically configures itself for the highest link speed and
communication mode allowed on the network.

10T Half 10 megabytes per second (Mbps), half-duplex operation

10T Full 10 Mbps, full-duplex operation

100TX Half 100 Mbps, half-duplex operation

100TX Full 100 Mbps, full-duplex operation

5. Touch the OK button. The product turns off and then on.
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6 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size in Windows

● Supported paper sizes

● Supported paper types and tray capacity

● Load paper trays

● Configure trays
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Understand paper use

This product supports a variety of paper and other print media. Paper or print media that does not
meet the following guidelines might cause poor print quality, increased jams, and premature wear on
the product.

It is possible for paper to meet all of these guidelines and still not produce satisfactory results. This
might be the result of improper handling, unacceptable temperature and/or humidity levels, or other
variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

● For best results, use only HP-brand paper and print media designed for laser printers or
multiuse.

● Do not use paper or print media made for inkjet printers.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very
precise dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could
damage the product.

● Hewlett-Packard Company cannot recommend the use of other brands of media because HP
cannot control their quality.

Use the following guidelines to obtain satisfactory results when using special paper or print media.
Set the paper type and size in the printer driver to obtain the best results.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner
of the envelope.

● Use peel-off adhesive strips that
are approved for use in laser
printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have
wrinkles or bubbles, or are
damaged.

● Do not print partial sheets of
labels.

Transparencies ● Use only transparencies that are
approved for use in color laser
printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.
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Media type Do Do not

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight
specifications for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product
unless it is HP paper that has
been approved for use in this
product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.
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Change the printer driver to match the paper type and
size in Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

5. Select a paper type from the Paper type drop-down list.

6. Click the OK button.
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Supported paper sizes

NOTE: To obtain best print results, select the appropriate paper size and type in your print driver
before printing.

Table 6-1  Supported paper and print media sizes

Size Dimensions Tray 1 Tray 2 or optional
Tray 3

Automatic duplex
printing

Letter 216 x 279 mm (8.5 x 11 inches)

Legal 216 x 356 mm (8.5 x 14 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Executive 184 x 267 mm (7.24 x 10.51 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)  

A6 105 x 148 mm (4.13 x 5.83 inches)  

B5 (JIS) 182 x 257 mm (7.17 x 10.12 inches)

16k 184 x 260 mm (7.24 x 10.23 inches)

195 x 270 mm (7.68 x 10.62 inches)

197 x 273 mm (7.75 x 10.75 inches)

 

8.5 x 13 216 x 330 mm (8.5 x 13 inches)

4 x 6 107 x 152 mm (4 x 6 inches)  

5 x 8 127 x 203 mm (5 x 8 inches)  

10 x 15 cm 100 x 150 mm (3.9 x 5.9 inches)  

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 216 x 356 mm (8.5 x 14 in)

 

Custom Minimum: 102 x 153 mm (4 x 6 in)

Maximum: 216 x 356 mm (8.5 x 14 in)

 

Table 6-2  Supported envelopes and postcards

Size Dimensions Tray 1 Tray 2 Automatic duplex
printing

Envelope #10 105 x 241 mm (4.13 x 9.49 inches)  

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)  

Envelope C5 162 x 229 mm (6.93 x 9.84 inches)  
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Table 6-2  Supported envelopes and postcards (continued)

Size Dimensions Tray 1 Tray 2 Automatic duplex
printing

Envelope B5 176 x 250 mm (6.7 x 9.8 inches)  

Envelope
Monarch

98 x 191 mm (3.9 x 7.5 inches)  

Postcard 100 x 148 mm (3.94 x 5.83 inches)  

Double
postcard

148 x 200 mm (5.83 x 7.87 inches)  
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Supported paper types and tray capacity

Table 6-3  Tray 1

Paper type Weight Capacity1 Paper orientation

Every day:

● Plain

● Light

● Bond

● Recycled

60 to 90 g/m2 (16 to 24 lb) Up to 50 sheets Side to be printed on face-up,
with the top edge at the back of
the tray

Presentation:

● Matte paper, mid-weight to
heavy

● Glossy paper, mid-weight
to heavy

Up to 176 g/m2 (47 lb)2, 3 Up to 5 mm (0.2 in) stack height Side to be printed on face-up,
with the top edge at the back of
the tray

Brochure:

● Matte paper, mid-weight to
heavy

● Glossy paper, mid-weight
to heavy

Up to 176 g/m2 (47 lb)2, 3 Up to 5 mm (0.2 in) stack height Side to be printed on face-up,
with the top edge at the back of
the tray

Photo/cover

● Matte cover paper

● Glossy cover paper

● Matte photo paper

● Glossy photo paper

● Postcard

● Cardstock

Up to 176 g/m2 (47 lb)2, 3 Up to 5 mm (0.2 in) stack height Side to be printed on face-up,
with the top edge at the back of
the tray
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Table 6-3  Tray 1 (continued)

Paper type Weight Capacity1 Paper orientation

Other:

● Color laser transparency4

● Labels4

● Letterhead

● Envelope4

● Preprinted

● Prepunched

● Colored

● Rough

● Tough4

 Up to 50 sheets, or 10
envelopes

Side to be printed on face-up,
with the top edge toward the
product

1 Capacity can vary depending on paper weight and thickness, and environmental conditions.
2 The product supports up to 220 g/m2 (59 lb) for glossy, glossy photo paper, and postcards.
3 The product supports 60-160 g/m2 (16-42 lb) paper weight for automatic duplex printing.
4 This paper type is not supported for automatic duplex printing.

Table 6-4  Tray 2 and Tray 3

Media type Weight Capacity1 Paper orientation

Every day:

● Plain

● Light

● Bond

● Recycled

60 to 90 g/m2 (16 to 24 lb) Up to 250 sheets Side to be printed on face-up,
with the top edge at the back of
the tray

Presentation:

● Matte paper, mid-weight to
heavy

● Glossy paper, mid-weight
to heavy

Up to 163 g/m2 (43 lb)2 Up to 12.5 mm (0.5 in) stack
height

Side to be printed on face-up,
with the top edge at the back of
the tray

Brochure:

● Matte paper, mid-weight to
heavy

● Glossy paper, mid-weight
to heavy

Up to 163 g/m2 (43 lb)2 Up to 12.5 mm (0.5 in) stack
height

Side to be printed on face-up,
with the top edge at the back of
the tray
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Table 6-4  Tray 2 and Tray 3 (continued)

Media type Weight Capacity1 Paper orientation

Photo/cover

● Matte cover paper

● Glossy cover paper

● Matte photo paper

● Glossy photo paper

● Postcard

● Cardstock

Up to 163 g/m2 (43 lb)2

Postcard: Up to 176 g/m2 (47 lb)

Up to 12.5 mm (0.5 in) stack
height

Side to be printed on face-up,
with the top edge at the back of
the tray

Other:

● Color laser transparency3

● Labels3

● Letterhead

● Envelope3

● Preprinted

● Prepunched

● Colored

● Rough

● Tough3

 Up to 50 sheets, or 10
envelopes

Side to be printed on face-up,
with the top edge at the back of
the tray or the stamp-end at the
back of the tray

1 Capacity can vary depending on paper weight and thickness, and environmental conditions.
2 The product supports 60-160 g/m2 (16-42 lb) paper weight for automatic duplex printing.
3 This paper type is not supported for automatic duplex printing.
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Load paper trays

Load Tray 1

1. Open Tray 1.  

2. Pull out the extension tray.  
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3. If you are loading long sheets of paper, flip
out the extension.

 

4. Extend the paper guides fully (callout 1) and
then load the paper stack into Tray 1 (callout
2). Adjust the paper guides to the size of the
paper.

NOTE: Place the paper into Tray 1 with the
side to be printed on face-up and the top
toward the product.

 

Load Tray 2 or optional Tray 3

1. Pull the tray out of the product.  
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2. Slide open the paper length and width guides.  

3. To load Legal-size paper, extend the tray by
pressing and holding the extension tab while
pulling the front of the tray toward you.

NOTE: When it is loaded with Legal-size
paper, the tray extends from the front of the
product approximately 64 mm (2.5 inches).

 

4. Place the paper in the tray and make sure
that it is flat at all four corners. Slide the side
paper width guides so that they align with the
paper-size marking in the bottom of the tray.
Slide the front paper length guide so that it
pushes the stack of paper against the back of
the tray.
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5. Push down on the paper to make sure that
the paper stack is below the paper limit tabs
on the side of the tray.

 

6. Slide the tray into the product.  

Load the document feeder

The document feeder holds up to 50 sheets of 75 g/m2 (20 lb bond) paper.

CAUTION: To prevent damage to the product, do not load an original document that contains
correction tape, correction fluid, paper clips, or staples. Also, do not load photographs, small originals,
or fragile originals into the document feeder.
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1. Insert the originals into the document feeder
face-up.

 

2. Adjust the guides until they are snug against
the paper.
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Configure trays

By default, the product pulls paper from Tray 1. If Tray 1 is empty, the product pulls paper from Tray
2, or Tray 3 if it installed. Configuring the tray on this product changes the heat and speed settings to
obtain the best print quality for the type of paper that you are using. If you are using special paper for
all or most print jobs on the product, change this default setting on the product.

The following table lists possible ways you can use the tray settings to meet your printing needs.

Paper use Configure the product Print

Load Tray 1 and one other tray with the
same paper, and have the product pick
paper from one tray if the other one is
empty.

Load paper in Tray 1. No configuration
is needed, if the default settings for type
and size have not been changed.

From the software program, print the
job.

Occasionally use special paper, such
as heavy paper or letterhead, from a
tray that usually contains plain paper.

Load special paper in Tray 1. From the software program print dialog,
chose the paper type that matches the
special paper loaded in the tray before
sending the print job.

Frequently use special paper, such as
heavy paper or letterhead, from one
tray.

Load special paper in Tray 1, and
configure the tray for the paper type.

From the software program print dialog,
chose the paper type that matches the
special paper loaded in the tray before
sending the print job.

Configure trays

1. Make sure the product is turned on.

2. Perform one of the following tasks:

● Control panel: Open the System Setup menu, and open the Paper Setup menu. Select the
tray that you want to configure.

● Embedded Web server: Click the Settings tab, and then click Paper Handling in the left
panel.

3. Change the desired tray setting, and then press OK or click Apply.
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7 Print cartridges

The information contained herein is subject to change without notice. For the latest User Guide
information go to www.hp.com/go/LJColorMFPM375_manuals or www.hp.com/go/
LJColorMFPM475_manuals.

● Print cartridge information

● Supplies views

● Manage print cartridges

● Replacement instructions

● Solve problems with supplies

Print cartridge information

Color Cartridge number Part number

Standard-capacity replacement black
print cartridge

305A CE410A

High-capacity replacement black print
cartridge

305X CE410X

Replacement cyan print cartridge 305A CE411A

Replacement yellow print cartridge 305A CE412A

Replacement magenta print cartridge 305A CE413A

Accessibility: The print cartridge can be installed and removed by using one hand.

Environmental features: Recycle print cartridges by using the HP Planet Partners return and
recycling program.

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.
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Supplies views

Print cartridge views

1 Cartridge memory chip

2 Plastic shield

3 Imaging Drum. Do not touch the imaging drum on the bottom of the print cartridge. Fingerprints on the imaging drum
can cause print-quality problems.
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Manage print cartridges

Correctly using, storing, and monitoring the print cartridge can help ensure high-quality print output.

Change settings for print cartridges

Print when a print cartridge is at estimated end of life

Supply-related notifications are communicated on the product control panel.

● A <Supply> Low message—where <Supply> is the color cartridge—appears when a print
cartridge is nearing the estimated end of its useful life.

● A <Supply> Very Low message appears when the print cartridge is at its estimated end of
useful life. To ensure optimal print quality, HP recommends replacing a print cartridge when the
<Supply> Very Low message appears.

Print-quality problems can occur when using a cartridge that is at its estimated end of life. The supply
does not need to be replaced at this point in time unless the print quality is no longer acceptable.

NOTE: Using the Continue setting allows printing beyond Very Low without customer interaction
and can result in unsatisfactory print quality.

When a color print cartridge becomes very low, the product prints in black only to prevent fax
interruptions. To configure the product to print in color and use the remaining toner in the print
cartridge past very low, follow these steps:

1. From the Home screen on the control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Supply Settings

● Color Cartridges

● Very Low Setting

● Continue

When you choose to replace the very low print cartridge, color printing resumes automatically.
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Enable or disable the At Very Low settings from the control panel

You can enable or disable the default settings at any time, and you do not have to re-enable them
when you install a new print cartridge.

1. From the Home screen on the control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Supply Settings

● Black Cartridge or Color Cartridges

● Very Low Setting

3. Select one of the following options:

● Select the Continue option to set the product to alert you that the print cartridge is very low,
but to continue printing.

● Select the Stop option to set the product to stop printing (including printing faxes) until you
replace the print cartridge.

● Select the Prompt option to set the product to stop printing (including printing faxes) and
prompt you to replace the print cartridge. You can acknowledge the prompt and continue
printing. A customer configurable option on this product is "Prompt to Remind Me in 100
pages, 200 pages, 300 pages, or never." This option is provided as a customer
convenience and is not an indication these pages will have acceptable print quality.

● On the Color Cartridges menu only, select Print Black (the default option) to alert you when
the print cartridge is very low, but to continue printing in black only.

When the product is set to the Stop option, there is some risk that faxes will not print after the new
cartridge is installed if your product has received more faxes than the memory can hold while
stopped.

When the product is set to the Prompt option, there is some risk that faxes will not print after the new
cartridge is installed if your product has received more faxes than the memory can hold while the
product is waiting for the prompt to be acknowledged.

Once an HP supply has reached very low, HP’s premium Protection Warranty on that supply has
ended. All print defects or cartridge failures incurred when an HP supply is used in Continue at very
low mode will not be considered to be defects in materials or workmanship in the supply under the
HP Print Cartridge Warranty Statement.

Print with EconoMode

EconoMode uses less toner, which might extend the life of the print cartridge.
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HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and
is no longer acceptable, consider replacing the print cartridge.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Store and recycle supplies

Recycle supplies

To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new
cartridge arrived. Use the enclosed return label to send the used supply to HP for recycling. For
complete information, see the recycling guide that is included with each new HP supply item.

Print-cartridge storage

Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.

HP policy on non-HP print cartridges

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.

NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.

HP anticounterfeit Web site

Go to www.hp.com/go/anticounterfeit when you install an HP print cartridge and the control-panel
message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take
steps to resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).
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Replacement instructions

Replace the print cartridges

The product uses four colors and has a different print cartridge for each color: black (K), magenta (M),
cyan (C), and yellow (Y).

CAUTION: If toner gets on any clothing, wipe it off with a dry cloth and wash the clothing in cold
water. Hot water sets toner into the fabric.

1. Open the front door.  

2. Pull out the print-cartridge drawer.  
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3. Grasp the handle on the old print cartridge
and then pull the cartridge straight up to
remove it.

 

4. Remove the new print cartridge from the
packaging.

 

5. Gently rock the print cartridge from front to
back to distribute the toner evenly inside the
cartridge.
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6. Remove the orange, plastic shield from the
bottom of the new print cartridge.

 

7. Do not touch the imaging drum on the bottom
of the print cartridge. Fingerprints on the
imaging drum can cause print-quality
problems.

 

8. Insert the new print cartridge into the product.  
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9. Pull the tab on the left side of the print
cartridge straight up to completely remove the
sealing tape. Recycle the sealing tape.

 

10. Close the print-cartridge drawer.  

11. Close the front door.  

12. Place the old print cartridge, the sealing tape,
and the orange plastic shield in the box for
the new print cartridge. Follow the recycling
instructions that are included in the box.

 

ENWW Replacement instructions 95



Solve problems with supplies

Check the print cartridges

Check each print cartridge, and replace it if necessary, if you are having any of the following
problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

NOTE: If you are using a draft print setting, the printing might appear light.

If you determine that you need to replace a print cartridge, print the Supplies Status Page to find the
part number for the correct genuine HP print cartridge.

Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge.

Genuine HP print cartridge 1. The product control panel or the Supplies Status page indicates Very Low
status when the cartridge has reached the end of its estimated life. Replace
the print cartridge if print quality is no longer acceptable.

2. Print a Print Quality Page from the Reports menu. If streaks or marks are in
one color on the page, you might have a defect in that color cartridge. See
the instructions in this document for interpreting the page. Replace the print
cartridge if necessary.

3. Visually inspect the print cartridge for damage. See the instructions that
follow. Replace the print cartridge if necessary.

4. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repetitive defects ruler in this document to identify the cause of the problem.
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Print the Supplies Status page

The Supplies Status page indicates the estimated life remaining in print cartridges. It also lists the
part number for the correct genuine HP print cartridge for your product so you can order a
replacement print cartridge, as well as other useful information.

1. At the control panel, press the OK button to open the menus.

2. Open the following menus:

● Reports

● Supplies Status
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Interpret the Print Quality Page

1. On the product control panel, open the Reports menu.

2. Select the Print Quality Page item to print it.

This page contains five bands of color, which are divided into four groups as indicated in the following
illustration. By examining each group, you can isolate the problem to a particular print cartridge.

Section Print-cartridge

1 Yellow

2 Cyan

3 Black

4 Magenta

● If dots or streaks appear in only one of the groups, replace the print cartridge that correlates with
that group.

● If dots appear in more than one group, print a cleaning page. If this does not solve the problem,
determine if the dots are always the same color; for example, if magenta dots appear in all five
color bands. If the dots are all the same color, replace that print cartridge.

● If streaks appear in multiple color bands, contact HP. A component other than the print cartridge
is probably causing the problem.

Inspect the print cartridge for damage

1. Remove the print cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.
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3. Examine the surface of the green imaging drum on the bottom of the print cartridge.

CAUTION: Do not touch the green roller (imaging drum) on the bottom of the cartridge.
Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the print
cartridge.

5. If the imaging drum does not appear to be damaged, rock the print cartridge gently several times
and reinstall it. Print a few pages to see if the problem has resolved.

Repeating defects

If defects repeat at any of the following intervals on the page, a print cartridge might be damaged.

● 22 mm

● 27 mm

● 28 mm

● 75 mm
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Interpret control panel messages for supplies

10.100X Supply Memory Error

Description

A specific print cartridge has a faulty or missing memory chip.

"X" indicates the cartridge: 0=black, 1=cyan, 2=magenta, 3=yellow.

Recommended action

Check the memory chip. If it is broken or damaged, replace the cartridge.

Verify that the cartridge is installed in the correct location.

Reinstall the print cartridge.

Turn off and then turn on the product.

If the error is with a color cartridge, try swapping it with a different color cartridge in the tray. If the
same message appears, then there is an engine problem. If a different 10.100X message appears,
replace the cartridge.

If the problem is not solved, replace the cartridge.

Black Cartridge Low

Description

The print cartridge is nearing the end of its useful life.

Recommended action

Printing can continue, but consider having a replacement supply on hand.

Black in wrong position

Description

The print cartridge is installed in the incorrect slot.

Recommended action

Make sure that each print cartridge is installed in the correct slot. From front to back, the print
cartridges are installed in this order: black, cyan, magenta, and yellow.

Black Very Low

Description

The print cartridge is at the end of its useful life. The product continues printing to prevent fax
interruptions.
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Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can
continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has
ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very
low mode will not be considered to be defects in materials or workmanship in the supply under the HP
Print Cartridge Warranty Statement.

Cyan Cartridge Low

Description

The print cartridge is nearing the end of its useful life.

Recommended action

Printing can continue, but consider having a replacement supply on hand.

Cyan in wrong position

Description

The print cartridge is installed in the incorrect slot.

Recommended action

Make sure that each print cartridge is installed in the correct slot. From front to back, the print
cartridges are installed in this order: black, cyan, magenta, and yellow.

Cyan Very Low

Description

The print cartridge is at the end of its useful life. When a color print cartridge becomes very low, the
product prints in black only to prevent fax interruptions. When you choose to replace the very low
print cartridge, color printing resumes automatically.

Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can
continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has
ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very
low mode will not be considered to be defects in materials or workmanship in the supply under the HP
Print Cartridge Warranty Statement.

Genuine HP supply installed

Description

A genuine HP supply was installed.
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Recommended action

No action necessary.

Incompatible <color>

Description

You have installed a print cartridge that is intended for use in a different HP product model. The
product might not function correctly with this print cartridge installed.

Recommended action

Install the correct print cartridge for this product.

Install [color] cartridge

Description

One of the color cartridges is not installed with the door closed.

Recommended action

Install the indicated color cartridge.

Magenta Cartridge Low

Description

The print cartridge is nearing the end of its useful life.

Recommended action

Printing can continue, but consider having a replacement supply on hand.

Magenta in wrong position

Description

The print cartridge is installed in the incorrect slot.

Recommended action

Make sure that each print cartridge is installed in the correct slot. From front to back, the print
cartridges are installed in this order: black, cyan, magenta, and yellow.

Magenta Very Low

Description

The print cartridge is at the end of its useful life. When a color print cartridge becomes very low, the
product prints in black only to prevent fax interruptions. When you choose to replace the very low
print cartridge, color printing resumes automatically.

102 Chapter 7   Print cartridges ENWW



Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can
continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has
ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very
low mode will not be considered to be defects in materials or workmanship in the supply under the HP
Print Cartridge Warranty Statement.

Remove shipping lock from <color> cartridge

Description

A print cartridge shipping lock is installed.

Recommended action

Pull the orange tab to remove the shipping lock from the cartridge.

Remove shipping locks from cartridges

Description

A print cartridge shipping lock is installed on one or more print cartridges.

Recommended action

Pull the orange tab to remove the shipping lock from the cartridge.

Replace [color]

Description

The print cartridge is at the end of its useful life, and the product is customer-configured to stop
printing when it reaches the very low state.

Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can
continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has
ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very
low mode will not be considered to be defects in materials or workmanship in the supply under the HP
Print Cartridge Warranty Statement.

Unsupported <color> Press [OK] to continue

Description

The product has detected a print cartridge that was not made by HP.
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Recommended action

Press the OK button to continue printing.

If you believe you purchased an HP supply, go to www.hp.com/go/anticounterfeit. Service or repairs
that are required as a result of using unsupported supplies is not covered under HP warranty.

Used <color> in use

Description

You are using a print cartridge that reached the default low threshold while it was installed in a
product.

Recommended action

Printing can continue, but consider having a replacement supply on hand.

Used [color] installed, to accept press OK

Description

A used color print cartridge has been installed or moved.

Recommended action

Touch the OK button to return to the Ready state.

Used supplies in use

Description

You are using more than one print cartridge that reached the default low threshold while it was
installed in a product.

Recommended action

Printing can continue, but consider having replacement supplies on hand.

Yellow Cartridge Low

Description

The print cartridge is nearing the end of its useful life.

Recommended action

Printing can continue, but consider having a replacement supply on hand.

Yellow in wrong position

Description

The print cartridge is installed in the incorrect slot.
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Recommended action

Make sure that each print cartridge is installed in the correct slot. From front to back, the print
cartridges are installed in this order: black, cyan, magenta, and yellow.

Yellow Very Low

Description

The print cartridge is at the end of its useful life. When a color print cartridge becomes very low, the
product prints in black only to prevent fax interruptions. When you choose to replace the very low
print cartridge, color printing resumes automatically.

Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can
continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has
ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very
low mode will not be considered to be defects in materials or workmanship in the supply under the HP
Print Cartridge Warranty Statement.
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8 Print tasks

● Cancel a print job

● Basic print tasks with Windows

● Use HP ePrint

● Additional print tasks with Windows

● Walk-up USB printing
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Cancel a print job

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that
currently appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or print
spooler, delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and then click
Printers and Faxes. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware and
Sound, click Printer. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the
product icon to open the window, right-click the print job that you want to cancel, and
then click Cancel.
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Basic print tasks with Windows

The methods to open the print dialog from software programs can vary. The procedures that follow
include a typical method. Some software programs do not have a File menu. See the documentation
for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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Get help for any printing option with Windows

1. Click the Help button to open the online Help.  
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Change the number of print copies with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.

Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.

 

Create printing shortcuts

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, all your adjustments
are lost.
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5. Select the print options for the new shortcut.  

6. Click the Save As button.  

7. Type a name for the shortcut, and click the
OK button.

 

Improve print quality with Windows

Select the page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

Select a custom page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

NOTE: Always load paper into the trays short edge first.

6. Click the OK button, and then click the OK button on the Paper/Quality tab. The custom page
size will appear in the list of paper sizes the next time you open the printer driver.

Select the paper type with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper, and then click the paper
type that you are using.

Select the paper tray with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a tray from the Paper source drop-down list.
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Print on both sides (duplex) with Windows

Print on both sides manually with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the Print on both sides (manually)
check box. Click the OK button to print the
first side of the job.

 

5. Retrieve the printed stack from the output bin,
and maintaining the same orientation, place it
with the printed side facing down in Tray 1.

 

6. On the control panel, press the OK button to
print the second side of the job.

 

Automatically print on both sides with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. Select the Print on both sides check box.
Click the OK button to print the job.
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Print multiple pages per sheet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from
the Pages per sheet drop-down list.

 

5. Select the correct Print page borders, Page
order, and Orientation options.

 

Select page orientation with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait or
Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.
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Set color options with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Click the HP EasyColor check box to clear it.

5. In the Color Options area, click the Manual option, and then click the Settings button.

6. Adjust the general settings for Edge Control, and settings for text, graphics, and photographs.
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Use HP ePrint

Use HP ePrint to print documents by sending them as an e-mail attachment to the product's e-mail
address from any e-mail enabled device.

NOTE: The product must be connected to a wired or wireless network and have Internet access to
use HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.

a. From the Home screen on the product control panel, touch the Web Services  button.

b. Touch the Enable Web Services button.

2. From the HP Web Services menu, touch the Display E-Mail Address button to display the
product's e-mail address on the control panel.

3. Use the HP ePrintCenter Web site to define security settings and to configure default print
settings for all HP ePrint jobs sent to this product.

a. Go to www.hpeprintcenter.com.

b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.

c. Select your product from the list, or click + Add printer to add it. To add the product, you
need the printer code, which is the segment of the product e-mail address that is before the
@ symbol.

NOTE: This code is valid for only 24 hours from the time you enable HP Web Services. If
it expires, follow the instructions to enable HP Web Services again, and obtain a new code.

d. To prevent your product from printing unexpected documents, click ePrint Settings, and
then click the Allowed Senders tab. Click Allowed Senders Only, and add the e-mail
addresses from which you want to allow ePrint jobs.

e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click
Print Options, and select the settings that you want to use.

4. To print a document, attach it to an e-mail message sent to the product's e-mail address.
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Additional print tasks with Windows

Print colored text as black (grayscale) with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Advanced tab.

4. Expand the Document Options section.

5. Expand the Printer Features section.

6. In the Print All Text as Black drop-down list, select the Enabled option.

Print on preprinted letterhead or forms with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.

 

5. Expand the list of Type is: options.  
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6. Expand the list of Other options.  

7. Select the option for the type of paper you are
using, and click the OK button.

 

Print on special paper, labels, or transparencies with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.
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5. Expand the list of Type is: options.  

6. Expand the category of paper types that best
describes your paper.

NOTE: Labels and transparencies are in the
list of Other options.

 

7. Select the option for the type of paper you are
using, and click the OK button.

 

128 Chapter 8   Print tasks ENWW



Print the first or last page on different paper with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. In the Special pages area, click the Print
pages on different paper option, and then
click the Settings button.

 

5. In the Pages in document area, select either
the First or Last option.

 

6. Select the correct options from the Paper
source and Paper type drop-down lists. Click
the Add button.
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7. If you are printing both the first and last pages
on different paper, repeat steps 5 and 6,
selecting the options for the other page.

 

8. Click the OK button.  

Scale a document to fit page size with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print document on option, and
then select a size from the drop-down list.
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Add a watermark to a document with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise,
the watermark is printed on each page.

Create a booklet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the Print on both sides check box.  

5. In the Booklet layout drop-down list, click the
Left binding or Right binding option. The
Pages per sheet option automatically
changes to 2 pages per sheet.
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6. Retrieve the printed stack from the output bin,
and maintaining the same orientation, place it
with the printed-side facing down in Tray 1.

 

7. On the control panel, touch the OK button to
print the second side of the job.
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Walk-up USB printing

This product features printing from a USB flash drive, so you can quickly print files without sending
them from a computer. The product accepts standard USB storage accessories in the USB port on
the front of the product. You can print the following types of files:

● .PDF

● .JPEG

1. Insert the USB drive into the USB port on the
front of the product.

 

2. The USB Flash Drive menu opens. Touch
one of the following options.

● Print Documents

● View and Print Photos

● Scan to USB Drive

 

3. To print a document, touch the Print
Documents item, and then touch the name of
the folder on the USB drive where the
document is stored. When the summary
screen opens, you can touch it to adjust the
settings. Touch the Print button to print the
document.
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4. To print photos, touch the View and Print
Photos item, and then touch the preview
image for each photo that you want to print.
Touch the Done button. When the summary
screen opens, you can touch it to adjust the
settings. Touch the Print button to print the
photos.

 

5. To scan a document and save it as a .JPEG
or .PDF file onto the USB drive, load the
document onto the scanner glass or into the
document feeder. Touch the Scan to USB
Drive item. Touch the Settings... button to
adjust the scan settings.

 

ENWW Walk-up USB printing 137



138 Chapter 8   Print tasks ENWW



9 Color

● Adjust color

● Use the HP EasyColor option

● Match colors to your computer screen
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Adjust color

Manage color by changing the settings on the Color tab in the printer driver.

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for
correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a
digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None: No color theme is used.
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Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click the Print item.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Clear the HP EasyColor check box.

5. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

6. Click the Print in Grayscale option to print a color document in black and shades of gray. Use
this option to print color documents for photocopying or faxing. You can also use this option to
print draft copies or to save color cartridge life.

7. Click the OK button.

Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for text,
graphics, and photographs.
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Table 9-1  Manual color options

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering
of edges. Edge control has two components:
adaptive halftoning and trapping. Adaptive
halftoning increases edge sharpness. Trapping
reduces the effect of color-plane misregistration by
overlapping the edges of adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is
on.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.

Halftone

Halftone options affect color output clarity and
resolution.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations.
Select this option when uniform and smooth area fills are
important.

● Detail is useful for text and graphics that require sharp
distinctions among lines or colors, or images that contain a
pattern or a high level of detail. Select this option when sharp
edges and small details are important.

Neutral Grays

The Neutral Grays setting determines the method
for creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale
viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.
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Use the HP EasyColor option

If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically
improves mixed-content documents that are printed from Microsoft Office programs. This technology
scans documents and automatically adjusts photographic images in .JPEG or .PNG format.
HP EasyColor technology enhances the entire image at one time, rather than dividing it into several
pieces, which results in improved color consistency, sharper details, and faster printing.

If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all
documents and automatically adjusts all photographic images with the same improved photographic
results.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in both the HP PCL 6 printer driver and the HP Mac
Postscript printer driver, so you do not need to make manual color adjustments. To disable the option
so you can manually adjust the color settings, open the Color tab in the Windows driver or the Color/
Quality Options tab in the Mac driver, and then click the HP EasyColor check box to clear it.
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Match colors to your computer screen

For most users, the best method for matching colors is to print sRGB colors.

The process of matching printer output color to your computer screen is complex, because printers
and computer monitors use different methods of producing color. Monitors display colors by using
light pixels that use an RGB (red, green, blue) color process, but printers print colors by using a
CMYK (cyan, magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

● Print media

● Printer colorants (inks or toners, for example)

● Printing process (inkjet, press, or laser technology, for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating systems

● Monitors

● Video cards and drivers

● Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.
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10 Copy

● Use copy functions

● Copy settings

● Copy photos

● Copy mixed size originals

● Copy on both sides
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Use copy functions

Copy

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen, touch the Copy button.

3. Touch the Black or Color button to start copying.

Multiple copies

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen, touch the Copy button.
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3. Touch the arrows to change the number of copies, or touch the existing number and type the
number of copies.

4. Touch the Black or Color button to start copying.

Copy a multiple-page original

1. Insert the originals into the document feeder face-up.

2. Adjust the guides until they are snug against the paper.

3. From the Home screen, touch the Copy button.

4. Touch the Black or Color button to start copying.
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Copy identification cards

Use the ID Copy feature to copy both sides of identification cards, or other small-size documents,
onto the same side of one sheet of paper. The product prompts you to copy the first side and then to
place the second side on a different area of the scanner glass and copy again. The product prints
both images at the same time.

1. Load the document onto the scanner glass.  

2. From the Home screen, touch the Copy
button.

 

3. Touch the ID Copy button.  

4. Touch the Black or Color button to start
copying.

 

5. The product prompts you to place the next
page on a different section of the scanner
glass.

 

6. Touch the OK button if you have more pages
to copy, or touch the Done button if this is the
last page.

 

7. The product copies all pages onto one side of
a sheet of paper.
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Cancel a copy job

1. Touch the Cancel  button on the product control panel.

NOTE: If more than one process is running, touching the Cancel  button clears the current
process and all pending processes.

2. Remove the remaining pages from the document feeder.

Reduce or enlarge a copy

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen, touch the Copy
button.

 

3. Touch the Settings... button, and then touch
the Reduce/Enlarge button. Touch the arrow
buttons to scroll through the options, and then
touch an option to select it.

 

4. Touch the Black or Color button to start
copying.
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Collate a copy job

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen, touch the Copy
button.

 

3. Touch the Settings... button, and then scroll to
and touch the Collation button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Black or Color button to start
copying.
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Make color or black and white copies

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen, touch the Copy button.

3. Touch the Black or Color button to start copying.
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Copy settings

Change copy quality

The following copy-quality settings are available:

● Auto Select: Use this setting when you are not concerned about the quality of the copy. This is
the default setting.

● Mixed: Use this setting for documents that contain a mixture of text and graphics.

● Text: Use this setting for documents that contain mostly text.

● Picture: Use this setting for documents that contain mostly graphics.

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen, touch the Copy
button.

 

3. Touch the Settings... button, and then scroll to
and touch the Optimize button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Black or Color button to start
copying.

 

152 Chapter 10   Copy ENWW



Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. This can cause vertical streaks on copy jobs from the document feeder, and
specks on copy jobs from the flatbed scanner glass. Use the following procedure to clean the scanner
glass and white plastic backing.

1. Use the power switch to turn off the product,
and then unplug the power cord from the
electrical socket.

 

2. Open the scanner lid.  

3. For specks on flatbed copy jobs, clean the
scanner glass and the white plastic backing
with a soft cloth or sponge that has been
moistened with nonabrasive glass cleaner.

For vertical streaks on document feeder copy
jobs, clean the document feeder scanner strip
on the left side of the product with a soft cloth
or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might
seep and damage the product.

 

4. Dry the glass and white plastic with a chamois
or a cellulose sponge to prevent spotting.

 

5. Plug in the product, and then use the power
switch to turn on the product.
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Adjust the lightness or darkness for copies

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen, touch the Copy
button.

 

3. On the summary screen, touch the arrow
buttons to adjust the setting.

 

4. Touch the Black or Color button to start
copying.

 

Define custom copy settings

When you change the copy settings at the control panel, the custom settings remain in effect for
approximately 2 minutes after the job completes, and then the product returns to the default settings.
To immediately return to the defaults, press the Cancel  button from the Home screen.

Print or copy edge-to-edge

The product cannot print fully edge-to-edge. The maximum printing area is 203.2 x 347 mm (8 x
13.7 in), leaving a 4 mm unprintable border around the page.

Considerations for printing or scanning documents with cropped edges:

● When the original is smaller than the output size, move the original 4 mm (1/6 inch) away from
the corner indicated by the icon on the scanner. Recopy or scan in this position.

● When the original is the size of the desired output, use the Reduce/Enlarge feature to reduce the
image so the copy is not cropped.
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Set the paper size and type for copying on special paper

1. From the Home screen, touch the Copy
button.

 

2. Touch the Settings... button, and then scroll to
and touch the Paper button.

 

3. From the list of paper sizes, touch the name
of the paper size that is in Tray 1.

 

4. From the list of paper types, touch the name
of the paper type that is in Tray 1.

 

5. Touch the Black or Color button to start
copying.

 

Restore copy default settings

1. From the Home screen, touch the Copy
button.

 

2. Touch the Settings... button, and then scroll to
and touch the Restore Defaults button.
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Copy photos

NOTE: Copy photos from the scanner glass, not from the document feeder.

1. Place the photo on the scanner glass, picture-side down at the upper left corner of the glass,
and close the scanner lid.

2. From the Home screen, touch the Copy button.

3. Touch the Settings... button, and then touch the Optimize button.

4. Touch the Picture button.

5. Touch the Black or Color button to start copying.
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Copy mixed size originals

Use the scanner glass to make copies of mixed size originals.

NOTE: You can use the document feeder to copy mixed size originals only if the pages share a
common dimension. For example, you can combine Letter and Legal size pages because they have
the same width. Stack the pages so the top edges are even with each other and so the pages have
the same width but varying lengths.

1. In Tray 1, load paper that is large enough for the largest page in the original document.

2. Place one page of the original document face down in the upper left corner of the scanner glass.

3. From the Home screen, touch the Copy button.

4. Touch the Settings... button, and then scroll to and touch the Paper button.

5. From the list of paper sizes, touch the name of the paper size that is loaded in Tray 1.

6. From the list of paper types, touch the name of the paper type that is loaded in Tray 1.

7. Touch the Black or Color button to start copying.

8. Repeat these steps for each page.
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Copy on both sides

Copy on both sides automatically (duplex models only)

1. Load the first page of the document onto the
scanner glass or into the document feeder.

 

2. From the Home screen, touch the Copy
button.

 

3. Touch the Settings... button, and then open
the Two Sided menu.

 

4. Select the duplexing option that you want to
use. For example, to copy a two-sided original
with two-sided output, select the 2-Sided to 2-
Sided option.

 

5. Touch the Black or Color button to start
copying.
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Copy on both sides manually

1. Load the first page of the document onto the
scanner glass or into the document feeder.

 

2. From the Home screen, touch the Copy
button.

 

3. Touch the Black or Color button to start
copying.

 

4. Remove the printed copy from the output bin,
and load the pages into Tray 1 with the
printed side down and the top edge at the
back of the tray.
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5. Load the next page of the document onto the
scanner glass or into the document feeder.

 

6. From the Home screen, touch the Copy
button.

 

7. Touch the Black or Color button to start
copying.

 

8. Repeat these steps until the copy is complete.  
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● Use scan functions

● Scan settings

● Scan a photo
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Use scan functions

Use the product to scan a document from the scanner glass or document feeder. For duplex models,
you can also create two-sided scans.

Scan methods

Perform scan jobs in the following ways.

● Scan to a USB flash drive from the product control panel.

● Scan from the computer by using HP Scan software

● Scan from TWAIN-compliant or Windows Imaging Application (WIA)-compliant software

NOTE: To learn about and use text-recognition software, install the Readiris program from the
software CD. Text-recognition software is also known as optical character recognition (OCR)
software.

Scan to a USB flash drive

1. Load the document onto the scanner glass or into the document feeder.

2. Insert a USB flash drive into the port on the front of the product.

3. From the Home screen, touch the Scan button.

4. Touch the Scan to USB Drive screen.

5. Touch the Scan button to scan and save the file. The product creates a folder named HP on the
USB drive, and it saves the file in .PDF or .JPG format using an automatically generated file
name.

NOTE: When the summary screen opens, you can touch it to adjust settings.

Scan by using HP Scan software (Windows)

1. Double-click the HP Scan icon on the computer desktop.

2. Select a scanning shortcut, and adjust the settings if necessary.

3. Click Scan.

NOTE: Click Advanced Settings to gain access to more options.

Click Create New Shortcut to create a customized set of settings and save it in the list of shortcuts.

Scan by using other software

The product is TWAIN-compliant and Windows Imaging Application (WIA)-compliant. The product
works with Windows-based programs that support TWAIN-compliant or WIA-compliant scanning
devices and with Macintosh-based programs that support TWAIN-compliant scanning devices.
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While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning
feature and scan an image directly into the open program. For more information, see the Help file or
the documentation that came with your TWAIN-compliant or WIA-compliant software program.

Scan from a TWAIN-compliant program

Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File
Acquire, Scan, Import New Object, Insert from, or Scanner. If you are unsure whether the
program is compliant or you do not know what the command is called, see the software program Help
or documentation.

When scanning from a TWAIN-compliant program, the HP Scan software program might start
automatically. If the HP Scan program starts, you can make changes while previewing the image. If
the program does not start automatically, the image goes to the TWAIN-compliant program
immediately.

Start the scan from within the TWAIN-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

Scan from a WIA-compliant program

WIA is another way to scan an image directly into a software program. WIA uses Microsoft software
to scan, instead of the HP Scan software.

Generally, a software program is WIA-compliant if it has a command such as Picture/From Scanner
or Camera in the Insert or File menu. If you are unsure whether the program is WIA-compliant, see
the software program Help or documentation.

Start the scan from within the WIA-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

-Or-

From the Windows control panel, in the Cameras and Scanner folder (located inside the Hardware
and Sound folder for Windows Vista and Windows 7), double-click the product icon. This opens the
standard Microsoft WIA Wizard, which enables you to scan to a file.

Scan by using optical character recognition (OCR) software

To import scanned text into your preferred word-processing program for editing, open the HP Scan
software and select the shortcut named Save as Editable Text (OCR).

You can also use third-party OCR software. The Readiris OCR program is included on a separate CD
that shipped with the product. To use the Readiris program, install it from the appropriate software
CD, and then follow the instructions in the online Help.

Cancel a scan

To cancel a scan job, use one of the following procedures.

● On the product control panel, touch the Cancel  button.

● Click the Cancel button in the on-screen dialog box.
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Scan settings

Scanner resolution and color

If you are printing a scanned image, and the quality is not what you expected, you might have
selected a resolution or color setting in the scanner software that does not match your needs.
Resolution and color affect the following features of scanned images:

● Image clarity

● Texture of gradations (smooth or rough)

● Scan time

● File size

Scanning resolution is measured in pixels per inch (ppi).

NOTE: Scanning ppi levels are not interchangeable with printing dpi (dots per inch) levels.

Color, grayscale, and black and white define the number of colors possible. You can adjust the
scanner hardware resolution to up to 1200 ppi. 

The resolution and color guidelines table lists simple tips that you can follow to meet your scanning
needs.

NOTE: Setting the resolution and color to a high value can create large files that take up disk space
and slow the scanning process. Before setting the resolution and color, determine how you are going
to use the scanned image.
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Resolution and color guidelines

The following table describes the recommended resolution and color settings for different types of
scan jobs.

NOTE: The default resolution is 200 ppi.

Intended use Recommended resolution Recommended color settings

Fax 150 ppi ● Black and White

E-mail 150 ppi ● Black and White, if the image does not require
smooth gradation

● Grayscale, if the image requires smooth
gradation

● Color, if the image is in color

Edit text 300 ppi ● Black and White

Print (graphics or text) 600 ppi for complex graphics, or if you
want to significantly enlarge the
document

300 ppi for normal graphics and text

150 ppi for photos

● Black and White for text and line art

● Grayscale for shaded or colored graphics and
photos

● Color, if the image is in color

Display on screen 75 ppi ● Black and White for text

● Grayscale for graphics and photos

● Color, if the image is in color

Color

You can set the color values to the following settings when scanning.

Setting Recommended use

Color Use this setting for high-quality color photos or documents in which the color is
important.

Black and White Use this setting for text documents.

Grayscale Use this setting when file size is an issue or when you want to scan a document or
photograph quickly.
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Scan quality

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner glass and white plastic backing.

1. Use the power switch to turn off the product,
and then unplug the power cord from the
electrical socket.

 

2. Open the scanner lid.  

3. Clean the scanner glass and the white plastic
backing with a soft cloth or sponge that has
been moistened with nonabrasive glass
cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might
seep and damage the product.

 

4. Dry the glass and white plastic with a chamois
or a cellulose sponge to prevent spotting.

 

5. Plug in the product, and then use the power
switch to turn on the product.
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Scan a photo

1. Place the photo on the scanner glass, picture-side down at the upper left corner of the glass,
and close the scanner lid.

2. Insert a USB flash drive into the port on the front of the product.

3. From the Home screen, touch the Scan button.

4. Touch the Scan to USB Drive button. The control panel shows a summary of scan settings.
Touch this screen to adjust any settings.

5. Touch the Scan button to scan the document and save it in a folder on the USB flash drive.
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Set up fax

Install and connect the hardware

Connect fax to a telephone line

▲ Connect the telephone cable provided with the product to the fax “line in” port  on the product

and to the telephone jack on the wall.

The product is an analog faxing device. HP recommends using the product on a dedicated analog
telephone line. If you are using a digital environment, such as DSL, PBX, ISDN, or VoIP, make sure
to use the correct filters and configure the digital settings correctly. For more information, contact your
digital service provider.

NOTE: Some countries/regions might require an adapter to the phone cord that came with the
product.

Connect additional devices

The product includes two fax ports:

● The fax “line in” port , which connects the product to the wall telephone jack.

● The fax “telephone line out” port , which connects additional devices to the product.

Telephones used in conjunction with the product can be employed in two ways:

● An extension phone is a phone plugged into the same phone line at another location.

● A downstream phone is one that is plugged into the product or a device that is plugged into the
product.

Connect additional devices in the order that is described in the following steps. The output port for
each device is connected to the input port of the next, forming a "chain". If you do not want to connect
a specific device, skip the step that explains it and continue to the next device.

NOTE: Do not connect more than three devices to the telephone line.

NOTE: Voicemail is not supported with this product.

1. Unplug the power cords for all of the devices that you want to connect.

2. If the product is not yet connected to a telephone line, see the product installation guide before
proceeding. The product should already be connected to a telephone jack.
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3. Remove the plastic insert from the "telephone line out" port (the port that is marked with the
telephone icon).
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4. To connect an internal or external modem on a computer, plug one end of a telephone cord into

the product “telephone line out” port . Plug the other end of the telephone cord into the fax

“line in” port.

NOTE: Some modems have a second “line” port to connect to a dedicated voice line. If you
have two “line” ports, see your modem documentation to make sure that you connect to the
correct “line” port.

5. To connect a caller-ID box, plug a telephone cord into the previous device’s “telephone” port.
Plug the other end of the telephone cord into the caller-ID box “line” port.
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6. To connect an answering machine, plug a telephone cord into the previous device’s “telephone”
port. Plug the other end of the telephone cord into the answering machine “line” port.

7. To connect a telephone, plug a telephone cord into the previous device’s “telephone” port. Plug
the other end of the telephone cord into the telephone “line” port.

8. After you have finished connecting additional devices, plug all of the devices into their power
sources.

Set up fax with a telephone answering machine

● Set the product rings-to-answer setting for at least one ring more than the number of rings for
which the answering machine is set.

● If an answering machine is connected to the same telephone line but on a different jack (in
another room, for example), it might interfere with the product's ability to receive faxes.

Set up fax with an extension phone

With this setting turned on, you can alert the product to pick up the incoming fax call by pressing
1-2-3 sequentially on the telephone keypad. The default setting is On. Turn this setting off only if you
use pulse dialing or if you have a service from your telephone company that also uses the 1-2-3
sequence. The telephone company service does not work if it conflicts with the product.

1. On the control panel, touch the Setup  button.

2. Scroll to and touch the Fax Setup menu.

3. Scroll to and touch the Advanced Setup button.

4. Scroll to and touch the Extension Phone button, and touch the On button.
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Setup for stand-alone fax

1. Unpack and set up the product.

2. From the Home screen, touch the Setup  button.

3. Touch the Fax Setup menu.

4. Touch the Fax Set-Up Utility button.

5. Follow the on-screen prompts and select the appropriate response for each question.

NOTE: The maximum number of characters for the fax number is 20.

NOTE: The maximum number of characters for the fax header is 25.

Configure fax settings

You can configure the product fax settings from the control panel, the Fax Setup Wizard (if the
software is installed), HP Device Toolbox (if the software is installed), or from the HP Embedded Web
Server (if the product is connected to a network).

In the United States and many other countries/regions, setting the time, date, and other fax header
information is a legal requirement.

Use the control panel to set the fax time, date, and header

To use the control panel to set the date, time, and header, complete the following steps:

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Scroll to and touch the Time/Date button.

5. Select the 12-hour clock or 24-hour clock.

6. Use the keypad to enter the current time, and then touch the OK button.

7. Select the date format.

8. Use the keypad to enter the current date, and then touch the OK button.

9. Touch the Fax Header menu.

10. Use the keypad to enter your fax number, and then touch the OK button.

NOTE: The maximum number of characters for the fax number is 20.

11. Use the keypad to enter your company name or header, and then touch the OK button.

NOTE: The maximum number of characters for the fax header is 25.
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Use of common localized letters in fax headers

When using the control panel to enter your name in the header or to enter a name for a one-touch
key, speed-dial entry, or group-dial entry, touch the 123 button to open a keypad that contains special
characters.

Use the HP Fax Setup Wizard

If you did not complete the fax setup process at the time you installed the software, you can complete
it at any time by using the HP Fax Setup Wizard.

1. Click Start, and then click Programs.

2. Click HP, click the name of the product, and then click HP Fax Setup Wizard.

3. Follow the onscreen instructions in the HP Fax Setup Wizard to configure the fax settings.
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Use the phone book

You can store frequently dialed fax numbers (up to 120 entries) either as individual fax numbers or as
groups of fax numbers.

Use the control panel to create and edit the fax phone book

1. From the Home screen, touch the Fax button.  

2. Touch the Fax Menu button.  

3. Touch the Phone Book Setup button.  

4. Touch the Individual Setup button to create a
speed dial entry.

 

5. Touch an unassigned number from the list.  

6. Use the keypad to enter a name for the entry,
and then touch the OK button.

 

7. Use the keypad to enter the fax number for
the entry, and then touch the OK button.

 

Import or export Microsoft Outlook contacts into the fax phone book

1. Type the product IP address into the address line of a Web browser to open the HP Embedded
Web Server.

2. Click the Fax tab, and then click the Fax Phone Book option.

3. Browse to the program phone book, and then click the Import/Export Phone Book option.

Use phone-book data from other programs

NOTE: Before a phone book from another program can be imported, you must use the export
feature in that other program.

HP ToolboxFX can import contact information from the following software program phone books.

● Microsoft Outlook

● Lotus Notes

● Microsoft Outlook Express

● A phone book previously exported from another HP product's ToolboxFX software.
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Delete phone book entries

You can delete all phone book entries that are programmed in the product.

CAUTION: After phone book entries are deleted, they cannot be recovered.

1. From the Home screen, touch the Fax button.  

2. Touch the Fax Menu button.  

3. Touch the Phone Book Setup button.  

4. Touch the Delete Entry button. Or, to delete
all the entries, touch the Delete All Entries
button.

 

5. Touch the entry that you want to delete.  

Use speed dials

Create and edit speed-dial entries

1. From the Home screen, touch the Fax button.  

2. Touch the Fax Menu button.  

3. Touch the Phone Book Setup button.  

4. Touch the Individual Setup button.  

5. Touch an unassigned number from the list.  

6. Use the keypad to enter a name for the entry,
and then touch the OK button.

 

7. Use the keypad to enter the fax number for
the entry, and then touch the OK button.
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Delete speed-dial entries

1. From the Home screen, touch the Fax button.  

2. Touch the Fax Menu button.  

3. Touch the Phone Book Setup button.  

4. Touch the Delete Entry button. Or, to delete
all the entries, touch the Delete All Entries
button.

 

5. Touch the entry that you want to delete.  

Manage group-dial entries

Create and edit group-dial entries

1. Create an individual entry for each fax number that you want in the group.

a. From the Home screen, touch the Fax button.

b. Touch the Fax Menu button.

c. Touch the Phone Book Setup button.

d. Touch the Individual Setup button.

e. Touch an unassigned number from the list.

f. Use the keypad to enter a name for the entry, and then touch the OK button.

g. Use the keypad to enter the fax number for the entry, and then touch the OK button.

2. From the Phone Book Setup menu, touch the Group Setup button.

3. Touch an unassigned number from the list.

4. Use the keypad to enter a name for the group, and then touch the OK button.

5. Touch the name of each individual entry that you want to include in the group. When you are
finished, touch the Done Selecting button.

Delete group-dial entries

1. From the Home screen, touch the Fax button.

2. Touch the Fax Menu button.
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3. Touch the Phone Book Setup button.

4. Touch the Delete Entry button. Or, to delete all the entries, touch the Delete All Entries button.

5. Touch the entry that you want to delete.
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Set fax settings

Send fax settings

Set special dialing symbols and options

You can insert pauses into a fax number that you are dialing. Pauses are often needed when dialing
internationally or connecting to an outside line.

Special symbol Button Description

Dialing pause The Redial/Pause button is available on the control panel keypad for
entering a fax number. You can also touch the comma button to insert a
dialing pause.

Pause for dial tone The W button is available only when you are entering the fax number for
a phone book entry. This character causes the product to wait for a dial
tone before dialing the remainder of the telephone number.

Hook flash The R button is available only when you are entering the fax number for a
phone book entry. This character causes the product to insert a hook
flash.

Set a dialing prefix

A dial prefix is a number or group of numbers that are automatically added to the beginning of every
fax number you enter at the control panel or from the software. The maximum number of characters
for a dial prefix is 50.

The default setting is Off. You might want to turn this setting on and enter a prefix if, for example, you
have to dial a number such as 9 to get a telephone line outside of your company telephone system.
While this setting is active, you can dial a fax number without the dial prefix by using manual dial.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Scroll to and touch the Dial Prefix button, and then touch the On button.

5. Use the keypad to enter the prefix, and then touch the OK button. You can use numbers,
pauses, and dialing symbols.

Set the dial-tone detection

Normally, the product begins dialing a fax number immediately. If you are using the product on the
same line as your telephone, turn on the detect-dial-tone setting. This prevents the product from
sending a fax while someone is on the telephone.
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The factory-set default for detect dial tone is On for France and Hungary, and Off for all other
countries/regions.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Detect Dial Tone button, and then touch the On button.

Set tone-dialing or pulse-dialing

Use this procedure to set the product to tone-dialing or pulse-dialing mode. The factory-set default is
Tone. Do not change this setting unless you know that the telephone line cannot use tone dialing.

NOTE: The pulse-dialing option is not available in all countries/regions.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Dialing Mode button, and then touch the Tone or Pulse button.

Set autoredial and the time between redials

If the product was unable to send a fax because the receiving fax machine did not answer or was
busy, the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-on-
communication-error options.

Set the redial-on-busy option

If this option is on, the product redials automatically if it receives a busy signal. The factory-set default
for the redial-on-busy option is On.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if Busy button, and then touch the On button.

Set the redial-on-no-answer option

If this option is on, the product redials automatically if the receiving machine does not answer. The
factory-set default for the redial-on-no-answer option is Off.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.
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3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if No Answer button, and then touch the On button.

Set the redial-on-communication-error option

If this option is on, the product redials automatically if some sort of communication error occurs. The
factory-set default for the redial-on-communication-error option is On.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if Comm. Error button, and then touch the On button.

Set light/dark and resolution

Set the default light/dark (contrast) setting

The contrast affects the lightness and darkness of an outgoing fax as it is being sent.

The default light/dark setting is the contrast that is normally applied to items that are being faxed. The
slider is set to the middle as the default setting.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Lighter/Darker button, and then touch one of the arrows to adjust the slider.

Set resolution settings

NOTE: Increasing the resolution increases the fax size. Larger faxes increase the send time and
could exceed the available memory in the product.

Use this procedure to change the default resolution for all fax jobs to one of the following settings:

● Standard: This setting provides the lowest quality and the fastest transmission time.

● Fine: This setting provides a higher resolution quality than Standard that is usually appropriate
for text documents.

● Superfine: This setting is best used for documents that mix text and images. The transmission
time is slower than the Fine setting but faster than the Photo setting.

● Photo: This setting produces the best images, but greatly increases the transmission time.

The factory-set default resolution setting is Fine.
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Set the default resolution setting

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Fax Resolution button, and then touch one of the options.

Cover-page templates

Several business and personal fax cover-page templates are available in the PC Fax Send software
program.

NOTE: You cannot alter cover-sheet templates, but you can edit the fields within the templates.

Set billing codes

If the billing codes feature is on, the product prompts you to enter a billing code for each fax. The
product increases the billing code count for each sent fax page. This includes all types of faxes
except for poll-received, fax-forwarded, or computer-downloaded faxes. For an undefined group or a
group-dial fax, the product increases the billing code count for each successful fax that is sent to each
destination.

The factory-set default for the billing-code setting is Off. The billing code can be any number from 1
through 250.

Set the billing-code setting

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Billing Codes button, and then touch the On button.

Use billing codes

1. Load the document in the document feeder or on the scanner glass.

2. From the Home screen, touch the Fax button.

3. Enter the fax number, or select a speed-dial or group-dial entry.

4. Touch the Start Fax button.

5. Enter the billing code, and then touch the OK button.

Print the billing-code report

The billing-code report is a printed list of all the fax billing codes and the total number of faxes billed
to each code.
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NOTE: After the product prints this report, it deletes all billing data.

1. From the Home screen, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Fax Reports button.

4. Scroll to and touch the Print Billing Report button.

Receive fax settings

Set fax forwarding

You can set your product to forward incoming faxes to another fax number. When the fax arrives at
your product, it is stored in the memory. The product then dials the fax number that you have
specified and sends the fax. If the product cannot forward a fax because of an error (for example, the
number is busy) and repeated redial attempts are unsuccessful, your product prints the fax.

If the product runs out of memory while receiving a fax, it terminates the incoming fax and only
forwards the pages and partial pages that have been stored in the memory.

When it is using the fax-forwarding feature, the product (rather than the computer) must be receiving
the faxes, and the answer mode must be set to Automatic.

1. From the Home screen, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Forward Fax button, and touch the On button.

5. Use the keypad to enter the fax-forwarding number, and then touch the OK button.

Set the answer mode

Depending on the situation, set the product answer mode to Automatic, TAM, Fax/Tel, or Manual.
The factory-set default is Automatic.

● Automatic: The product answers incoming calls after a specified number of rings or upon
recognition of special fax tones.

● TAM: The product does not automatically answer the call. Instead, it waits until it detects the fax
tone.

● Fax/Tel: The product answers incoming calls immediately. If it detects the fax tone, it processes
the call as a fax. If it does not detect the fax tone, it creates an audible ring to alert you to answer
the incoming voice call.

● Manual: The product never answers calls. You must start the fax-receiving process yourself,
either by touching the Start Fax button on the control panel or by picking up a telephone that is
connected to that line and dialing 1-2-3.
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To set or change the answer mode, complete the following steps:

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Scroll to and touch the Answer Mode button, and then touch the name of the option that you
want to use.

Block or unblock fax numbers

If you do not want to receive faxes from specific people or businesses, you can block as many as 30
fax numbers by using the control panel. When you block a fax number and someone from that
number sends you a fax, the control-panel display indicates that the number is blocked, the fax does
not print, and the fax is not saved in memory. Faxes from blocked fax numbers appear in the fax
activity log with a “discarded” designation. You can unblock blocked fax numbers individually or all at
one time.

NOTE: The sender of a blocked fax is not notified that the fax failed.

1. From the Home screen, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Block Junk Faxes button.

5. Touch the Add Number button.

6. Use the keypad to enter the fax number that you want to block, and then touch the OK button.

Set the number of rings-to-answer

When the answer mode is set to Automatic, the product rings-to-answer setting determines the
number of times the telephone rings before the product answers an incoming call.

If the product is connected to a line that receives both fax and voice calls (a shared line) and that also
uses an answering machine, you might need to adjust the rings-to-answer setting. The number of
rings-to-answer for the product must be greater than the rings-to-answer on the answering machine.
This allows the answering machine to answer the incoming call and record a message if it is a voice
call. When the answering machine answers the call, the product listens to the call and automatically
answers it if it detects fax tones.

The default setting for rings-to-answer is five for the U.S. and Canada, and two for other countries/
regions.

Use the following table to determine the number of rings-to-answer to use.
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Type of telephone line Recommended rings-to-answer setting

Dedicated fax line (receiving only fax calls) Set to a number of rings within the range shown on the
control-panel display. (The minimum and maximum number
of rings allowed varies by country/region.)

One line with two separate numbers and a ring-pattern
service

One or two rings. (If you have an answering machine or
computer voicemail for the other telephone number, make
sure that the product is set to a greater number of rings than
the answering system. Also, use the distinctive-ring feature
to differentiate between voice and fax calls.)

Shared line (receiving both fax and voice calls) with only an
attached telephone

Five rings or more.

Shared line (receiving both fax and voice calls) with an
attached answering machine or computer voicemail

Two rings more than the answering machine or computer
voicemail.

To set or change the number of rings-to-answer, use the following steps:

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Touch the Rings to Answer button.

5. Use the keypad to enter the number of rings, and then touch the OK button.

Set distinctive ring

Ring-pattern or distinctive-ring service is available through some local telephone companies. The
service allows you to have more than one telephone number on a single line. Each telephone number
has a unique ring pattern, so that you can answer voice calls and the product can answer fax calls.

If you subscribe to a ring-pattern service with a telephone company, you must set the product to
answer the correct ring pattern. Not all countries/regions support unique ring patterns. Contact the
telephone company to determine if this service is available in your country/region.

NOTE: If you do not have ring-pattern service and you change the ring-pattern settings to
something other than the default, All Rings, the product might not be able to receive faxes.

The settings are as follows:

● All Rings: The product answers any calls that come through the telephone line.

● Single: The product answers any calls that produce a single-ring pattern.

● Double: The product answers any calls that produce a double-ring pattern.

● Triple: The product answers any calls that produce a triple-ring pattern.

● Double and Triple: The product answers any calls that produce a double-ring or triple-ring
pattern.
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To change ring patterns for call answering, complete the following steps:

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Touch the Distinctive Ring button, and then touch the name of an option.

Use autoreduction for incoming faxes

If the fit-to-page option is turned on, the product automatically reduces long faxes up to 75% to fit the
information on the default paper size (for example, the fax is reduced from legal to letter size).

If the fit-to-page option is turned off, long faxes print at full size on multiple pages. The factory-set
default for incoming fax autoreduction is On.

If you have the Stamp Faxes option turned on, you might also want to turn on autoreduction. This
reduces the size of the incoming faxes slightly, and prevents the page-stamp from forcing a fax onto
two pages.

NOTE: Make sure that the default paper size setting matches the size of the paper in the tray.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Fit to Page button, and then touch the On button.

Set fax reprint settings

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Allow Fax Reprint button, and then touch the On button.

Set the fax sounds volume

Control the volume of the fax sounds from the control panel. You can make changes to the following
sounds:

● Alarm Volume

● Ring Volume

● Phone Line Volume
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Set the alarm volume, phone-line volume, and ring volume

1. From the Home screen, touch the Setup  button.

2. Touch the System Setup menu.

3. Touch the Volume Settings menu.

4. Touch the name of the volume setting that you want to adjust, and then touch one of the options.
Repeat this step for each volume setting.

Set stamp-received faxes

The product prints the sender identification information at the top of each received fax. You can also
stamp the incoming fax with your own header information to confirm the date and time that the fax
was received. The factory-set default for stamp-received faxes is Off.

NOTE: Turning on the stamp-received setting might increase the page size and cause the product
to print a second page.

NOTE: This option applies only to received faxes that the product prints.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Stamp Faxes button, and then touch the On button.

Set the private receive feature

When the private-receive feature is active, received faxes are stored in memory. A password is
required to print the stored faxes.

NOTE: When the product fax memory is full, the product cannot receive more fax jobs. If the private
receive setting is enabled, make sure that the received faxes are checked and printed or deleted on a
regular basis in order to avoid filling the fax memory.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.
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4. Scroll to and touch the Private Receive button, and then touch the On button.

5. If you have not already set a system password, the product prompts you to create one.

NOTE: The system password is case-sensitive.

a. Touch the OK button, and then use the keypad to enter the system password.

b. Touch the OK button, confirm the password by entering it a second time, and then touch
the OK button to save the password.

Set fax polling

If someone else has set up a fax to be polled, you can request that the fax be sent to your product.
(This is known as polling another machine).

1. From the Home screen, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Polling Receive button.

5. Use the keypad to enter the number of the fax machine that you want to poll, and then touch the
OK button.

The product dials the other fax machine and requests the fax.
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Use fax

Fax software

Supported fax programs

The PC fax program that came with the product is the only PC fax program that works with the
product. To continue to use a PC fax program previously installed on the computer, use the modem
that is already connected to the computer; it will not function through the product modem.

Cancel a fax

Use these instructions to cancel a single fax that is currently dialing or a fax that is being transmitted
or received.

Cancel the current fax

Press the Cancel  button on the control panel. Any pages that have not been transmitted are
canceled. Pressing the Cancel  button also stops group-dial jobs.

Cancel a pending fax job

Use this procedure to cancel a fax job in the following situations:

● The product is waiting to redial after encountering a busy signal, an unanswered call, or a
communication error.

● The fax is scheduled to be sent at a future time.

Use the following steps to cancel a fax job by using the Fax Job Status menu:

1. From the Home screen, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Send Options button.

4. Touch the Fax Job Status button.

5. Touch the fax number for the job that you want to cancel.

Use fax on a DSL, PBX, or ISDN system

HP products are designed specifically for use with traditional analog phone services. They are not
designed to work on DSL, PBX, ISDN lines, or VoIP services, but they can work with the proper
filters, setup, and equipment from a digital services provider.

NOTE: HP recommends discussing DSL, PBX, ISDN, and VoIP setup options with the service
provider.
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The HP LaserJet product is an analog device that is not compatible with all digital phone
environments (unless a digital-to-analog converter is used). HP does not guarantee that the product
will be compatible with digital environments or digital-to-analog converters.

DSL

A digital subscriber line (DSL) uses digital technology over standard copper telephone wires. This
product is not directly compatible with those digital signals. However, if the configuration is specified
during DSL setup, the signal can be separated so that some of the bandwidth is used to transmit an
analog signal (for voice and fax) while the remaining bandwidth is used to transmit digital data.

NOTE: Not all faxes are compatible with DSL services. HP does not guarantee that the product will
be compatible with all DSL service lines or providers.

A typical DSL modem employs a filter to separate the higher frequency DSL modem communication
from lower frequency analog phone and fax modem communication. It is often necessary to use a
filter with analog phones and analog fax products that are connected to a telephone line used by a
DSL modem. The DSL service provider usually provides this filter. Contact the DSL provider for more
information or for assistance.

PBX

The product is an analog device that is not compatible in all digital phone environments. Digital-to-
analog filters or converters may be needed for faxing functionality. If faxing issues occur in a PBX
environment, it might be necessary to contact the PBX provider for assistance. HP does not
guarantee that the product will be compatible with digital environments or digital-to-analog converters.

Contact the PBX provider for more information and for assistance.

ISDN

The product is an analog device that is not compatible in all digital phone environments. Digital-to-
analog filters or converters may be needed for faxing functionality. If faxing issues occur in an ISDN
environment, it might be necessary to contact the ISDN provider for assistance. HP does not
guarantee that the product will be compatible with ISDN digital environments or digital-to-analog
converters.

Use fax on a VoIP service

Voice over internet protocol (VoIP) services are often not compatible with fax machines unless the
provider explicitly states that it supports fax over IP services.

If the product experiences problems getting a fax to work on a VoIP network, verify that all cables and
settings are correct. Decreasing the fax-speed setting might allow the product to send a fax over a
VoIP network.

If the VoIP provider offers a "Pass through" mode for the connection, that will offer better fax
performance on VoIP. Also if the provider has "comfort noise" added to the line, fax performance can
be enhanced if this feature is not enabled.

If faxing problems continue, contact the VoIP provider.
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Fax memory

Fax memory contents are retained when there is a loss of power

The flash memory protects against data loss when a power failure occurs. Other fax devices store fax
pages in either normal RAM or short-term RAM. Normal RAM immediately loses data when power is
lost, while short-term RAM loses data about 60 minutes after a power failure occurs. Flash memory
can maintain its data for years without power applied.

Delete faxes from memory

Use this procedure only if you are concerned that someone else has access to your product and
might try to reprint faxes from the memory.

CAUTION: In addition to clearing the reprint memory, this procedure clears any fax that is currently
being sent, unsent faxes that are pending redial, faxes that are scheduled to be sent at a future time,
and faxes that are not printed or forwarded.

1. From the Home screen, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Clear Saved Faxes button.

Send a fax

Fax from the flatbed scanner

1. Place the document face-down on the
scanner glass.

 

2. From the Home screen, touch the Fax button.  

3. Use the keypad to type the fax number.  

4. Touch the Start Fax button.  

192 Chapter 12   Fax ENWW



5. The product prompts you to confirm that you
are sending from the scanner glass. Touch
the Yes button.

 

6. The product prompts you to load the first
page. Touch the OK button.

 

7. The product scans the first page and then
prompts you to load another page. If the
document has multiple pages, touch the Yes
button. Continue this process until you have
scanned all the pages.

 

8. When you have scanned the last page, touch
the No button at the prompt. The product
sends the fax.

 

Fax from the document feeder

1. Insert the originals into the document feeder
face-up.

NOTE: The document feeder capacity is up
to 50 sheets of 75 g/m2 or 20 lb paper.

CAUTION: To prevent damage to the
product, do not use an original that contains
correction tape, correction fluid, paper clips,
or staples. Also, do not load photographs,
small originals, or fragile originals into the
document feeder.

 

2. Adjust the paper guides until they are snug
against the paper.

 

3. From the Home screen, touch the Fax button.  
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4. Use the keypad to type the fax number.  

5. Touch the Start Fax button.  

Use speed dials and group-dial entries

1. Load the document into the document feeder or onto the scanner glass.

2. From the Home screen, touch the Fax button.

3. On the keypad, touch the fax phone book icon.

4. Touch the name of the individual or group entry that you want to use.

5. Touch the Start Fax button.
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Send a fax from the software

The following information provides basic instructions for sending faxes by using the software that
came with the product. All other software-related topics are covered in the software Help, which can
be opened from the software-program Help menu.

You can fax electronic documents from a computer if you meet the following requirements:

● The product is connected directly to the computer or to a network to which the computer is
connected.

● The product software is installed on the computer.

● The computer operating system is one that this product supports.

Send a fax from the software

The procedure to send a fax varies according to your specifications. The most typical steps follow.

1. Click Start, click Programs (or All Programs in Windows XP), and then click HP.

2. Click the product name, and then click Send fax. The fax software opens.

3. Enter the fax number of one or more recipients.

4. Load the document in the document feeder.

5. Click Send Now.

Send a fax from a third-party software program, such as Microsoft Word

1. Open a document in a third-party program.

2. Click the File menu, and then click Print.

3. Select the fax print driver from the printer driver drop-down list. The fax software opens.

4. Enter the fax number of one or more recipients.

5. Include any pages loaded at the product. This step is optional.

6. Click Send Now.
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Send a fax by dialing from a telephone connected to the fax line 

Occasionally, you might want to dial a fax number from a telephone that is connected to the same line
as the product. For example, if you are sending a fax to a person whose device is in the manual
receive mode, you can precede the fax with a voice call to let that person know that the fax is coming.

NOTE: The telephone must be connected to the product "telephone" port .

1. Load the document into the document feeder.

2. From the Home screen, touch the Fax button.

3. Pick up the handset of a telephone that is connected to the same line as the product. Dial the fax
number by using the telephone keypad.

4. When the recipient answers, instruct the person to start the fax machine.

5. When you hear the fax tones, touch the Start Fax button on the control panel, wait until
Connecting appears on the control panel display, and then hang up the telephone.

Send a fax with confirmation

You can set the product so that it prompts you to enter the fax number a second time to confirm that
you are sending the fax to the correct number.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Confirm Fax Number button, and touch the On button.

5. Send the fax.

Schedule a fax to be sent later

Use the product control panel to schedule a fax to be sent automatically at a future time to one or
more people. When this procedure is completed, the product scans the document into memory and
then returns to the Ready state.

NOTE: If the product cannot transmit the fax at the scheduled time, that information is indicated on
the fax error report (if that option is turned on) or recorded in the fax activity log. The transmittal might
not be initiated because the fax-sending call is not answered, or because a busy signal stops the
redial attempts.

If a fax has been scheduled to be sent at a future time but it requires updating, send the additional
information as another job. All faxes that are scheduled to go to the same fax number at the same
time are delivered as individual faxes.
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1. Load the document into the document feeder.  

2. From the Home screen, touch the Fax button.  

3. Touch the Fax Menu button.  

4. Touch the Send Options button.  

5. Touch the Send Fax Later button.  

6. Use the keypad to enter the time of day to
send the fax. Touch the OK button.

 

7. Use the keypad to enter the date to send the
fax. Touch the OK button.

 

8. Use the keypad to type the fax number.
Touch the OK button. The product scans the
document and saves the file in memory until
the designated time.

 

Use access codes, credit cards, or calling cards

To use access codes, credit cards, or calling cards, dial manually to allow for pauses and dialing
codes.

Send faxes internationally

To send a fax to an international destination, dial manually to allow for pauses and international
dialing codes.
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Receive a fax

Print a fax

When the product receives a fax transmission, it prints the fax (unless the private-receive feature is
enabled) and also stores it automatically to flash memory.

When a color print cartridge becomes very low, the product prints in black only to prevent fax
interruptions. To configure the product to print in color and use the remaining toner in the print
cartridge past very low, follow these steps:

1. On the product control panel, touch the Setup  button, and then touch the System Setup

button.

2. Touch the At Very Low button, and then touch the Color Cartridges button.

3. Touch the Continue button.

When you choose to replace the very low print cartridge, color printing resumes automatically.

Print a stored fax when the private receive feature is on

To print stored faxes, you must provide the product security password. After the product prints the
stored faxes, the faxes are deleted from memory.

1. From the Home screen, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Print Private Faxes button.

5. Use the keypad to enter the product security password, and then touch the OK button.

Reprint a fax

When the Allow Fax Reprint feature is on, the product stores received faxes in memory. The product
has about 3.2 MB of storage space, which holds about 250 pages.

These faxes are stored continuously. Reprinting them does not clear them from the memory.

Turn on the Allow Fax Reprint feature

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Allow Fax Reprint button, and touch the On button.
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Reprint faxes

1. From the Home screen, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Reprint Faxes button.

5. Touch the entry for the fax that you want to reprint.

Receive faxes when fax tones are audible on the phone line

If you have a telephone line that receives both fax and telephone calls, and you hear fax tones when
you answer the telephone, you can start the receiving process in one of two ways:

● If you are close to the product, press the Start Fax button on the control panel.

● If not, press 1-2-3 in sequence on the telephone keypad, listen for fax transmission sounds, and
then hang up.

NOTE: In order for the second method to work, the Extension Phone setting must be set to Yes.
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Solve fax problems

Fax troubleshooting checklist

● Several possible fixes are available. After each recommended action, retry faxing to see if the
problem is resolved.

● For best results during fax problem solving, make sure the line from the product is plugged
directly into the wall phone port. Disconnect all other devices that are connected to the product.

1. Verify that the telephone cord is plugged into the correct port on the back of the product.

2. Check the phone line by using the fax test:

a. On the control panel, open the Setup  menu, and then open the Service menu.

b. Select the Fax Service option.

c. Select the Run Fax Test option. The product prints a fax test report.

The report contains the following possible results:

● Pass: The report contains all of the current fax settings for review.

● Fail: The cord is in the wrong port. The report contains suggestions for how to resolve
the issue.

● Fail : The phone line is not active. The report contains suggestions for how to resolve
the issue.

3. Verify that the product firmware is current:

a. Print a configuration page from the control panel Reports menu to obtain the current
firmware date code.

b. Go to www.hp.com.

1. Click the Support & Drivers link.

2. Click the Download drivers and software (and firmware) link option.

3. In the For product box, type the product model number, and then click the Go button.
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4. Click the link for your operating system.

5. Scroll to the Firmware section of the table.

◦ If the listed version matches the version on the configuration page, you have the
most current version.

◦ If the versions are different, download the firmware upgrade and update the
firmware on the product following the instructions onscreen.

NOTE: The product must be connected to a computer with internet access to
upgrade firmware.

◦ Resend the fax.

4. Verify that the fax was set up when the product software was installed.

From the computer, in the HP program folder, run the Fax Setup Utility.

5. Verify that the telephone service supports analog fax.

● If using ISDN or digital PBX, contact your service provider for information about configuring
to an analog fax line.

● If using a VoIP service, change the Fax Speed setting to Slow (V.29) or disable Fast (V.34)
from the control panel. Ask if your service provider supports fax and for the recommended
fax modem speed. Some companies might require an adapter.

● If using a DSL service, ensure that a filter is included on the phone line connection to the
product. Contact the DSL service provider or purchase a DSL filter if you do not have one.
If a DSL filter is installed, try another since these filters can be defective.

6. If the error persists, find more detailed problem-solving solutions in the sections that follow this
one.
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Fax error messages 

Alert and warning messages appear temporarily and might require you to acknowledge the message
by touching the OK button to resume or by touching the Cancel  button to cancel the job. With
certain warnings, the job might not complete or the print quality might be affected. If the alert or
warning message is related to printing and the auto-continue feature is on, the product will attempt to
resume printing the job after the warning has appeared for 10 seconds without acknowledgement.

Communication error.

Description

A fax communication error occurred between the product and the sender or receiver.

Recommended action

Allow the product to retry sending the fax. Unplug the product telephone cord from the wall, plug in a
telephone, and try making a call. Plug the product phone cord into a jack for another phone line.

Try a different phone cord.

Set the Fax Speed option to the Slow (V.29) setting or disable the Fast (V.34) setting.

Turn off the Error Correction feature to prevent automatic error correction.

NOTE: Turning off the Error Correction feature can reduce image quality.

Print the Fax Activity Log report from the control panel to determine if the error occurs with a specific
fax number.

If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

Document feeder door is open. Canceled fax.

Description

The cover at the top of the document feeder is open, and the product cannot send the fax.

Recommended action

Close the cover, and send the fax again.

Fax is busy. Canceled send.

Description

The fax line to which you were sending a fax was busy. The product has canceled sending the fax.

Recommended action

Call the recipient to ensure that the fax machine is on and ready.

Check that you are dialing the correct fax number.
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Check that the Redial if Busy option is enabled.

Open the Service menu, and touch the Fax Service button. Touch the Run Fax Test button. This test
verifies that the phone cord is connected to the correct port and that the phone line has a signal. The
product prints a report with the results.

If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

Fax is busy. Redial pending.

Description

The fax line to which you were sending a fax was busy. The product automatically redials the busy
number.

Recommended action

Allow the product to retry sending the fax.

Call the recipient to ensure that the fax machine is on and ready.

Check that you are dialing the correct fax number.

Open the Service menu, and touch the Fax Service button. Touch the Run Fax Test button. This test
verifies that the phone cord is connected to the correct port and that the phone line has a signal. The
product prints a report with the results.

If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

Fax receive error.

Description

An error occurred while trying to receive a fax.

Recommended action

Ask the sender to resend the fax.

Try faxing back to the sender or another fax machine.

Check for a dial tone on the phone line by touching the Start Fax button.

Check that the telephone cord is securely connected by unplugging and replugging the cord.

Make sure that you are using the telephone cord that came with the product.

Open the Service menu, and touch the Fax Service button. Touch the Run Fax Test button. This test
verifies that the phone cord is connected to the correct port and that the phone line has a signal. The
product prints a report with the results.

Decrease the fax speed. Ask the sender to resend the fax.

Turn off error-correction mode. Ask the sender to resend the fax.
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NOTE: Turning off error-correction mode can reduce the quality of the fax image.

Connect the product to a different phone line.

If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

Fax Send error.

Description

An error occurred while trying to send a fax.

Recommended action

Try resending the fax.

Try faxing to another fax number.

Check for a dial tone on the phone line by touching the Start Fax button.

Check that the telephone cord is securely connected by unplugging and replugging the cord.

Make sure that you are using the telephone cord that came with the product.

Make sure that the phone is working by disconnecting the product, plugging in a telephone to the
phone line, and making a voice call.

Connect the product to a different phone line.

Set the fax resolution to Standard instead of the default of Fine.

If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

Fax storage is full. Canceling the fax receive.

Description

During the fax transmission, the product ran out of memory. Only the pages that fit into memory will
be printed.

Recommended action

Print all of the faxes, and then have the sender resend the fax. Have the sender divide the fax job into
multiple jobs before resending. Cancel all fax jobs or clear the faxes from memory.

Fax storage is full. Canceling the fax receive.

Description

The amount of available memory for storing faxes is insufficient to store an incoming fax.
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Recommended action

If you are using the Private Receive feature, print all received faxes to regain some memory.

If you still need more memory, clear faxes from memory. Open the Service menu. In the Fax Service
menu, select the Clear Saved Faxes option.

Fax storage is full. Canceling the fax send.

Description

During the fax job, the memory filled. All pages of the fax have to be in memory for a fax job to work
correctly. Only the pages that fit into memory were sent.

Recommended action

Cancel the current job. Turn the product off, and then turn it on again. Try sending the job again.

If the error reoccurs, cancel the job and turn the product off and then on a second time. The product
might not have enough memory for some jobs.

No dial tone.

Description

The product could not detect a dial tone.

Recommended action

Check for a dial tone on the phone line by touching the Start Fax button.

Unplug the telephone cord from both the product and the wall and replug the cord.

Make sure that you are using the telephone cord that came with the product.

Unplug the product telephone cord from the wall, plug in a telephone, and try making a voice call.

Make sure that the phone cord from the wall telephone jack is plugged into the line  port.

Plug the product phone cord into a jack for another phone line.

Check the phone line by using the Run Fax Test option from the Service menu on the control panel.

If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

No fax answer. Canceled send.

Description

Attempts to redial a fax number failed, or the Redial if No Answer option was turned off.

Recommended action

Call the recipient to ensure that the fax machine is on and ready.
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Check that you are dialing the correct fax number.

Check that the redial option is enabled.

Unplug the telephone cord from both the product and the wall and replug the cord.

Unplug the product telephone cord from the wall, plug in a telephone, and try making a voice call.

Make sure that the phone cord from the wall telephone jack is plugged into the line  port.

Plug the product phone cord into a jack for another phone line.

If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

No fax answer. Redial pending.

Description

The receiving fax line did not answer. The product attempts to redial after a few minutes.

Recommended action

Allow the product to retry sending the fax.

Call the recipient to ensure that the fax machine is on and ready.

Check that you are dialing the correct fax number.

If the product continues to redial, unplug the product telephone cord from the wall, plug in a
telephone, and try making a voice call.

Make sure that the phone cord from the wall telephone jack is plugged into the line  port.

Plug the product phone cord into a jack for another phone line.

Try a different phone cord.

If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

No fax detected.

Description

The product answered the incoming call but did not detect that a fax machine was calling.

Recommended action

Allow the product to retry receiving the fax.

Try a different phone cord.

Plug the product phone cord into a jack for another phone line.
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If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.
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Troubleshoot fax codes and trace reports

View and interpret fax error codes

Use fax error codes from the fax activity log to solve problems with the product fax features.

Code number Description

232 Possible causes include the following:

● A communication failure has occurred between the two machines.

● The user at the remote machine may have pressed the Stop button.

● The power at the remote machine has been interrupted, or deliberately turned off causing the fax
session to be interrupted.

To solve the issue, try the following steps:

1. Resend the fax at a different time when telephone line conditions have improved.

2. If the error persists, and error correction is in use for the fax session, disable the Error Correction
setting.

282 The product has not received any data at the start of a page during reception in error correction mode, but
the modem has not detected a remote disconnect. The remote machine is probably transmitting sync
frames instead of data and has either jammed or broken.

The remote machine is probably transmitting sync frames instead of data and has either jammed or
broken. Have the sender resend the fax after first requesting that the sender verify that the sending
machine is working correctly.

321 There was a communication error with the receiving fax machine due to poor telephone line conditions.

Resend the fax at a different time when telephone line conditions have improved.
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Code number Description

344-348 Possible causes include the following:

● The remote machine has failed to respond to a fax command from the local machine due to the
connection being interrupted.

● The user at the remote machine may have pressed the Stop button.

● In rare instances, incompatibility between the two machines can cause the remote machine to simply
terminate the call.

To solve the issue, try the following steps:

1. Resend the fax at a different time when telephone line conditions have improved.

2. If the error persists, and error correction is in use for the fax session, disable the Error Correction
setting.

381 Possible causes include the following:

● The remote machine has failed to respond to a fax command from the local machine due to the
connection being interrupted.

● The user at the remote machine may have pressed the Stop button.

To solve the issue, try the following steps:

1. Resend the fax at a different time when telephone line conditions have improved.

2. If the error persists, and error correction is in use for the fax session, disable the Error Correction
setting.

Fax trace report

A fax T.30 trace report has information that can help resolve fax transmission problems. If you call HP
for help in resolving these problems, print a T.30 trace report before you call.

1. From the Home screen, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Print T.30 Trace button, and then touch the Now button.

NOTE: This procedure prints a report for the last fax job, successful or not. To generate a report for
each unsuccessful fax job, select the If Error setting. To generate a report for each fax job, select the
At End of Call setting.

Fax logs and reports

Use the following instructions to print fax logs and reports:
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Print all fax reports

Use this procedure to print all of the following reports at one time:

● Last Call Report

● Fax Activity Log

● Phone Book Report

● Junk Fax List

● Billing Report (when Billing Codes are turned on)

● Configuration Report

● Usage Page

 

1. From the Home screen, touch the Fax button.  

2. Touch the Fax Menu button.  

3. Touch the Fax Reports button.  

4. Touch the Print All Fax Reports button.  

Print individual fax reports

1. From the Home screen, touch the Fax button.  

2. Touch the Fax Menu button.  

3. Touch the Fax Reports button.  

4. Touch the name of the report that you want to
print.
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Set the fax error report

A fax error report is a brief report that indicates the product experienced a fax job error. You can set it
to print after the following events:

● Every fax error (the factory-set default)

● Send fax error

● Receive fax error

● Never

NOTE: With this option, you will have no indication that a fax failed to be transmitted unless
you print a fax activity log.

1. From the Home screen, touch the Fax button.  

2. Touch the Fax Menu button.  

3. Touch the Fax Reports button.  

4. Touch the Fax Error Report button, and then
touch the printing option that you want to use.

 

Change error correction and fax speed

Set the fax-error-correction mode

Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If
the product detects an error during the transmission and the error-correction setting is On, the
product can request that the portion of the fax be resent. The factory-set default for error correction is
On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you
are willing to accept the errors in the transmission. Turning off the setting might be useful when you
are trying to send a fax overseas or receive one from overseas, or if you are using a satellite
telephone connection.

1. From the Home screen, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Error Correction button, and then touch the On button.
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Change the fax speed

The fax-speed setting is the modem protocol that the product uses to send faxes. It is the worldwide
standard for full-duplex modems that send and receive data across telephone lines at up to 33,600
bits per second (bps). The factory-set default for the fax-speed setting is Fast (V.34).

You should change the setting only if you are having trouble sending a fax to or receiving a fax from a
particular device. Decreasing the fax speed might be useful when you are trying to send a fax
overseas, or receive one from overseas, or if you are using a satellite telephone connection.

1. From the Home screen, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Fax Speed button, and then touch the speed setting that you want to use.

Solve problems sending faxes

● An error message displays on the control panel

● The control panel displays a Ready message with no attempt to send the fax

● The control panel displays the message "Storing page 1" and does not progress beyond that
message

● Faxes can be received, but not sent

● Unable to use fax functions from the control panel

● Unable to use speed dials

● Unable to use group dials

● Receive a recorded error message from the phone company when trying to send a fax

● Unable to send a fax when a phone is connected to the product

An error message displays on the control panel

The Communication error. message appears

● Allow the product to retry sending the fax. Re-sending temporarily reduces the fax speed.

● Unplug the product telephone cord from the wall, plug in a telephone, and try making a call. Plug
the product phone cord into a jack for another phone line.

If the product is connected to a digital phone line, verify that you are using the correct filter and
settings provided by the digital service provider.

● Try a different phone cord.
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● From the control panel, change the Fax Speed option to the Medium (V.17) setting or Slow (V.
29) setting.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Turn off the Error Correction option.

a. From the Home screen, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off setting.

NOTE: Turning off the Error Correction option can reduce image quality.

● If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

No dial tone.

● Make sure that the telephone cord is plugged into the correct port on the product.

● Make sure that the telephone cord from the product is plugged directly into the wall telephone
jack.

● Check for a dial tone on the phone line by using the Start Fax button.

● Unplug the product telephone cord from the wall, plug in a telephone, and try making a voice
call.

● Unplug the telephone cord from both the product and the wall and replug the cord.

● Make sure that you are using the telephone cord that came with the product.

● Plug the product phone cord into a jack for another phone line.

● Check the phone line by using the Run Fax Test option from the Service menu on the control
panel.

a. From the Home screen, touch the Setup  button.

b. Open the Service menu.
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c. Open the Fax Service menu.

d. Select the Run Fax Test item.

The Fax is busy. message appears

● Try sending the fax again.

● Call the recipient to ensure that the fax machine is on and ready.

● Check that you are dialing the correct fax number.

● Check for a dial tone on the phone line by using the Start Fax button.

● Make sure that the phone is working by disconnecting the product, plugging in a telephone to the
phone line, and making a voice call.

● Plug the product phone cord into a jack for another phone line, and try sending the fax again.

● Try a different phone cord.

● Send the fax at a later time.

● If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

The No fax answer. message appears

● Try to resend the fax.

● Call the recipient to ensure that the fax machine is on and ready.

● Check that you are dialing the correct fax number.

● Unplug the product telephone cord from the wall, plug in a telephone, and try making a voice
call.

● Plug the product phone cord into a jack for another phone line.

● Try a different phone cord.

● Make sure that the phone cord from the wall telephone jack is plugged into the line  port.

● Check the phone line by using the Run Fax Test option from the Service menu on the control
panel.

a. From the Home screen, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Run Fax Test item.

● If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.
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Document feeder paper jam

● Verify that the paper meets product size requirements. The product does not support pages
longer than 381 mm (15 in) for faxing.

● Copy or print the original to letter, A4, or legal size paper, and then resend the fax.

The Fax storage is full. message appears

● Turn the product off then on.

● Print stored faxes that have not been printed.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Receive Options menu.

c. Select the Print Private Faxes item.

d. Provide the password when the product prompts you.

● Delete stored faxes from memory.

a. From the Home screen, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Clear Saved Faxes item.

● Divide the large fax job into smaller sections, and then fax them individually.

Scanner error

● Verify that the paper meets product size requirements. The product does not support pages
longer than 381 mm (15 in) for faxing.

● Copy or print the original onto letter, A4, or legal size paper and then resend the fax.

The control panel displays a Ready message with no attempt to send the fax

● Check the fax activity log for errors.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Fax Reports menu.

c. Open the Fax Activity Log menu.

d. Select the Print Log Now option.

● If a phone is connected to the product, make sure that the phone is hung up.

● Disconnect all other lines between the fax and the product.

● Connect the product directly into the wall telephone jack and resend the fax.
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The control panel displays the message "Storing page 1" and does not progress

beyond that message

● Delete stored faxes from memory.

a. From the Home screen, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Clear Saved Faxes item.

Faxes can be received, but not sent

Send fax and nothing happens.

1. Check for a dial tone on the phone line by using the Start Fax button.

2. Turn the product off then on.

3. Use the control panel or the HP Fax Setup Wizard to configure the fax time, date, and fax
header information.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Fax Header menu.

e. Enter the correct settings.

4. Verify that any extension phones on the line are hung up.

5. If using a DSL service, make sure that the phone line connection to the product includes a high-
pass filter.

Unable to use fax functions from the control panel

● The product might be password protected. Use the HP Embedded Web Server, HP Toolbox
software, or the control panel to set a password.

● If you do not know the password for the product, contact your system administrator.

● Verify with the system administrator that the fax functionality has not been disabled.
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Unable to use speed dials

● Make sure that the fax number is valid.

● If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Dial Prefix menu.

e. Select the On setting.

Unable to use group dials

● Make sure that the fax number is valid.

● If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Dial Prefix menu.

e. Select the On setting.

● Set up all entries in the group with speed dial entries.

a. Open an unused speed dial entry.

b. Enter the fax number for the speed dial.

c. Touch the OK button to save the speed dial.

Receive a recorded error message from the phone company when trying to send a fax

● Make sure you dial the fax number correctly, and make sure that the phone service is not
blocked. For example, some phone services might prevent long distance calling.

● If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.
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d. Open the Dial Prefix menu.

e. Select the On setting.

NOTE: To send a fax without a prefix, when the Dial Prefix option is turned on, send the fax
manually.

● Send a fax to an international number

a. If a prefix is required, manually dial the telephone number with the prefix.

b. Enter the country/region code before dialing the phone number.

c. Wait for pauses as you hear the tones on the phone.

d. Send the fax manually from the control panel.

Unable to send a fax when a phone is connected to the product

● Make sure that the telephone is hung up.

● Make sure that the telephone is not being used for a voice call when faxing.

● Unplug the phone from the line, and then try sending the fax.
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Solve problems receiving faxes

● The fax does not respond

● An error message displays on the control panel

● A fax is received but does not print

● Sender receives a busy signal

● No dial tone

● Cannot send or receive a fax on a PBX line

The fax does not respond

The fax has a dedicated phone line

● Set the Answer Mode option to the Automatic setting from the control panel.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Automatic setting.

An answering machine is connected to the product

● Set the Answer Mode option to the TAM setting and plug the answering machine into the
“telephone” port.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the TAM setting.

If the TAM setting is unavailable, set the Answer Mode option to the Automatic setting.

● Set the Rings to Answer setting to at least one ring more than the number of rings for which the
answering machine is set.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.
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d. Open the Rings to Answer menu.

e. Select the correct setting.

● Plug the answering machine into the “telephone” port.

● If the product has a telephone handset connected, set the Answer Mode option to the Fax/Tel
setting to route calls to the correct device. When detecting a voice call, the product generates a
ring tone that alerts you to pick up the telephone handset.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Fax/Tel setting.

A telephone handset is connected to the product

Set the Answer Mode option to the Automatic setting.

1. From the Home screen, touch the Setup  button.

2. Open the Fax Setup menu.

3. Open the Basic Setup menu.

4. Open the Answer Mode menu.

5. Select the Automatic setting.

The Answer Mode setting is set to the Manual setting

● Touch the Start Fax button on the control panel.

Voice mail is available on the fax line

● Add a distinctive ring service to your telephone line and change the Distinctive Ring setting on
the product to match the ring pattern supplied by the telephone company. Contact your
telephone company for information.

a. Verify that the answer mode is set to the Automatic setting.

b. From the Home screen, touch the Setup  button.

c. Open the Fax Setup menu.

d. Open the Basic Setup menu.
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e. Open the Distinctive Ring menu.

f. Select the correct setting.

● Buy a dedicated line for faxing.

● Set the Answer Mode option to the Manual setting.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Manual setting.

NOTE: You must be present to receive faxes.

The product is connected to a DSL phone service

● Check the installation and features. A DSL modem requires a high-pass filter on the phone line
connection to the product. Contact your DSL service provider for a filter or buy a filter.

● Verify that the filter is plugged in.

● Replace the existing filter to make sure that it is not defective.

The product uses a fax over IP or VoIP phone service

● Set the Fax Speed option to the Slow (V.29) or Medium (V.17) setting, or disable the Fast (V.34)
setting.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Contact your service provider to make sure that fax is supported and for a recommended fax
speed settings. Some companies might require an adapter.
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An error message displays on the control panel

The No fax detected. message appears

NOTE: This error does not always refer to a missed fax. If a voice call is made to a fax number by
mistake and the caller hangs up, the No fax detected. message appears on the control panel.

● Ask the sender to resend the fax.

● Make sure that the telephone cord from the product is plugged into the wall telephone jack.

● Try a different phone cord.

● Plug the product phone cord into a jack for another phone line.

● Make sure the telephone line and phone wall jack are active by plugging in a telephone and
checking for a dial tone.

● Make sure that the telephone cord is plugged into the “line” port on the product.

● Check the phone line by running a fax test from the control panel.

● If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

The Communication error. message appears

● Ask the sender to send the fax again or send at a later time when line conditions have improved.

● Unplug the product telephone cord from the wall, plug in a telephone, and try making a call. Plug
the product phone cord into a jack for another phone line.

● Try a different phone cord.

● Set the Fax Speed option to the Slow (V.29) or Medium (V.17) setting, or disable the Fast (V.34)
setting.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Turn off the Error Correction feature to prevent automatic error correction.

NOTE: Turning off the Error Correction feature can reduce image quality.

a. From the Home screen, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.
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d. Open the Error Correction menu.

e. Select the Off setting.

● Print the Fax Activity Log report from the control panel to determine if the error occurs with a
specific fax number.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Fax Reports menu.

c. Open the Fax Activity Log menu.

d. Select the Print Log Now option.

● If the error persists, contact HP. See www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475 or the support flyer that came in the product box.

The Fax storage is full. message appears

● Turn the product off then on.

● Print all of the faxes, and then have the sender resend the fax.

● Ask the sender to divide a large fax job into smaller sections, and then fax them individually.

● Make sure that the resolution of the sending fax machine is not set to the Photo setting or the
Superfine setting.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.

● Cancel all fax jobs or clear the faxes from memory.

The Fax is busy. message appears

● The product cannot receive a fax while attempting to send one. Cancel the fax send and try
sending at a later time.

● Allow the product to try sending the fax again.
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A fax is received but does not print

The Private Receive feature is on

● When the Private Receive feature is activated, received faxes are stored in memory. A password
is required to print the stored faxes.

● Enter the password to print the fax. If you do not know the password, contact the product
administrator.

NOTE: Memory errors might occur if the faxes are not printed. The product will not answer if the
memory is full.

Sender receives a busy signal

A handset is connected to the product

● Make sure the phone is hung up.

● Change the Answer Mode option to match the product setup.

a. From the Home screen, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the setting that matches the product setup.

Set the Answer Mode option to the Fax/Tel setting to automatically receive faxes. The Fax/
Tel setting automatically detects whether the incoming transmission is a fax or a voice call
and routes the call to the appropriate device.

A phone line splitter is being used

● If you are using a phone line splitter, remove the splitter and set up the phone as a downstream
phone.

● Make sure the phone is hung up.

● Make sure the phone is not being used for a voice call when faxing.

No dial tone

● If using a phone line splitter, remove the phone line splitter and set up the phone as a
downstream phone.

Cannot send or receive a fax on a PBX line

● If you are using a PBX phone line, contact your PBX administrator to configure an analog fax
line for your product.
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Solve general fax problems 

● Faxes are sending slowly

● Fax quality is poor

● Fax cuts off or prints on two pages

Faxes are sending slowly

The product is experiencing poor phone line quality.

● Retry sending the fax when the line conditions have improved.

● Check with the phone service provider that the line supports fax.

● Turn off the Error Correction setting.

a. Open the Setup  menu.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off setting.

NOTE: This can reduce image quality.

● Use white paper for the original. Do not use colors such as gray, yellow, or pink.

● Increase the Fax Speed setting.

a. Open the Setup  menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Divide large fax jobs into smaller sections, and then fax them individually.

● Change the fax settings on the control panel to a lower resolution.

a. Open the Setup  menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.
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Fax quality is poor

Fax is blurry or light.

● Increase fax resolution when sending faxes. Resolution does not affect received faxes.

a. Open the Setup  menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.

NOTE: Increasing resolution slows transmission speed.

● Turn on the Error Correction setting from the control panel.

a. Open the Setup  menu.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the On setting.

● Check the print cartridges and replace if necessary.

● Ask the sender to darken the contrast setting on the sending fax machine, and then resend the
fax.

Fax cuts off or prints on two pages

● Set the Default Paper Size setting. Faxes print on a single size of paper based on the Default
Paper Size settings.

a. Open the Setup  menu.

b. Open the System Setup menu.

c. Open the Paper Setup menu.
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d. Open the Default Paper Size menu.

e. Select the correct setting.

● Set the paper type and size for the tray used for faxes.

● Turn on the Fit to Page setting to print longer length faxes on letter or A4 size paper.

a. Open the Setup  menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fit to Page menu.

e. Select the On setting.

NOTE: If the Fit to Page setting is off and the Default Paper Size setting is set to letter, a legal size
original prints on two pages.

Regulatory information and warranties

For regulatory and warranty information, see Additional statements for telecom (fax) products
on page 313.
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13 Manage and maintain

● Print information pages

● Use the HP Embedded Web Server

● Use HP Web Jetadmin software

● Product security features

● Economy settings

● Install memory DIMMs

● Clean the product

● Product updates
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Print information pages

Information pages reside within the product memory. These pages help diagnose and solve problems
with the product.

NOTE: If the product language was not correctly set during installation, you can set the language
manually so the information pages print in one of the supported languages. Change the language by
using the System Setup menu on the control panel or the HP Embedded Web Server.

1. From the Home screen, touch the Setup  button.

2. Touch the Reports button.

3. Touch the name of the report that you want to print.

Menu Item Description

Demo Page Prints a page that demonstrates print quality

Menu Structure Prints a control-panel menu layout map.

Configuration Report Prints a list of the product settings

Supplies Status Prints the print-cartridge status. Includes the following information:

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP print cartridges

● Number of pages printed

● Information about ordering new HP print cartridges and recycling used HP print cartridges

Network Summary Displays status for:

● Network hardware configuration

● Enabled features

● TCP/IP and SNMP information

● Network statistics

● Wireless network configuration (wireless models only)

Usage Page Displays the number of pages printed, faxed, copied, and scanned by the product

PCL Font List Prints a list of all installed PCL 5 fonts

PS Font List Prints a list of all installed PS fonts

PCL6 Font List Prints a list of all installed PCL 6 fonts

Color Usage Log Prints information about the color supply usage

Service Page Prints the service page
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Menu Item Description

Diagnostics Page Prints diagnostic information about calibration and color quality

Print Quality Page Prints a page that helps solve problems with print quality
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Use the HP Embedded Web Server

This product is equipped with an embedded Web server (EWS), which provides access to information
about product and network activities. A Web server provides an environment in which web programs
may run, much in the same way that an operating system, such as Windows, provides an
environment for programs to run on a computer. The output from these programs can then be
displayed by a Web browser, such as Microsoft Internet Explorer, Safari, or Netscape Navigator.

An “embedded” Web server resides on a hardware device (such as an HP LaserJet product) or in
firmware, rather than as software that is loaded on a network server.

The advantage of an EWS is that it provides an interface to the product that anyone with a network-
connected product and computer can use. There is no special software to install or configure, but you
must have a supported Web browser on the computer. To gain access to the EWS, type the IP
address for the product in the address line of the browser. To find the IP address, print a configuration
page.

NOTE: For Macintosh operating systems, you can use the EWS over a USB connection after
installing the Macintosh software included with the product.

Open the HP Embedded Web Server

To open the HP Embedded Web Server, type the IP address or host name of the product in the
address field of a supported Web browser. To find the IP address or host name, print a configuration
page.

You can also open the HP Embedded Web Server from the printer driver. Open the Services tab and
click the supplies icon.

NOTE: If an error occurs while opening the HP Embedded Web Server, confirm that the proxy
settings are correct for your network.

TIP: After you open the URL, bookmark it so that you can return to it quickly in the future.

HP Embedded Web Server features

The EWS allows you to view product and network status and manage printing functions from a
computer. With the EWS, you can complete the following tasks:

● View product status information

● Enable HP Web Services, including HP ePrint.

● Determine the remaining life on all supplies and order new ones

● View and change part of the product configuration

● View and print some internal pages

● Select the language in which to display the EWS pages and control panel messages
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● View and change network configuration

● Set, change, or clear the product security password.

NOTE: Changing network settings in the EWS might disable some of product software or features.

Use HP Web Jetadmin software

HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP devices, including printers, multifunction products, and digital senders. This single
solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and
imaging environment — ultimately increasing business productivity by helping you save time, control
costs, and protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product
features. Visit www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn
more about updates.

Product security features

The product includes a password feature that restricts access to setup features while allowing basic
functions to continue. The password can be set from the EWS or the control panel.

Private receive can be used to store faxes on the product until you are at the product to print them.

Assign a system password

Assign a password for the product so that unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of
a Web browser.

2. Click the Settings tab.

3. On the left side of the window, click the Security menu.

4. In the Device Security Settings area, click the Configure . . . button.

5. In the Device Password area, type the password in the New Password box, and type it again
in the Verify password box.

6. Click the Apply button. Make note of the password and store it in a safe place.
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Economy settings

Print with EconoMode

EconoMode uses less toner, which might extend the life of the print cartridge.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and
is no longer acceptable, consider replacing the print cartridge.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Powersave modes

The product includes features that can help reduce energy consumption

The sleep mode feature reduces power consumption when the product has been inactive for an
extended period. You can set the length of time before the product enters sleep mode.

NOTE: This mode does not affect product warm-up time.

The Auto Power Down feature turns the product off after a certain length of time. You can adjust this
time setting.

Set sleep delay

1. From the Home screen, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings

● Sleep Delay

3. Select the time for the sleep delay.

NOTE: The default value is 15 minutes.
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Set the Auto Power Down delay

1. From the Home screen, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings

● Auto Power Down

● Power Down Delay

3. Select the time for the power-down delay.

NOTE: The default value is 30 minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when
you press a button on the control panel. You can change which events cause the product to
wake. Open the following menus:

● System Setup

● Energy Settings

● Auto Power Down

● Wake Events

To turn off a wake event, select the event and then select the No option.

Archive print

Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print
to create documents that you want to preserve or archive.

1. From the Home screen, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Archive Print button, and then touch the On button.
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Install memory DIMMs

This product comes with 192-megabyte (MB) random-access memory installed. You can install an
additional 256-megabyte of memory for the product by adding a dual inline memory module (DIMM).
You can also install a font DIMM to allow the product to print characters (for example, Chinese
language or the Cyrillic alphabet characters).

CAUTION: Static electricity can damage electronic parts. When handling electronic parts, either
wear an antistatic wrist strap, or frequently touch the surface of the antistatic package and then touch
bare metal on the product.

Install memory DIMMs

1. Turn the product off, and then disconnect all power and interface cables.

2. On the right side of the product, open the DIMM access door.

3. Remove the DIMM access door.
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4. To replace a DIMM that is currently installed, spread the latches apart on each side of the DIMM
slot, lift the DIMM up at an angle, and pull it out.

CAUTION: Static electricity can damage electronic parts. When handling electronic parts,
either wear an antistatic wrist strap, or frequently touch the surface of the antistatic package and
then touch bare metal on the product.

5. Remove the new DIMM from the antistatic package, and then locate the alignment notch on the
bottom edge of the DIMM.

6. Holding the DIMM by the edges, align the notch on the DIMM with the bar in the DIMM slot at an
angle.
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7. Push down on the DIMM until both latches engage the DIMM. When the installation is correct,
the metal contacts are not visible.

NOTE: If you have difficulty inserting the DIMM, make sure that the notch on the bottom of the
DIMM is aligned with the bar in the slot. If the DIMM still does not go in, make sure that you are
using the correct DIMM type.

8. Reinsert the DIMM access door.

9. Close the DIMM access door.

10. Reconnect the power cable and USB or network cable, and then turn on the product.
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Enable memory

Windows XP, Windows Server 2003,
Windows Server 2008, and Windows
Vista

1. Click Start.

2. Click Settings.

3. Click Printers and Faxes (using the default Start menu view) or click
Printers (using the Classic Start menu view).

4. Right-click the product driver icon, and then select Properties.

5. Click the Device Settings tab.

6. Expand the area for Installable Options.

7. Next to Automatic Configuration, select Update Now.

8. Click OK.

NOTE: If the memory is not updated correctly after using the Update Now
option, you can manually select the total amount of memory installed in the
product in the Installable Options area.

The Update Now option overwrites any existing product configuration settings.

Windows 7 1. Click Start.

2. Click Devices and Printers.

3. Right-click the product driver icon, and then select Printer properties.

4. Click the Device Settings tab.

5. Expand the area for Installable Options.

6. Next to Automatic Configuration, select Update Now.

7. Click OK.

NOTE: If the memory is not updated correctly after using the Update Now
option, you can manually select the total amount of memory installed in the
product in the Installable Options area.

The Update Now option overwrites any existing product configuration settings.

Mac OS X 10.5 and 10.6 1. From the Apple menu , click the System Preferences menu and then click

the Print & Fax icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.
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Check DIMM installation

After installing the DIMM, make sure that the installation was successful.

1. Turn the product on. Check that the Ready light is illuminated after the product has gone through
the startup sequence. If an error message appears, a DIMM might have been incorrectly
installed.

2. Print a configuration page.

3. Check the memory section on the configuration page and compare it to the configuration page
that was printed before the memory installation. If the amount of memory has not increased, the
DIMM might not be installed correctly, or the DIMM might be defective. Repeat the installation
procedure. If necessary, install a different DIMM.

NOTE: If you installed a product language (personality), check the "Installed Personalities and
Options" section on the configuration page. This area should list the new product language.

Memory allocation

Utilities or jobs that you download to the product sometimes include resources (for example, fonts,
macros, or patterns). Resources that are internally marked as permanent remain in the product
memory until you turn the product off.

Use the following guidelines if you use the page description language (PDL) ability to mark resources
as permanent. For technical details, see an appropriate PDL reference for PCL or PS.

● Mark resources as permanent only when it is absolutely necessary that they remain in memory
while the product is turned on.

● Send permanent resources to the product only at the beginning of a print job and not while the
product is printing.

NOTE: Overusing permanent resources or downloading them while the product is printing might
affect product performance or the ability to print complex pages.
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Clean the product

Clean the paper path

During the printing process, paper, toner, and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. This product
has a cleaning mode that can correct and prevent these types of problems.

Clean the paper path from the product control panel

1. From the Home screen, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Cleaning Page button.

4. Load plain letter or A4 paper when you are prompted.

5. Touch the OK button to begin the cleaning process.

A page feeds through the product slowly. Discard the page when the process is completed.

NOTE: For models that do not have an automatic duplexer, the product prints the first side and
then prompts you to remove the page from the output bin and reload it in Tray 1, keeping the
same orientation.

Clean the scanner glass strip and platen

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner glass and white plastic backing.

1. Use the power switch to turn off the product, and then unplug the power cord from the electrical
socket.

2. Open the scanner lid.
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3. Clean the scanner glass and the white plastic backing with a soft cloth or sponge that has been
moistened with nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids
directly on the glass or platen. They might seep and damage the product.

4. Dry the glass and white plastic backing with a chamois or a cellulose sponge to prevent spotting.

5. Plug in the product, and then use the power switch to turn on the product.

Clean the document feeder pickup rollers and separation pad

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document feeder rollers and separation pad.

1. Open the document feeder cover.
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2. Use a moist, lint-free cloth to wipe both pickup rollers and the separation pad to remove dirt.

3. Close the document feeder cover.

Clean the touch screen

Clean the touch screen whenever it is necessary to remove fingerprints or dust. Wipe the touch
screen gently with a clean, water-dampened, lint-free cloth.

CAUTION: Use water only. Solvents or cleaners can damage the touch screen. Do not pour or
spray water directly onto the touch screen.
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Product updates

Software and firmware updates and installation instructions for this product are available at
www.hp.com/go/LJColorMFPM375 or www.hp.com/go/LJColorMFPM475. Click Support & Drivers,
click the operating system, and then select the download for the product.
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14 Solve problems

● Self help

● Problem-solving checklist

● Restore the factory-set defaults

● Paper feeds incorrectly or becomes jammed

● Clear jams

● Improve print quality

● The product does not print or it prints slowly

● Solve walk-up USB printing problems

● Solve product connectivity problems

● Solve wireless network problems

● Solve product software problems with Windows

● Solve product software problems with Mac
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Self help

In addition to the information in this guide, other sources are available that provide helpful
information.

HP Help and Learn Center The HP Help and Learn Center and other documentation are on the CD that came
with the product or in the HP Program folder on your computer. The HP Help and
Learn Center is a product help tool that provides easy access to product
information, HP product Web support, troubleshooting, and regulatory and safety
information.

Quick Reference Topics Several Quick Reference Topics for this product are available at this Web site:
www.hp.com/go/LJColorMFPM375 or www.hp.com/go/LJColorMFPM475

You can print these topics and keep them near the product. They are a handy
reference for procedures that you perform frequently.

Quick Reference Guide This guide contains procedures for the most commonly used product functions.
The guide is available from this Web site: www.hp.com/go/LJColorMFPM375 or
www.hp.com/go/LJColorMFPM475

You can print this guide and keep it near the product.

Control panel help The control panel has built-in help that guides you through several tasks, such as
replacing print cartridges and clearing jams.
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Problem-solving checklist

Follow these steps when trying to solve a problem with the product.

● Step 1: Check that the product power is on

● Step 2: Check the control panel for error messages

● Step 3: Test print functionality

● Step 4: Test copy functionality

● Step 5: Test the fax sending functionality

● Step 6: Test the fax receiving functionality

● Step 7: Try sending a print job from a computer

● Step 8: Test the walk-up USB printing functionality

● Factors that affect product performance

Step 1: Check that the product power is on

1. Make sure the product is plugged in and turned on.

2. Make sure the power cable is connected to the product and the outlet.

3. Check the power source by connecting the power cable to a different outlet.

4. If the product motors do not rotate, make sure the print cartridges are installed and that the
doors are all closed. The control panel displays messages to indicate these problems.

5. If the document feeder motor does not rotate, open the document feeder cover and remove any
packing material or shipping tape.

6. If the scanner bulb does not light during copying, scanning, or faxing, contact HP support.

Step 2: Check the control panel for error messages

The control panel should indicate ready status. If an error message appears, resolve the error.

Step 3: Test print functionality

1. From the control panel Home screen, touch the Setup  button.

2. Open the Reports menu, and select the Configuration Report item to print the report.

3. If the report does not print, make sure paper is loaded in the tray, and check the control panel to
see if paper is jammed inside the product.

NOTE: Make sure the paper in the tray meets specifications for this product.
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Step 4: Test copy functionality

1. Place the configuration page into the document feeder and make a copy. If paper does not feed
smoothly through the document feeder, you might need to clean the document feeder rollers and
separation pad. Make sure the paper meets specifications for this product.

2. Place the configuration page onto the scanner glass and make a copy.

3. If the print quality on the copied pages is not acceptable, clean the scanner glass and the small
glass strip.

Step 5: Test the fax sending functionality

1. From the control panel Home screen, touch the Setup  button.

2. Open the Service menu, and then open the Fax Service menu. Touch the Run Fax Test button
to test the fax functionality.

3. Touch the Fax button on the product control panel, and then touch the Start Fax button.

Step 6: Test the fax receiving functionality

1. From the control panel Home screen, touch the Setup  button.

2. Open the Service menu, and then open the Fax Service menu. Touch the Run Fax Test button
to test the fax functionality.

3. Use another fax machine to send a fax to the product.

4. If the product does not receive the fax, make sure that you do not have too many telephone
devices connected to the product, and that all telephone devices are connected in the correct
order.

5. Review and reset the product fax settings.

6. Turn off the Private Receive feature.

Step 7: Try sending a print job from a computer

1. Use a word-processing program to send a print job to the product.

2. If the job does not print, make sure you selected the correct printer driver.

3. Uninstall and then reinstall the product software.

Step 8: Test the walk-up USB printing functionality

1. Load a .PDF document or .JPEG photo onto a USB flash drive, and insert it in the slot on the
front of the product.

2. The USB Flash Drive menu opens. Try printing the document or photo.

3. If no documents are listed, try a different type of USB flash drive.
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Factors that affect product performance

Several factors affect the time it takes to print a job:

● The software program that you are using and its settings

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB or network connection

● Whether the product is printing in color or in monochrome

● The type of USB flash drive, if you are using one

Restore the factory-set defaults 

CAUTION: Restoring the factory-set defaults returns all of the product and network settings to the
factory defaults, and it also clears the fax header name, phone number, and any stored faxes in the
product memory. This procedure also clears the fax phone book, and deletes any pages that are
stored in the memory. The procedure then automatically restarts the product.

1. On the product control panel, touch the Setup  button.

2. Scroll to and touch the Service menu.

3. Scroll to and touch the Restore Defaults button, and then touch the OK button.

The product automatically restarts.
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Paper feeds incorrectly or becomes jammed

● The product does not pick up paper

● The product picks up multiple sheets of paper

● Prevent paper jams

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the
guides with the paper-size markings in the bottom of the tray.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the
guides with the paper-size markings in the bottom of the tray.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.
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5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.
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Clear jams

Jam locations

Jams can occur in these locations:

1 Document feeder

2 Rear door

3 Output bin

4 Tray 1

5 Tray 2

6 Tray 2 jam-access area

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few
sheets have been printed.
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Clear jams from the document feeder

1. Turn the product off.  

2. Open the document feeder cover.  

3. Lift the document feeder roller assembly, and
gently pull the jammed paper out.
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4. Close the document feeder roller assembly.  

5. Close the document feeder cover.  

6. Open the scanner lid. If paper is jammed
behind the white plastic backing, gently pull it
out.
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Clear jams in Tray 1

1. Pull the jammed sheet from Tray 1.

NOTE: If the sheet tears, make sure that all
of the fragments are removed before you
resume printing.

 

2. Pull out Tray 2 and place it on a flat surface.  

3. Lower the jam-access tray.  
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4. Remove the jammed sheet by pulling it
straight out.

 

5. Push the jam-access tray up to close it, and
then replace Tray 2.

NOTE: To close the tray, push in the middle
or with even pressure on both sides. Avoid
pushing on one side only.
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Clear jams in Tray 2

1. Open Tray 2.  

2. Remove the jammed sheet by pulling it
straight out.

 

3. Close Tray 2.

NOTE: To close the tray, push in the middle
or with even pressure on both sides. Avoid
pushing on one side only.
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Clear jams in the fuser area

1. Open the rear door.

CAUTION: The fuser, located in the back of
the product, is hot. Wait for the fuser to cool
before continuing.

 

2. If necessary, push the guide (callout 1) and
remove any visible paper (callout 2) from the
bottom of the delivery area.

NOTE: If the sheet tears, make sure that all
fragments are removed before you resume
printing. Do not use sharp objects to remove
fragments.

 

3. Close the rear door.  
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Clear jams in the output bin

1. Look for jammed paper in the output bin area.  

2. Remove any visible media.

NOTE: If the sheet tears, make sure that all
fragments are removed before resuming
printing.

 

3. Open and then close the rear door to clear
the message.
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Clear jams in the duplexer (duplexing models only)

1. Open the rear door.

CAUTION: The fuser, located in the back of
the product, is hot. Wait for the fuser to cool
before continuing.

 

2. If necessary, pull the guide (callout 1) and
remove any visible paper (callout 2) from the
bottom of the delivery area.

 

3. If necessary, remove any visible paper from
bottom side of the duplexing unit.
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4. If you can not see any jammed paper, lift the
duplexing unit using the tab on the side of the
duplexing unit.

 

5. If you can see the trailing edge of the paper,
remove the paper from the product.

 

6. If you can see the leading edge of the paper,
remove it from the product.

 

7. Close the rear door.  
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Improve print quality

You can prevent most print-quality problems by following these guidelines.

● Use the correct paper type setting in the printer driver

● Adjust color settings in the printer driver

● Use paper that meets HP specifications

● Print a cleaning page

● Calibrate the product to align the colors

● Check the print cartridges

● Use the printer driver that best meets your printing needs

● Improve print quality for copies

Use the correct paper type setting in the printer driver

Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

Change the paper type setting for Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand each category of paper types until you find the paper type that you are using.

7. Select the option for the type of paper you are using, and click the OK button.

Change the paper type setting for Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.
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3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Adjust color settings in the printer driver

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for
correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a
digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None
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Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and white. Use this option
to print color documents for photocopying or faxing.

6. Click the OK button.
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Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for
use in Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of
the following problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. From the Home screen, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Cleaning Page button.

4. Load plain letter or A4 paper when you are prompted.

5. Touch the OK button to begin the cleaning process.

A page feeds through the product slowly. Discard the page when the process is completed.

NOTE: For models that do not have an automatic duplexer, the product prints the first side and
then prompts you to remove the page from the output bin and reload it in Tray 1, keeping the
same orientation.
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Calibrate the product to align the colors

If the printed output has colored shadows, blurry graphics, or areas that have poor color, you might
need to calibrate the product to align the colors. Print the Diagnostics Page from the Reports menu
on the control panel to check the color alignment. If the blocks of color on that page are not aligned
with each other, you need to calibrate the product.

1. On the product control panel, open the System Setup menu.

2. Open the Print Quality menu, and select the Color Calibration item.

3. Select the Calibrate Now option.

Check the print cartridges

Check each print cartridge, and replace it if necessary, if you are having any of the following
problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

NOTE: If you are using a draft print setting, the printing might appear light.

If you determine that you need to replace a print cartridge, print the Supplies Status Page to find the
part number for the correct genuine HP print cartridge.

Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge.

Genuine HP print cartridge 1. The product control panel or the Supplies Status page indicates Very Low
status when the cartridge has reached the end of its estimated life. Replace
the print cartridge if print quality is no longer acceptable.

2. Print a Print Quality Page from the Reports menu. If streaks or marks are in
one color on the page, you might have a defect in that color cartridge. See
the instructions in this document for interpreting the page. Replace the print
cartridge if necessary.

3. Visually inspect the print cartridge for damage. See the instructions that
follow. Replace the print cartridge if necessary.

4. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repetitive defects ruler in this document to identify the cause of the problem.
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Print the Supplies Status page

The Supplies Status page indicates the estimated life remaining in print cartridges. It also lists the
part number for the correct genuine HP print cartridge for your product so you can order a
replacement print cartridge, as well as other useful information.

1. At the control panel, press the OK button to open the menus.

2. Open the following menus:

● Reports

● Supplies Status
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Interpret the Print Quality Page

1. On the product control panel, open the Reports menu.

2. Select the Print Quality Page item to print it.

This page contains five bands of color, which are divided into four groups as indicated in the following
illustration. By examining each group, you can isolate the problem to a particular print cartridge.

Section Print-cartridge

1 Yellow

2 Cyan

3 Black

4 Magenta

● If dots or streaks appear in only one of the groups, replace the print cartridge that correlates with
that group.

● If dots appear in more than one group, print a cleaning page. If this does not solve the problem,
determine if the dots are always the same color; for example, if magenta dots appear in all five
color bands. If the dots are all the same color, replace that print cartridge.

● If streaks appear in multiple color bands, contact HP. A component other than the print cartridge
is probably causing the problem.

Inspect the print cartridge for damage

1. Remove the print cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.
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3. Examine the surface of the green imaging drum on the bottom of the print cartridge.

CAUTION: Do not touch the green roller (imaging drum) on the bottom of the cartridge.
Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the print
cartridge.

5. If the imaging drum does not appear to be damaged, rock the print cartridge gently several times
and reinstall it. Print a few pages to see if the problem has resolved.

Repeating defects

If defects repeat at any of the following intervals on the page, a print cartridge might be damaged.

● 22 mm

● 27 mm

● 28 mm

● 75 mm

Use the printer driver that best meets your printing needs

You might need to use a different printer driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.
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HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless
you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for
postscript flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● May not be fully compatible with third-party and custom solutions based on
PCL5

Download additional printer drivers from this Web site: www.hp.com/go/LJColorMFPM375_software
or www.hp.com/go/LJColorMFPM475_software.
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Improve print quality for copies

If you encounter print quality problems in copied documents, review the solutions for printed
documents listed previously in this document. However, some print-quality problems occur only in
copied documents.

● If streaks appear on copies made by using the document feeder, clean the small glass strip on
the left side of the scanner assembly.

● If dots or other defects appear on copies made by using the scanner glass, clean the scanner
glass and the white plastic backing.

1. Use the power switch to turn off the product, and then unplug the power cord from the electrical
socket.

2. Open the scanner lid.

3. Clean the scanner glass and the white plastic backing with a soft cloth or sponge that has been
moistened with nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids
directly on the glass or platen. They might seep and damage the product.

4. Dry the glass and white plastic backing with a chamois or a cellulose sponge to prevent spotting.

5. Plug in the product, and then use the power switch to turn on the product.
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn the product off and then on
again.

◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the
network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can
cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties,
and open the Ports tab.

◦ If you are using a network cable to connect to the network, make sure the printer name
listed on the Ports tab matches the product name on the product configuration page.

◦ If you are using a USB cable and are connecting to a wireless network, make sure the box
is checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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Solve walk-up USB printing problems

● The USB Flash Drive menu does not open when you insert the USB accessory

● The file does not print from the USB storage accessory

● The file that you want to print is not listed in the USB Flash Drive menu

The USB Flash Drive menu does not open when you insert the USB
accessory

1. You might be using a USB storage accessory or a file system that this product does not support.
Save the files on a standard USB storage accessory that uses File Allocation Table (FAT) file
systems. The product supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB storage accessory.

3. The USB storage accessory might have multiple partitions. (Some USB storage accessory
manufacturers install software on the accessory that creates partitions, similar to a CD.)
Reformat the USB storage accessory to remove the partitions, or use a different USB storage
accessory.

4. The USB storage accessory might require more power than the product can provide.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Use a USB storage accessory that has its own power supply or that requires less power.

5. The USB storage accessory might not be functioning correctly.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Try printing from another USB storage accessory.

The file does not print from the USB storage accessory

1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
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The file that you want to print is not listed in the USB Flash Drive menu

1. You might be trying to print a file type that the USB printing feature does not support. The
product supports .PDF and .JPEG file types.

2. You might have too many files in a single folder on the USB storage accessory. Reduce the
number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this
case, the product replaces the file names with characters from a different character set. Rename
the files using ASCII characters.

Solve product connectivity problems 

Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.

Solve network problems

Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP
address that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.
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3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you
change these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer
driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.
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The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if
necessary.

2. Reconfigure the network settings if necessary.
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Solve wireless network problems

● Wireless connectivity checklist

● The control panel displays the message: The wireless feature on this product has been turned
off

● The product does not print after the wireless configuration completes

● The product does not print, and the computer has a third-party firewall installed

● The wireless connection does not work after moving the wireless router or product

● Cannot connect more computers to the wireless product

● The wireless product loses communication when connected to a VPN

● The network does not appear in the wireless networks list

● The wireless network is not functioning

Wireless connectivity checklist

● The product and the wireless router are turned on and have power. Also make sure the wireless
radio in the product is turned on.

● The service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If
you are not sure the SSID is correct, run the wireless setup again.

● With secured networks, make sure the security information is correct. If the security information
is incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless
network. If the network has Internet access, try connecting to the Internet over a wireless
connection.

● The encryption method (AES or TKIP) is the same for the product as it is for the wireless access
point (on networks using WPA security).

● The product is within the range of the wireless network. For most networks, the product must be
within 30 m (100 ft) of the wireless access point (wireless router).

● Obstacles do not block the wireless signal. Remove any large metal objects between the access
point and the product. Make sure poles, walls, or support columns containing metal or concrete
do not separate the product and wireless access point.

● The product is located away from electronic devices that might interfere with the wireless signal.
Many devices can interfere with the wireless signal including motors, cordless phones, security
system cameras, other wireless networks, and some Bluetooth devices.

● The printer driver is installed on the computer.

● You have selected the correct printer port.

● The computer and product connect to the same wireless network.
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The control panel displays the message: The wireless feature on this
product has been turned off

1. Touch the Wireless Menu button.

2. Touch the Turn Wireless On/Off button, and then touch the On button.

The product does not print after the wireless configuration completes

1. Make sure the product is turned on and in the ready state.

2. Make sure you are connecting to the correct wireless network.

3. Make sure that the wireless network is working correctly.

a. Open the Network Setup menu, and then open the Wireless Menu item.

b. Select the Run Network Test item to test the wireless network. The product prints a report
with the results.

4. Make sure that the correct port or product is selected.

a. From the list of printers on your computer, right-click the name of this product, click
Properties, and then open the Ports tab.

b. Make sure the box is checked next to Virtual printer port for USB.

5. Make sure that your computer is working correctly. If necessary, restart your computer.

The product does not print, and the computer has a third-party firewall
installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you
allow the programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable
the firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or
product

Make sure that the router or product connects to the same network that your computer connects to.

1. Open the Reports menu, and select the Configuration Report item to print the report.

2. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer
configuration for your computer.

3. If the SSIDs are not the same, the devices are not connecting to the same network. Reconfigure
the wireless setup for your product.
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Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block
the signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access
point.

2. Make sure the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

a. On the product control panel, open the Network Setup menu, and then open the Wireless
Menu item.

b. Select the Run Network Test item to test the wireless network. The product prints a report
with the results.

5. Make sure that the correct port or product is selected.

a. From the list of printers on your computer, right-click the name of this product, click
Properties, and then open the Ports tab.

b. Click the Configure Port button to verify that the IP address matches the IP address listed
on the Run Network Test report.

6. Make sure that your computer is working correctly. If necessary, restart your computer.

The wireless product loses communication when connected to a VPN

● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.
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The wireless network is not functioning

1. To verify if the network has lost communication, try connecting other devices to the network.

2. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the service set identifier (SSID) for your network.

c. If the window displays round-trip times, the network is working.

3. Make sure that the router or product connects to the same network that your computer connects
to.

a. Open the Reports menu, and select the Configuration Report item to print the report.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the
printer configuration for your computer.

c. If the SSIDs are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for your product.
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Solve product software problems with Windows

Problem Solution

A printer driver for the product is
not visible in the Printer folder

Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

 Try plugging the USB cable into a different USB port on the computer.

An error message was
displayed during the software
installation

Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the task
bar, right-click the icon, and select Close or Disable.

 Check the amount of free space on the drive where you are installing the product software. If
necessary, free up as much space as you can, and reinstall the product software.

 If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode,
but nothing prints

Print a Configuration page, and verify the product functionality.

 Verify that all of the cables are correctly seated and within specifications. This includes the USB and
power cables. Try a new cable.

 Verify the IP Address on the Configuration Page matches the IP address for the software port. Use
one of the following procedures:

 Windows XP, Windows Server
2003, Windows Server 2008,
and Windows Vista

1. Click Start.

2. Click Settings.

3. Click Printers and Faxes (using the default Start menu view)
or click Printers (using the Classic Start menu view).

4. Right-click the product driver icon, and then select Properties.

5. Click the Ports tab, and then click Configure Port.

6. Verify the IP address, and then click OK or Cancel.

7. If the IP Addresses are not the same, delete the driver, and
reinstall the driver using the correct IP address.

 Windows 7 1. Click Start.

2. Click Devices and Printers.

3. Right-click the product driver icon, and then select Printer
properties.

4. Click the Ports tab, and then click Configure Port.

5. Verify the IP address, and then click OK or Cancel.

6. If the IP Addresses are not the same, delete the driver, and
reinstall the driver using the correct IP address.
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Solve product software problems with Mac

● The printer driver is not listed in the Print & Fax list

● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax list after the
driver is selected.

● You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print & Fax
list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax list.

3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected product in
the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Replace the USB or network cable with a high-quality cable.
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A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax list.

When connected with a USB cable, the product does not appear in the
Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate high-speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain.
Disconnect all of the devices from the chain, and connect the cable directly to the USB port on
the computer

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic
printer driver instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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A Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Part numbers

Item Part number Cartridge number Description

Print
cartridges

CE410A 305A Standard-capacity black print cartridge with HP
ColorSphere toner

CE410X 305X High-capacity black print cartridge with HP ColorSphere
toner

CE411A 305A Cyan print cartridge with HP ColorSphere toner

CE412A 305A Yellow print cartridge with HP ColorSphere toner

CE413A 305A Magenta print cartridge with HP ColorSphere toner

Memory CB423A  256 MB memory DIMM

Paper-
handling
accessories

CF106A  250-sheet paper feeder (optional Tray 3)

USB cable 8121-0868  2-meter A-to-B cable

NOTE: For information about the yield for the cartridges, see www.hp.com/go/pageyield. Actual
yield depends on specific use.
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B Service and support

● Hewlett-Packard limited warranty statement

● HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement

● Data stored on the print cartridge

● End User License Agreement

● OpenSSL

● Customer support
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Hewlett-Packard limited warranty statement

HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet Pro 300 color MFP M375nw and HP LaserJet
Pro 400 color MFP M475dn, and M475dw

One year from date of purchase

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from
defects in materials and workmanship after the date of purchase, for the period specified above. If HP
receives notice of such defects during the warranty period, HP will, at its option, either repair or
replace products which prove to be defective. Replacement products may be either new or equivalent
in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when
properly installed and used. If HP receives notice of such defects during the warranty period, HP will
replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is
unable, within a reasonable time, to repair or replace any product to a condition as warranted, you will
be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or
calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized
modification or misuse, (d) operation outside of the published environmental specifications for the
product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for
this product and where HP has marketed this product. The level of warranty service you receive may
vary according to local standards. HP will not alter form, fit or function of the product to make it
operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the
above limitation or exclusion may not apply to you.
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THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION
TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT
TO YOU.
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HP's Premium Protection Warranty: LaserJet print
cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit
wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description
of the problem and print samples) or contact HP customer support. At HP's option, HP will either
replace products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION
TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT
TO YOU.
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Data stored on the print cartridge

The HP print cartridges used with this product contain a memory chip that assists in the operation of
the product.

In addition, this memory chip collects a limited set of information about the usage of the product,
which might include the following: the date when the print cartridge was first installed, the date when
the print cartridge was last used, the number of pages printed using the print cartridge, the page
coverage, the printing modes used, any printing errors that might have occurred, and the product
model. This information helps HP design future products to meet our customers' printing needs.

The data collected from the print cartridge memory chip does not contain information that can be
used to identify a customer or user of the print cartridge or their product. However, a customer can
choose not to store usage data on the memory chip through the control panel.

HP collects a sampling of the memory chips from print cartridges returned to HP's free return and
recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling
are read and studied in order to improve future HP products. HP partners who assist in recycling this
print cartridge might have access to this data, as well.

Any third party possessing the print cartridge might have access to the anonymous information on the
memory chip.
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End User License Agreement

PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User
License Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you
represent) and (b) Hewlett-Packard Company (“HP”) that governs your use of the software product
(“Software”). This EULA does not apply if there is a separate license agreement between you and HP
or its suppliers for the Software, including a license agreement in online documentation. The term
“Software” may include (i) associated media, (ii) a user guide and other printed materials, and (iii)
“online” or electronic documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING,
OR OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU
DO NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA,
PLEASE RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN
DAYS FOR A REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR
MADE AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third
Party License”). Any Third Party Software is licensed to you subject to the terms and conditions
of the corresponding Third Party License. Generally, the Third Party License is in a file such as
“license.txt” or a “readme” file. You should contact HP support if you cannot find a Third Party
License. If the Third Party Licenses include licenses that provide for the availability of source
code (such as the GNU General Public License) and the corresponding source code is not
included with the Software, then check the product support pages of HP's website (hp.com) to
learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing,
copying, storing, loading, executing, displaying, or otherwise using the HP Software. You
may not modify the HP Software or disable any licensing or control feature of the
HP Software. If this Software is provided by HP for Use with an imaging or printing product
(for example, if the Software is a printer driver, firmware, or add-on), the HP Software may
only be used with such product (“HP Product”). Additional restrictions on Use may appear
in the User Documentation. You may not separate component parts of the HP Software for
Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the
HP Software, provided each copy contains all the original HP Software’s proprietary notices
and is used only for back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement
(collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP
as eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you
may no longer use such HP Software. This EULA applies to each Upgrade unless HP provides
other terms with the Upgrade. In case of a conflict between this EULA and such other terms, the
other terms will prevail.
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4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer
of the HP Software to another end user. Any transfer will include all component parts,
media, User Documentation, this EULA, and if applicable, the Certificate of Authenticity.
The transfer may not be an indirect transfer, such as a consignment. Prior to the transfer,
the end user receiving the transferred Software will agree to this EULA. Upon transfer of
the HP Software, your license is automatically terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
commercial timesharing or bureau use. You may not sublicense, assign or otherwise
transfer the HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User
Documentation are owned by HP or its suppliers and are protected by law, including applicable
copyright, trade secret, patent, and trademark laws. You will not remove any product
identification, copyright notice, or proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed
under applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information
you provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of
support services related to the Software or the HP Product. All such information will be subject to
HP’s privacy policy. HP will not use such information in a form that personally identifies you
except to the extent necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire
liability of HP and its suppliers under this EULA and your exclusive remedy under this EULA will
be limited to the greater of the amount actually paid by you for the Product or U.S. $5.00. TO
THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS
SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR
CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA,
BUSINESS INTERRUPTION, PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN
ANY WAY TO THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY
SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF
THE ABOVE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states or other
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Software was developed entirely at private expense. All
Software is commercial computer software within the meaning of the applicable acquisition
regulations. Accordingly, pursuant to US FAR 48 CFR 12.212 and DFAR 48 CFR 227.7202, use,
duplication and disclosure of the Software by or for the U.S. Government or a U.S. Government
subcontractor is subject solely to the terms and conditions set forth in this End User License
Agreement, except for provisions which are contrary to applicable mandatory federal laws.
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10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software,
including any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to
you in this EULA.

© 2009 Hewlett-Packard Development Company, L.P.

Rev. 04/09
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OpenSSL

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).
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Customer support

Get telephone support for your country/region

Have the product name, serial number, date of purchase,
and problem description ready.

Country/region phone numbers are on the flyer that was in
the box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/go/LJColorMFPM375 or www.hp.com/go/
LJColorMFPM475

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic
information

www.hp.com/go/LJColorMFPM375_software or
www.hp.com/go/LJColorMFPM475_software

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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C Product specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Environmental specifications
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Physical specifications

Table C-1  Physical specifications

Product Height Depth Width Weight

HP LaserJet Pro 300
color MFP M375nw

500 mm (19.7 inches) 483 mm (19.0 inches) 420 mm (16.5 inches) 28.2 kg (62.2 lb)

HP LaserJet Pro 400
color MFP M475dn

500 mm (19.7 inches) 483 mm (19.0 inches) 420 mm (16.5 inches) 29.5 kg (65.0 lb)

HP LaserJet Pro 400
color MFP M475dw

500 mm (19.7 inches) 483 mm (19.0 inches) 420 mm (16.5 inches) 29.5 kg (65.0 lb)

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/go/LJColorMFPM375_regulatory or www.hp.com/go/LJColorMFPM475_regulatory
for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Environmental specifications

Table C-2  Environmental specifications1

Recommended Operating Storage

Temperature 15° to 32.5° C

(59° to 90.5° F)

15° to 32.5° C

(59° to 90.5° F)

–20° to 40° C

(–4° to 104° F)

Relative humidity 20 to 70% 10 to 80% 95% or less

Altitude  0 to 3048 m (0 to 10,000 ft)  

1 Values are subject to change.
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D Regulatory information

● FCC regulations

● Environmental product stewardship program

● Declaration of conformity

● Declaration of conformity (wireless models)

● Safety statements

● Additional statements for telecom (fax) products

● Additional statements for wireless products
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FCC regulations

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy. If this equipment is not installed and used in accordance with the
instructions, it may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could
void the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.

Environmental product stewardship program

Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our
environment.

Ozone production

This product generates no appreciable ozone gas (O3).

Power consumption

Power usage drops significantly while in Ready or Sleep mode, which saves natural resources and
saves money without affecting the high performance of this product. Hewlett-Packard printing and
imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental
Protection Agency's ENERGY STAR specifications for imaging equipment. The following mark will
appear on ENERGY STAR qualified imaging products:
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Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Toner consumption

EconoMode uses less toner, which might extend the life of the print cartridge. HP does not
recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might
outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is no longer
acceptable, consider replacing the print cartridge.

Paper use

This product’s manual/automatic duplex feature (two-sided printing) and N-up printing (multiple pages
printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies

It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with
HP Planet Partners. Multilingual program information and instructions are included in every new
HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are
recycled properly, processing them to recover plastics and metals for new products and diverting
millions of tons of waste from landfills. Since this cartridge is being recycled and used in new
materials, it will not be returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use
this label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.
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Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or
more HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For US and Puerto Rico HP LaserJet print cartridge recycling returns, use the pre-paid, pre-
addressed shipping label contained in the box. To use the UPS label, give the package to the UPS
driver during your next delivery or pick-up, or take it to an authorized UPS drop-off center.
(Requested UPS Ground pickup will be charged normal pick-up rates) For the location of your local
UPS drop-off center, call 1-800-PICKUPS or visit www.ups.com.

If you are returning the package with the FedEx label, give the package to either the U.S. Postal
Service carrier or FedEx driver during your next pick-up or delivery. (Requested FedEx Ground
pickup will be charged normal pick-up rates). Or, you can drop off your packaged print cartridge(s) at
any U.S. Post Office or any FedEx shipping center or store. For the location of your nearest U.S. Post
Office, please call 1-800-ASK-USPS or visit www.usps.com. For the location of your nearest FedEx
shipping center/store, please call 1-800-GOFEDEX or visit www.fedex.com.

For more information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle
or call 1-800-340-2445. Information subject to change without notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal
Service provides no-cost cartridge return transportation services under an arrangement with HP for
Alaska and Hawaii.
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Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit
www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper

This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions

This HP product does not contain added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:

HP LaserJet Pro 300 color MFP M375 and HP LaserJet Pro 400 color MFP M475

Type Carbon monofluoride lithium

Weight 0.8 g

Location On formatter board

User-removable No

For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.
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Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of
with your other household waste. Instead, it is your responsibility to dispose of your waste equipment
by handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human
health and the environment. For more information about where you can drop off your waste
equipment for recycling, please contact your local city office, your household waste disposal service
or the shop where you purchased the product.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example,
toner) can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/
hpinfo/community/environment/productinfo/safety.
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For more information

To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of conformity

Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-1002-03-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Pro 400 color MFP M475dn

Regulatory Model Number2) BOISB-1002-03

BOISB-0903-00 – (US-Fax Module LIU)

BOISB-0903-01 – (EURO-Fax Module LIU)

Product Options: ALL

Print Cartridges: CE410A, CE410X, CE411A, CE412A, CE413A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006+A11

IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)

IEC 62311:2007 / EN62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1 / EN55022:2006 +A1 - Class B1)

EN 61000-3-2:2006

EN 61000-3-3:2008

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class B1) / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

TELECOM: ES 203 021; FCC Title 47 CFR, Part 683)

ENERGY USE: Regulation (EC) No. 1275/2008

ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test
Procedure

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, the

R&TTE Directive 1999/5/EC (Annex II), the EuP Directive 2005/32/EC and carries the CE-Marking  accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired
operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3. Telecom approvals and standards appropriate for the target countries/regions have been applied to this product, in addition to those
listed above.

4. This product uses an analog fax accessory module which Regulatory Model numbers are: BOISB-0903-00 (US-LIU) or
BOISB-0903-01 (EURO LIU), as needed to meet technical regulatory requirements for the countries/regions this product will be sold.

Boise, Idaho USA

October 2011

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Straße 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
www.hp.eu/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Declaration of conformity (wireless models)

Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-1002-02&-04 Rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Pro 300 color MFP M375nw

HP LaserJet Pro 400 color MFP M475dw

Regulatory Model Number2) BOISB-1002-02, BOISB-1002-04

BOISB-0903-00 – (US-Fax Module LIU)

BOISB-0903-01 – (EURO-Fax Module LIU)

SDGOB – 0892 – (Radio Module)

Product Options: ALL

Print Cartridges: CE410A, CE410X, CE411A, CE412A, CE413A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006+A11

IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)

IEC 62311:2007 / EN 62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1 / EN55022:2006 +A1 - Class B1)

EN 61000-3-2:2006

EN 61000-3-3:2008

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class B1) / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

TELECOM: ES 203 021; FCC Title 47 CFR, Part 683)

Radio5) EN 301 489-1:V1.8.1 (2008-04) / EN 301 489-17:V2.1.1 (2009-05)

EN 300 328: V1.7.1 (2006-10)

FCC Title 47 CFR, Part 15 Subpart C (Section 15.247) / IC: RSS-210

ENERGY USE: Regulation (EC) No. 1275/2008

ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test
Procedure
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Supplementary Information:

The product herewith complies with the requirements of the R&TTE; Directive 1999/5/EC Annex II and Annex IV, EMC Directive

2004/108/EC, the Low Voltage Directive 2006/95/EC, the EuP Directive 2005/32/EC and carries the CE-Marking  accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired
operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3. Telecom approvals and standards appropriate for the target countries/regions have been applied to this product, in addition to those
listed above.

4. This product uses an analog fax accessory module which Regulatory Model numbers are: BOISB-0903-00 (US-LIU) or
BOISB-0903-01 (EURO LIU), as needed to meet technical regulatory requirements for the countries/regions this product will be sold.

5. This product uses a radio module device which Regulatory Model number is SDGOB-0892 as needed to meet technical regulatory
requirements for the countries/regions this product will be sold.

Boise, Idaho USA

October 2011

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Straße 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
www.hp.eu/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration
has implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser
product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance
Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation
emitted inside the device is completely confined within protective housings and external covers, the
laser beam cannot escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those
specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations

Complies with Canadian EMC Class B requirements.

« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)
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EMC statement (Korea)

Laser statement for Finland

Luokan 1 laserlaite

Klass 1 Laser Apparat

HP LaserJet Pro 300 color MFP M375nw, HP LaserJet Pro 400 color MFP M475dn, M475dw,
laserkirjoitin on käyttäjän kannalta turvallinen luokan 1 laserlaite. Normaalissa käytössä kirjoittimen
suojakotelointi estää lasersäteen pääsyn laitteen ulkopuolelle. Laitteen turvallisuusluokka on
määritetty standardin EN 60825-1 (2007) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet Pro 300 color MFP M375nw, HP LaserJet Pro 400 color MFP M475dn, M475dw -
kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia kohteita. Laitteen saa avata ja huoltaa
ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota
väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän käsikirjassa lueteltuja,
käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m
W Luokan 3B laser.
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GS statement (Germany)

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert warden.

Substances Table (China)

Restriction on Hazardous Substances statement (Turkey)

Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur

Restriction on Hazardous Substances statement (Ukraine)

Обладнання відповідає вимогам Технічного регламенту щодо обмеження використання деяких
небезпечних речовин в електричному та електронному обладнанні, затвердженого постановою
Кабінету Міністрів України від 3 грудня 2008 № 1057
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Additional statements for telecom (fax) products

EU Statement for Telecom Operation

This product is intended to be connected to the analog Public Switched Telecommunication Networks
(PSTN) of European Economic Area (EEA) countries/regions.

It meets requirements of EU R&TTE Directive 1999/5/EC (Annex II) and carries appropriate CE
conformity marking.

For more details see Declaration of Conformity issued by the manufacturer in another section of this
manual.

However due to differences between individual national PSTNs the product may not guarantee
unconditional assurance of successful operation on every PSTN termination point. Network
compatibility depends on the correct setting being selected by the customer in preparation of its
connection to the PSTN. Please follow the instructions provided in the user manual.

If you experience network compatibility issues, please contact your equipment supplier or Hewlett-
Packard help desk in the country/region of operation.

Connecting to a PSTN termination point may be the subject of additional requirements set out by the
local PSTN operator.

New Zealand Telecom Statements

The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has
accepted that the item complies with minimum conditions for connection to its network. It indicates no
endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it
provides no assurance that any item will work correctly in all respects with another item of
Telepermitted equipment of a different make or model, nor does it imply that any product is
compatible with all of Telecom’s network services.

This equipment may not provide for the effective hand-over of a call to another device connected to
the same line.

This equipment shall not be set up to make automatic calls to the Telecom “111” Emergency Service.

This product has not been tested to ensure compatibility with the FaxAbility distinctive ring service for
New Zealand.

Additional FCC statement for telecom products (US)

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA.
On the back of this equipment is a label that contains, among other information, a product identifier in
the format US:AAAEQ##TXXXX. If requested, this number must be provided to the telephone
company.

The REN is used to determine the quantity of devices, which may be connected to the telephone line.
Excessive RENs on the telephone line may result in the devices not ringing in response to an
incoming call. In most, but not all, areas, the sum of the RENs should not exceed five (5.0). To be
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certain of the number of devices that may be connected to the line, as determined by the total RENs,
contact the telephone company to determine the maximum REN for the calling area.

This equipment uses the following USOC jacks: RJ11C.

An FCC-compliant telephone cord and modular plug is provided with this equipment. This equipment
is designed to be connected to the telephone network or premises wiring using a compatible modular
jack, which is Part 68 compliant. This equipment cannot be used on telephone company-provided
coin service. Connection to Party Line Service is subject to state tariffs.

If this equipment causes harm to the telephone network, the telephone company will notify you in
advance that temporary discontinuance of service may be required. If advance notice is not practical,
the telephone company will notify the customer as soon as possible. Also, you will be advised of your
right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations, or procedures that
could affect the operation of the equipment. If this happens, the telephone company will provide
advance notice in order for you to make the necessary modifications in order to maintain
uninterrupted service.

If trouble is experienced with this equipment, please see the numbers in this manual for repair and
(or) warranty information. If the trouble is causing harm to the telephone network, the telephone
company may request you remove the equipment from the network until the problem is resolved.

The customer can do the following repairs: Replace any original equipment that came with the device.
This includes the print cartridge, the supports for trays and bins, the power cord, and the telephone
cord. It is recommended that the customer install an AC surge arrestor in the AC outlet to which this
device is connected. This is to avoid damage to the equipment caused by local lightning strikes and
other electrical surges.

Telephone Consumer Protection Act (US)

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer
or other electronic device, including fax machines, to send any message unless such message clearly
contains, in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business, other entity, or
individual sending the message and the telephone number of the sending machine or such business,
or other entity, or individual. (The telephone number provided cannot be a 900 number or any other
number for which charges exceed local or long distance transmission charges).

Industry Canada CS-03 requirements

Notice: The Industry Canada label identifies certified equipment. This certification means the
equipment meets certain telecommunications network protective, operational, and safety
requirements as prescribed in the appropriate Terminal Equipment Technical Requirement
document(s). The Department does not guarantee the equipment will operate to the user’s
satisfaction. Before installing this equipment, users should ensure that it is permissible for the
equipment to be connected to the facilities of the local telecommunications company. The equipment
must also be installed using an acceptable method of connection. The customer should be aware that
compliance with the above conditions may not prevent degradation of service in some situations.
Repairs to certified equipment should be coordinated by a representative designated by the supplier.
Any repairs or alterations made by the user to this equipment, or equipment malfunctions, may give
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the telecommunications company cause to request the user to disconnect the equipment. Users
should ensure for their own protection that the electrical ground connections of the power utility,
telephone lines, and internal metallic water pipe system, if present, are connected together. This
precaution can be particularly important in rural areas.

CAUTION: Users should not attempt to make such connections themselves, but should contact the
appropriate electric inspection authority, or electrician, as appropriate. The Ringer Equivalence
Number (REN) of this device is 0.0.

Notice: The Ringer Equivalence Number (REN) assigned to each terminal device provides an
indication of the maximum number of terminals allowed to be connected to a telephone interface. The
termination on an interface may consist of any combination of devices subject only to the requirement
that the sum of the Ringer Equivalence Number of all the devices does not exceed five (5.0). The
standard connecting arrangement code (telephone jack type) for equipment with direct connections to
the telephone network is CA11A.

Vietnam Telecom wired/wireless marking for ICTQC Type approved
products
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Additional statements for wireless products

FCC compliance statement—United States

Exposure to radio frequency radiation

CAUTION: The radiated output power of this device is far below the FCC radio frequency exposure
limits. Nevertheless, the device shall be used in such a manner that the potential for human contact
during normal operation is minimized.

In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human
proximity to the antenna shall not be less than 20 cm ( (8 in)) during normal operation.

This device complies with Part 15 of FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

CAUTION: Based on Section 15.21 of the FCC rules, changes of modifications to the operation of
this product without the express approval by Hewlett-Packard Company may invalidate its authorized
use.

Australia statement

This device incorporates a radio-transmitting (wireless) device. For protection against radio
transmission exposure, it is recommended that this device be operated no less than 20 cm from the
head, neck, or body.

Brazil ANATEL statement

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra
interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a
sistemas operando em caráter primário.

Canadian statements

For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus as set out in the radio interference regulations of the Canadian Department of
Communications. The internal wireless radio complies with RSS 210 of Industry Canada.

Pour l´usage d´intérieur. Le présent appareil numérique n´émet pas de bruits radioélectriques
dépassant les limites applicables aux appareils numériques de Classe B prescribes dans le
règlement sur le brouillage radioélectrique édicté par le Ministère des Communications du Canada.
Le composant RF interne est conforme à la norme CNR-210 d´Industrie Canada.

European Union regulatory notice

The telecommunications functionality of this product may be used in the following EU and EFTA
countries/regions:
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Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany,
Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta,
Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, and United Kingdom.

Notice for use in France

For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This equipment may be
used indoor for the entire 2400-2483.5 MHz frequency band (channels 1-13). For outdoor use, only
2400-2454 MHz frequency band (channels 1-9) may be used. For the latest requirements, see
www.arcep.fr.

L'utilisation de cet equipement (2.4 GHz Wireless LAN) est soumise à certaines restrictions : Cet
équipement peut être utilisé à l'intérieur d'un bâtiment en utilisant toutes les fréquences de
2400-2483.5 MHz (Chaine 1-13). Pour une utilisation en environnement extérieur, vous devez utiliser
les fréquences comprises entre 2400-2454 MHz (Chaine 1-9). Pour les dernières restrictions, voir,
www.arcep.fr.

Notice for use in Russia

Существуют определенные ограничения по использованию беспроводных сетей (стандарта
802.11 b/g) с рабочей частотой 2,4 ГГц: Данное оборудование может использоваться внутри
помещений с использованием диапазона частот 2400-2483,5 МГц (каналы 1-13). При
использовании внутри помещений максимальная эффективная изотропно–излучаемая
мощность (ЭИИМ) должна составлять не более 100мВт.

Korean statement
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Taiwan statement

Vietnam Telecom wired/wireless marking for ICTQC Type approved
products
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A
accessories

ordering 285, 286
acoustic specifications 298
advanced setup

fax 19
AirPrint 52, 57
answer mode, setting 184
answering machines, connecting

173
fax settings 185

anticounterfeit supplies 91
autoreduction settings, fax 187

B
batteries included 303
billing codes, fax

using 183
bin, output

jams, clearing 259
locating 6

black and white scanning 165
blocking faxes 185
booklets

creating (Windows) 133
busy signals, redialing options

181

C
caller-ID boxes, connecting 172
Canadian DOC regulations 310
canceling

copy jobs 149
faxes 190
print job 53, 108
scan jobs 163

cartridges
non-HP 91
recycling 91, 301

replacing 92
storage 91
supplies status page 16
warranty 290

cautions iii
change

print cartridge 92
checklist

fax troubleshooting 200
checklists, printing 17
clean

touch screen 243
cleaning

glass 153, 166, 241
paper path 241, 265

collating copies 150
color

adjusting 140
Edge Control 142
halftone options 142
manage 139
matching 144
Neutral Grays 142
printed vs. monitor 144
printing in grayscale

(Windows) 124
using 139

color alignment, calibrating 266
color options

HP EasyColor (Windows) 143
setting (Windows) 122

color settings
adjusting 263

Color tab settings 56
color usage log 16
color, scanning settings 164, 165
comparison, product models 1
configuration page 16

configuring
IP address 47

connecting to a wireless network
66

connectivity
solving problems 275
USB 64

contrast settings
copy 154
fax 182

control panel
buttons and lights 10
clean touch screen 243
cleaning page, printing 241
help 12
Home screen 11
HP Web Services menu 15
menu map, printing 16
menus 14
Reports menu 16
settings 41, 49

conventions, document iii
copies

changing number of
(Windows) 111

copy menu 30
copying

canceling 149
collation 150
contrast, adjusting 154
double-sided 158, 159
edge-to-edge 154
enlarging 149
light/dark settings 154
multiple copies 146
one-touch 146
paper settings 155
photos 156
quality, adjusting 152, 271
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reducing 149
restore default settings 155

counterfeit supplies 91
cover pages

printing (Mac) 54
printing on different paper

(Windows) 129
custom print settings (Windows)

111
custom-size copies 149
custom-size paper settings

Macintosh 53
customer support

online 296

D
darkness, contrast settings

copy 154
fax 182

default gateway, setting 69
defaults, restoring 249
defects, repeating 99, 269
delaying fax sending 196
deleting faxes from memory 192
dial-tone detection settings 180
dialing

from a telephone 196
pauses, inserting 180
prefixes, inserting 180
redialing automatically,

settings 181
tone or pulse settings 181

dimensions 298
DIMMs

installing 236
verifying installation 240

disposal, end-of-life 303
distinctive-ring settings 186
document conventions iii
document feeder

jams 253
loading 83
locating 6

door release, locating 6
dots per inch (dpi)

fax 182
double-sided printing (duplexing)

Mac 55
dpi (dots per inch)

fax 182

faxing 19
scanning 164

drivers
changing paper types and

sizes 74
changing settings (Mac) 50
changing settings (Windows)

41
presets (Mac) 53
settings 41
settings (Mac) 53
settings (Windows) 109
supported (Windows) 38
universal 40
usage page 16

DSL
faxing 190

duplex printing (double-sided)
settings (Windows) 116

duplex settings, changing 70

E
e-mail, scanning to

resolution settings 165
EconoMode setting 90, 234
economy settings 234
Edge Control 142
edge-to-edge printing 154
electrical specifications 298
electronic faxes

sending 195
Embedded Web Server (EWS)

assigning passwords 233
embedded Web server (EWS)

features 232
end-of-life disposal 303
enlarging documents

copying 149
environmental features 5
environmental specifications 298
environmental stewardship

program 300
ePrint

enabling or disabling 15
error messages, fax 202, 212,

219
error report, fax

printing 211
error-correction setting, fax 211

errors
software 282

European Union, waste disposal
304

extension phones
receiving faxes from 173
sending faxes from 196

F
factory-set defaults, restoring 249
fax

answer mode 18, 184
autoreduction 187
billing codes 183
blocking 185
canceling 190
confirming number 196
contrast setting 182
delaying sending 196
deleting from memory 192
detect-dial-tone settings 180
dial prefixes 180
dialing, tone or pulse 181
error report, printing 211
error-correction 211
extension phone receiving

173
factory-set defaults, restoring

249
forwarding 184
pauses, inserting 180
polling 189
printing 198
printing private faxes 198
private receive 188
receiving when you hear fax

tones 199
redial settings 181
reports 32
reports, printing all 210
reprinting faxes 187
reprinting from memory 198
resolution 182
ring patterns 186
ring type 19
rings-to-answer 185
security, private receive 188
sending from a telephone 196
sending from software 195
solve general problems 225
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speed dials 194
stamp-received 188
unable to receive 219
unable to send 212
using DSL, PBX, or ISDN 190
using VoIP 191
V.34 setting 212
volume settings 187

fax date, setup
use control panel 174
use HP Fax Setup Wizard

175
fax header, setup

use control panel 174
use HP Fax Setup Wizard

175
fax menu 32
fax ports, locating 7, 8
fax reports, printing 32
fax time, setup

use control panel 174
use HP Fax Setup Wizard

175
fax troubleshooting

checklist 200
faxing

from a computer (Mac) 58,
195

from a computer (Windows)
195

Finnish laser safety statement
311

firewall 66
first page

printing on different paper
(Windows) 129

use different paper 54
Fit to Page setting, fax 187
fonts

DIMMs, installing 236
lists, printing 16
permanent resources 240

forms
printing (Windows) 124

forwarding faxes 184
fraud Web site 91
fuser

jams, clearing 258

G
gateway, setting default 69
glass, cleaning 153, 166, 241
graph paper, printing 17
grayscale

printing (Windows) 124
grayscale scanning 165
group-dial entries

creating 178
deleting 178
editing 178

H
help

printing options (Windows)
110

help, control panel 12
Home screen, control panel 11
HP Customer Care 296
HP Easy Color

disabling 143
using 143

HP Embedded Web Server 44
HP ePrint

description 52
enabling or disabling 15

HP ePrint, using 123
HP fraud Web site 91
HP Scan (Windows) 162
HP Universal Print Driver 40
HP Utility 51
HP Utility, Mac 51
HP Web Jetadmin 233
HP Web Services menu 15
HP Web Services, enabling 123
HP-UX software 44
humidity specifications

environment 298

I
identification cards

copying 148
input tray

loading 80
locating 6

installing
product on wired networks 65
software, USB connections 64
software, wired networks 66

interface ports
locating 7, 8

IP address
configuring 47
obtaining 65

IPv4 address 69
ISDN

faxing 190

J
jams

causes of 250
document feeder, clearing

253
locating 252
output bin, clearing 259
paper path, clearing 258
tracking number of 16

Japanese VCCI statement 310
Jetadmin, HP Web 233

K
Korean EMC statement 311

L
labels

printing (Windows) 126
landscape orientation

selecting, Windows 120
laser safety statements 310, 311
last page

printing on different paper
(Windows) 129

letterhead
printing (Windows) 124

license, software 292
lightness

copy contrast 154
fax contrast 182

link speed settings 70
Linux 44
Linux software 44
loading paper

input tray 80
logs, fax

error 211
printing all 210
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M
Mac

changing paper types and
sizes 53

driver settings 50, 53
faxing 58
HP Utility 51
installing software 46
problems, troubleshooting

283
removing software 49
scanning from TWAIN-

compliant software 162
supported operating systems

46
Macintosh

resize documents 53
support 296

Macintosh driver settings
custom-size paper 53
watermarks 54

managing network 68
matching colors 144
material restrictions 303
Material Safety Data Sheet

(MSDS) 304
media

custom-size, Macintosh
settings 53

first page 54
pages per sheet 55
supported sizes 75

memory
deleting faxes 192
included 2
installing 236
part number 286
permanent resources 240
reprinting faxes 198
verifying installation 240

memory chip, print cartridge
description 291

menu
control panel, access 14
copy 30
fax 32
Fax setup 18
Network config 28
Quick Forms 17
scan 34

Service 26
System setup 21
USB 35

menus, control panel
HP Web Services 15
map, printing 16
Reports 16

mercury-free product 303
Microsoft Word, faxing from 195
model

comparison 1
number, locating 9

modems, connecting 172
multiple pages per sheet 55

printing (Windows) 119
music paper, printing 17

N
n-up printing 55

selecting (Windows) 119
network

configuring 28
password, changing 69
password, setting 69
settings, changing 68
settings, viewing 68

Network config menu 28
network port

locating 7, 8
networks

configuration page 16
default gateway 69
HP Web Jetadmin 233
IPv4 address 69
models supporting 2
settings report 16
subnet mask 69

networks, wired
installing product 65

Neutral Grays 142
non-HP supplies 91
notebook paper, printing 17
notes iii
number of copies, changing 146

O
obtaining

IP address 65
OCR software 163
online help, control panel 12

online support 296
opening printer drivers

(Windows) 109
operating environment,

specifications 298
operating systems supported 38,

46
optical character recognition

software 163
ordering

supplies and accessories 286
ordering supplies

Web sites 285
orientation

selecting, Windows 120
output bin

jams, clearing 259
locating 6

outside lines
dial prefixes 180
pauses, inserting 180

P
page count 16
page sizes

scaling documents to fit
(Windows) 131

pages per minute 2
pages per sheet 55

selecting (Windows) 119
paper

copy settings 155
covers, using different paper

129
custom-size, Macintosh

settings 53
default size for tray 85
fax autoreduction settings 187
first and last pages, using

different paper 129
first page 54
jams 250
pages per sheet 55
printing on preprinted

letterhead or forms
(Windows) 124

selecting 265
supported sizes 75

paper jams. See jams
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paper path
jams, clearing 258

paper pickup problems
solving 250

paper size
changing 74

paper sizes
selecting 114
selecting custom 115

paper type
changing 262

paper types
changing 74
selecting 115

paper, ordering 286
paper, special

printing (Windows) 126
pauses, inserting 180
PBX

faxing 190
PCL drivers 38

universal 40
PCL font list 16
permanent resources 240
phone book, fax

adding entries 194
deleting all entries 177
importing 176

phones
receiving faxes from 173, 199

phones, connecting extra 173
phones, downstream

sending faxes from 196
photos

copying 156
scanning 167

physical specifications 298
pixels per inch (ppi), scanning

resolution 164
polling faxes 189
portrait orientation

selecting, Windows 120
ports

locating 7, 8
power

consumption 298
ppi (pixels per inch), scanning

resolution 164
prefixes, dial 180

preprinted paper
printing (Windows) 124

presets (Mac) 53
print cartridges

checking for damage 98, 268
door release, locating 6
memory chips 291
non-HP 91
part numbers 87, 286
recycling 91, 301
storage 91
supplies status page 16
warranty 290

print job
canceling 53, 108

print media
supported 75

print quality
improving 262
improving (Windows) 114

print quality page
interpreting 98, 268
printing 98, 268

print-cartridges
replacing 92

printer driver
configuring wireless network

68
printer drivers

choosing 269
printer drivers (Mac)

changing settings 50
settings 53

printer drivers (Windows)
changing settings 41
settings 109
supported 38

printing
edge-to-edge 154
from USB storage

accessories 136
settings (Mac) 53
settings (Windows) 109

printing on both sides
settings (Windows) 116

priority, settings 41, 49
private receive 188
problem-solving

no response 272
slow response 273

product
model comparison 1
serial number, locating 9

protocol settings, fax 212
PS Emulation drivers 38
PS font list 16
pulse-dialing 181

Q
quality

copy settings 152

R
Readiris OCR software 163
receiving faxes

answer mode, setting 184
autoreduction settings 187
blocking 185
error report, printing 211
from extension phone 173
polling 189
reprinting 198
reprinting faxes 187
ring patterns, settings 186
rings-to-answer settings 185
stamp-received setting 188
when you hear fax tones 199

recycling 5, 301
HP printing supplies returns

and environmental program
302

recycling supplies 91
redialing

automatically, settings 181
reducing documents

copying 149
removing Mac software 49
removing Windows software 43
repeating defects,

troubleshooting 99, 269
repetitive defects,

troubleshooting 99, 269
reports

configuration page 230
demo page 16, 230
diagnostics page 231
fax 32
menu map 230
network report 230
PCL 6 font list 230
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PCL font list 230
print quality page 16, 231
PS font list 230
service page 230
supplies status page 230
usage page 230

Reports menu 16
reports, fax

error 211
printing all 210

reprinting faxes 187, 198
resize documents

Macintosh 53
Windows 131

resizing documents
copying 149

resolution
fax 182
scanning 164

resource saving 240
restoring factory-set defaults 249
ring patterns 186
ring tones

distinctive 186
rings-to-answer setting 185

S
safety statements 310, 311
saving resources, memory 240
scale documents

Macintosh 53
Windows 131

scaling documents
copying 149

scan menu 34
scanner

glass cleaning 153, 166, 241,
271

scanning
black and white 165
canceling 163
color 164
from HP Scan (Windows) 162
from Mac software 59
grayscale 165
methods 162
OCR software 163
photos 167
resolution 164

TWAIN-compliant software
162

WIA-compliant software 162
sending faxes

billing codes 183
canceling 190
confirmation 196
delaying 196
error report, printing 211
forwarding 184
from downstream telephone

196
from software 195

serial number, locating 9
Service menu 26
service page 16
settings

driver presets (Mac) 53
drivers 41
drivers (Mac) 50
factory-set defaults, restoring

249
network report 16
priority 41, 49

shortcuts (Windows)
creating 112
using 111

size 298
size, copy

reducing or enlarging 149
sizes, media

Fit to Page setting, faxing 187
sleep delay

disabling 234
enabling 234

small documents
copying 148

software
embedded Web server 44
HP Utility 51
installing, USB connections

64
installing, wired networks 66
Linux 44
problems 282
Readiris OCR 163
scanning from TWAIN or WIA

162
sending faxes 195
settings 41, 49

software license agreement
292

Solaris 44
supported operating systems

38, 46
uninstalling for Windows 43
uninstalling Mac 49
UNIX 44
Windows 44
Windows components 37

Solaris software 44
solve

fax problems 212
solve problems

fax 225
solving

direct-connect problems 275
network problems 275
walk-up USB printing

problems 274
special paper

printing (Windows) 126
specifications

electrical and acoustic 298
environmental 298
physical 298

speed dials
programming 194

speed-dial entries
creating 177, 178
editing 177, 178

status
Home screen, control panel

11
HP Utility, Mac 51
supplies, printing report 16

storing
environmental specifications

298
print cartridges 91

subnet mask 69
supplies

counterfeit 91
non-HP 91
ordering 285, 286
recycling 91, 301
status, viewing with HP Utility

51
supplies status page 16

printing 97, 267
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support
online 296

supported media 75
System setup menu 21

T
TCP/IP

manually configuring IPv4
parameters 69

technical support
online 296

telephones
receiving faxes from 173, 199

telephones, connecting extra 173
telephones, downstream

sending faxes from 196
temperature specifications

environment 298
tips iii
tone-dialing 181
toner cartridges. See print

cartridges
touch screen, clean 243
transparencies

printing (Windows) 126
trapping 142
Tray 1

double-sided printing 55
jams, clearing 255

Tray 2
jams, clearing 257

Tray 3
part number 286

trays
default paper size 85
double-sided printing 55
included 2
jams, clearing 257
locating 6
selecting (Windows) 115

troubleshooting
checklist 247
direct-connect problems 275
fax error-correction setting

211
faxes 200
jams 250
Mac problems 283
network problems 275
paper feed problems 250

receive fax 219
repeating defects 99, 269
send fax 212
walk-up USB printing

problems 274
TWAIN-compliant software,

scanning from 162
two-sided printing

settings (Windows) 116

U
unblocking fax numbers 185
uninstalling Mac software 49
uninstalling Windows software 43
universal print driver 40
UNIX 44
UNIX software 44
usage page 16
USB

configuring wireless network
49, 67

USB cable, part number 286
USB configuration 64
USB menu 35
USB port

locating 7, 8
USB storage accessories

printing from 136

V
V.34 setting 212
VoIP

faxing 191
volume

settings 22
volume, adjusting 187

W
walk-up USB printing 136
warnings iii
warranty

license 292
print cartridges 290
product 288

watermarks 54
adding (Windows) 133

Web printing
HP ePrint 52

Web sites 44
customer support 296
fraud reports 91

HP Web Jetadmin,
downloading 233

Macintosh customer support
296

Material Safety Data Sheet
(MSDS) 304

ordering supplies 285
universal print driver 40

weight 298
WIA-compliant software, scanning

from 162
Windows

driver settings 41
drivers supported 38
faxing from 195
scanning from TWAIN or WIA

software 162
software components 37, 44
supported operating systems

38
universal print driver 40

wireless
configuring 28

wireless network
configuring with the setup

wizard 67
configuring with USB 49, 67
configuring with WPS 48, 67
installing the driver 68

wireless network connection 66
Wireless Setup Wizard

configuring wireless network
67

Word, faxing from 195
WPS

configuring wireless network
48, 67
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